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Introduction to Genotyper Software Version 2.5

 

New Features

 

The latest release of the ABI P

 

RISM

 

®

 

 Genotyper

 

®

 

 Software, version 2.5, 
has two new features:

 

�

 

The ability to import ABI P

 

RISM

 

® 

 

GeneScan

 

® 

 

Analysis data from a 
BioLIMS

 

®

 

 2.0 database. 

See Chapter 13 for more information.

 

�

 

The ability to import and process GeneScan sample files containing 
a 5th dye. 

See Chapter 14 for more information.

 

IMPORTANT

 

Genotyper v. 2.5 runs only on a Power Macintosh

 

®

 

 computer.

 

Note

 

The user interface for importing dye colors and raw data has been 
changed in this version (v. 2.5) of Genotyper Software. This change is 
described in Chapter 14.
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Software License and Warranty

 

Applied Biosystems Software License and Limited Product Warranty

 

PURCHASER, CAREFULLY READ THE FOLLOWING TERMS AND 
CONDITIONS (THE “AGREEMENT”), WHICH APPLY TO THE 
SOFTWARE ENCLOSED (THE “SOFTWARE”). YOUR OPENING OF 
THIS PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS 
AND CONDITIONS. IF YOU DO NOT ACCEPT THEM, PROMPTLY 
RETURN THE COMPLETE PACKAGE AND YOUR MONEY WILL BE 
RETURNED. THE LAW PROVIDES FOR CIVIL AND CRIMINAL 
PENALTIES FOR ANYONE WHO VIOLATES THE LAWS OF 
COPYRIGHT.

COPYRIGHT

The SOFTWARE, including its structure, organization, code, user 
interface, and associated documentation, is a proprietary product of 
Applied Biosystems and is protected by international laws of copyright. 
Title to the SOFTWARE, and to any and all portion(s) of the 
SOFTWARE shall at all times remain with Applied Biosystems.

LICENSE

1. You may use the SOFTWARE on a single computer (or on a single 
network, if your software is designated as a network version). You may 
transfer the SOFTWARE to another single computer (or network, if a 
network version), so long as you first delete the SOFTWARE from the 
previous computer or network. You may never have operational 
SOFTWARE on more than one computer (or more than one network, if 
a network version) per original copy of the SOFTWARE at any time.

2. You may make one copy of the SOFTWARE for backup purposes.

3. You may transfer the SOFTWARE to another party, but only if the 
other party agrees in writing with Applied Biosystems to accept the 
terms and conditions of this Agreement. If you transfer the SOFTWARE 
to another party, you must immediately transfer all copies to that party, 
or destroy those not transferred. Any such transfer terminates your 
license.



 

xxii

 

RESTRICTIONS

1. You may not copy, transfer, rent, modify, use, or merge the 
SOFTWARE, or the associated documentation, in whole or in part, 
except as expressly permitted in this Agreement.

2. You may not reverse assemble, decompile, or otherwise reverse 
engineer the SOFTWARE.

LIMITED WARRANTY 

For a period of 90 days after purchase of the SOFTWARE, Applied 
Biosystems warrants that the SOFTWARE will function substantially as 
described in the documentation supplied by Applied Biosystems with 
the SOFTWARE. If you discover an error which causes substantial 
deviation from that documentation, send a written notification to Applied 
Biosystems. Upon receiving such notification, if Applied Biosystems is 
able to reliably reproduce that error at its facility, then Applied 
Biosystems will do one of the following at its sole option: (i) correct the 
error in a subsequent release of the SOFTWARE, which shall be 
supplied to you free of charge, or (ii) accept a return of the SOFTWARE 
from you, and refund the purchase price received for the SOFTWARE. 
Applied Biosystems does not warrant that the SOFTWARE will meet 
your requirements, will be error-free, or will conform exactly to the 
documentation. Any sample or model used in connection with this 
Agreement is for illustrative purposes only, is not part of the basis of the 
bargain, and is not to be construed as a warranty that the SOFTWARE 
will conform to the sample or model.

LIMITATION OF LIABILITY

EXCEPT AS SPECIFICALLY STATED IN THIS AGREEMENT, THE 
SOFTWARE IS PROVIDED AND LICENSED “AS IS”. THE ABOVE 
WARRANTY IS GIVEN IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING THOSE OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
NOTWITHSTANDING ANY FAILURE OF THE CENTRAL PURPOSE 
OF ANY LIMITED REMEDY, APPLIED BIOSYSTEMS LIABILITY FOR 
BREACH OF WARRANTY SHALL BE LIMITED TO A REFUND OF 
THE PURCHASE PRICE FOR SUCH PRODUCT. IN NO EVENT WILL 
APPLIED BIOSYSTEMS BE LIABLE FOR ANY OTHER DAMAGES, 
INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN 



 

xxiii

 

IF APPLIED BIOSYSTEMS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

TERM

You may terminate this Agreement by destroying all copies of the 
SOFTWARE and documentation. Applied Biosystems may terminate 
this Agreement if you fail to comply with any or all of its terms, in which 
case you agree to return to Applied Biosystems all copies of the 
SOFTWARE and associated documentation.

MISCELLANEOUS

1. Failure to enforce any of the terms and conditions of this Agreement 
by either party shall not be deemed a waiver of any rights and privileges 
under this Agreement.

2. In case any one or more of the provisions of this Agreement for any 
reason shall be held to be invalid, illegal, or unenforceable in any 
respect, such invalidity, illegality, or unenforceability shall not affect any 
other provisions of this Agreement, and this Agreement shall be 
construed as if such invalid, illegal, or unenforceable provisions had 
never been contained herein.

3. This Agreement shall be construed and governed by the laws of the 
State of California.

4. This Agreement and the Applied Biosystems Sales Quotation 
constitute the entire agreement between Applied Biosystems and you 
concerning the SOFTWARE.
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Chapter Overview

 

Introduction

 

This chapter describes ABI P

 

RISM

 

®

 

 Genotyper

 

®

 

 2.5, the components of 
the ABI P

 

RISM

 

 Genotyping Software System, and requirements for 
installing and starting Genotyper.

 

In This Chapter

 

This chapter contains the following topics:

 

Topic See Page

 

Overview of ABI PRISM Genotyper 2.5 1-2

Overview of the ABI PRISM Genotyping Software System 1-5

Installing and Starting Genotyper 1-9

Using the Macintosh 1-14

Macintosh Terms Used in This Manual 1-15

Technical Support 1-16
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Overview of ABI PRISM Genotyper 2.5

 

Definition

 

Genotyper is a software application that enables you to analyze and 
interpret nucleic acid fragment size and quantitation data by converting 
it into user defined results. 

You can transfer these results to:

 

�

 

GenBase for storage

 

�

 

GenoPedigree for display on pedigrees

 

�

 

Other databases for storage, spreadsheets for statistical analysis or 
linkage analysis.
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How You Can Use
Genotyper

 

You can use Genotyper, as well as the other components of the ABI 
P

 

RISM

 

 Genotyping Software System, to automate and assist you with 
many different genetic research projects including:

 

Microsatellite Analysis

 

�

 

Fluorescent genotyping for genetic linkage studies

 

�

 

Paternity identification

 

�

 

Forensic identification of samples

 

�

 

Determination of loss of heterozygosity

 

�

 

Microsatellite instability

 

�

 

Trisomy analysis

 

AFLP Analysis

 

�

 

Gene Mapping using amplified fragment polymorphisms (AFLP)

 

�

 

Quantitative expression of gene products

 

Gene Expression Profiling

 

�

 

Differential display

 

�

 

Quantitative expression of gene products

 

Mutation Detection

 

�

 

Single strand conformation polymorphisms (SSCP)

 

�

 

Heteroduplex mobility assays (HMA)

 

�

 

Mismatch cleavage

 

Mutation Screening

 

�

 

Oligonucleotide ligation assays (OLA)

 

�

 

Allele-specific PCR

 

�

 

Gene dosage PCR

 

�

 

RNAse protection assays

For more information on ABI P

 

RISM

 

 Genotyping Software System 
components, see “Overview of the ABI PRISM Genotyping Software 
System” on page 1-5.
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How Genotyper
Works

The following figure shows how Genotyper analyzes data imported from 
ABI PRISM GeneScan® and BioLIMS®:
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Overview of the ABI PRISM Genotyping Software System

Definition Genotyper®, GeneScan, GenBase™, and GenoPedigree™ are four 
stand-alone software applications that when used together make up the 
ABI PRISM Genotyping Software System.

Relationship of
System

Components

The diagram below illustrates how the ABI PRISM Genotyping Software 
System integrates Genotyper with GenoPedigree and linkage analysis 
programs through GenBase.
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Component
Descriptions

The following table describes the components of the ABI PRISM 
Genotyping Software System.

Components of the ABI PRISM Genotyping Software System: 

Component Description

ABI PRISM GeneScan Analyzes nucleic acid fragment data collected by 
an ABI PRISM instrument and sizes and 
quantifies detected fragments, putting the results 
in GeneScan files.

ABI PRISM Genotyper Analyzes data from GeneScan files or BioLIMS, 
labeling fragment data and creating tables 
specific to your genotyping studies.

ABI PRISM 
GenoPedigree

An interactive pedigree diagram editor that reads 
and writes its own documents containing 
pedigree, layout, and style information. 

ABI PRISM GenBase A database application that stores data for 
genotypes, pedigrees, markers, traits 
(diseases), and other relevant information. You 
can import data from or export data to GenBase 
from Genotyper, and GenoPedigree.
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Related
Publications

The following table describes publications that you can refer to for 
detailed information about ABI PRISM Genotyping Software System 
component applications.

Publication List: 

Publication Description

Hard-copy Publications

ABI PRISM Genotyper 
User’s Manual

Explains how to use features of Genotyper to 
analyze data from GeneScan files and BioLIMS, 
and produce results data specific to your 
Genotyping application.

ABI PRISM Genotyper 
Applications Tutorials

Contains tutorial information for using Genotyper 
and Genotyping Software System components 
to perform typical genotyping applications.

ABI PRISM 
GenoPedigree User’s 
Manual

Explains how to use GenoPedigree to display, 
generate, and analyze, import and export 
pedigree diagrams and data.

ABI PRISM GenBase 
User’s Manual

Explains how to use a database application that 
stores data for genotypes, pedigrees, markers, 
traits (diseases), and other relevant information. 
You can import data from or export data to 
GenBase from Genotyper and GenoPedigree.

ABI PRISM GeneScan 
User’s Manual

Explains how to use GeneScan Analysis 
software to size and quantify nucleic acid 
fragments detected on an ABI PRISM instrument.

CD-ROM Publications

ABI PRISM Genotyper 
User’s Manual

Allows you to use online navigation tools to 
search for information contained in the 
Genotyper User’s Manual, and access user 
documentation for other Genotyping System 
Software components.

ABI PRISM Genotyper 
Applications Tutorials

Allows you to use online navigation tools to 
search for information contained in the 
Genotyper Applications Tutorials, and access 
user documentation for other Genotyping 
System Software components.

ABI PRISM GenBase 
User’s Manual

Allows you to use online navigation tools to 
search for information contained in the GenBase 
User’s Manual, and access user documentation 
for other Genotyping System Software 
components.
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Web Site
Information

Information on the software and user manuals of the ABI PRISM® 
Genotyping Software System can be accessed from the Applied 
Biosystems:

www.appliedbiosystems.com/techsupport

ABI PRISM 
GenoPedigree User’s 
Manual

Allows you to use online navigation tools to 
search for information contained in the 
GenoPedigree User’s Manual, and access user 
documentation for other Genotyping System 
Software components.

Publication List: (continued)

Publication Description
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Installing and Starting Genotyper

Registering Your
Copy of Genotyper

When you register your copy of Genotyper you become eligible for 
telephone and field service support from Applied Biosystems for 100 
days from the date of shipment. To register, fill out the registration card 
included in this package and return it to Applied Biosystems. 

For Applied Biosystems technical support telephone and address 
information, see “Technical Support” on page 1-16.

Registration also allows you to purchase upgrades to the software at a 
lower price than it would cost you to purchase a new upgraded 
package. 

IMPORTANT These privileges are available only if you have returned your 
registration card.

Compatibility
With Previous

Versions

Genotyper 2.5 can read files created by Genotyper 1.0, 1.1, 1.1.1, and 
2.0.

Previous versions of Genotyper cannot read files created by Genotyper 
2.5.

The commands Add Rows to Tables and Add Rows to Link are 
supported in Genotyper 2.5 for compatibility with Genotyper 1.X 
macros. However, there are many new table features in Genotyper 2.0 
that require the new versions of these commands. In particular, tables 
written with Add Rows to Table will need to be rewritten with Setup Table 
and Append to Table. The older commands may be removed in future 
versions.

For more information on using the new table features, see “Working 
with Tables” on page 8-1.
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Hardware and
Software

Requirements

This table describes the components your computer system requires to 
run Genotyper 2.5.

Genotyper hardware and software requirements: 

System 
Component

Description

Recommended Minimum Requirement

Computer A Power Macintosh G3 computer with a 
233 MHz or faster processor

A PowerPC Macintosh

 Monitor A seventeen inch monitor A 640 x 480 pixels size monitor

Note Color monitors are useful, but not required.

 Operating 
System

Macintosh Operating System 8.0 or later Macintosh Operating System 7.5.3 with 
32 MB of RAM.

Memory 
Allocated to 
Genotyper

15 MB of RAM (without virtual memory 
16.5). This allows you to import 
GeneScan files from approximately one 
Gel file.

5 MB of RAM (without virtual memory 
6.5). This allows you to import only a lim-
ited number of GeneScan files at one 
time.

Note Genotyper performance increases when you allocate more memory to the 
program. Performance decreases, as you import more GeneScan files. Actual results 
will vary depending on your type of computer system and the kinds of Genotyper 
tasks you are performing.

 Disk Drive If you intend to use Genotyper with GenBase, note that the GenBase data file is a 
single, large disk file, and performance depends on having sufficient unfragmented 
space on your hard drive. GenBase requires at least 5 MB of free space to launch 
successfully.
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Setting Memory
Allocation

Because the sizes of the GeneScan data you import can vary, you may 
need to allocate more memory to Genotyper. You can estimate that 
each additional megabyte of memory allocated to Genotyper allows you 
to import approximately 12 GeneScan files when raw data is imported 
or 20 GeneScan files if raw data is not imported (actual sizes may vary). 

To change the memory allocation to Genotyper: 

Step Action

1 Quit Genotyper.

2 Click the Genotyper application icon to select it. 

3 Choose the Get Info command from the Finder’s File menu. 

The Get Info dialog box appears.

4 Enter a new value for the Preferred size

Note In some versions of the Macintosh System, the Preferred 
size value is referred to as the Current size.

5 Click the close box in the upper left corner.
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How to Install
Genotyper

Genotyper comes on a single CD-ROM disc containing the: 

� Genotyper Program file

� Tutorials & Examples files

� Genotyper User Manual in Portable Document Format (pdf)

IMPORTANT Do not work off of the CD-ROM disc. 

To install Genotyper for the first time:

Step Action

1 Insert the Genotyper CD into your computer CD-ROM drive.

2 Double-click the Genotyper Installer icon.

3 Choose the hard-drive on which you want the program to be 
installed.

4 Follow the prompts on the installer to install the program.

5 Eject the Genotyper CD.
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How to Start
Genotyper To start Genotyper: 

Step Action

1 Double click the Genotyper icon in the Finder.

The first time you start Genotyper, the Registration dialog box 
appears.

2 Enter your name, your organization, and your registration code.

Note The first time you use the application, you are asked to 
enter the registration code on your registration card. Genotyper 
then verifies the code. 

IMPORTANT Keep your registration code in a place where you 
can easily retrieve it. If you need to re-install the software at any 
time, you will be prompted for the registration code once again.

3 Click OK.

The Genotyper start-up screen appears briefly.

You are now ready to use Genotyper.
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Using the Macintosh

Knowledge
Assumptions

For the purposes of this manual, it is assumed that you have used a 
Macintosh computer. If you are not familiar with the terms or procedures 
in the following table, refer to the Macintosh System Software User’s 
Guide for more information.

The table below describes Macintosh procedures that you should be 
familiar with to use Genotyper.

Performance and
Maintenance

Guidelines

When using Genotyper, you will often be working with many files, and 
accessing the hard disk often, so it is essential that you follow 
guidelines to minimize the occurrence of errors during operation of the 
computer.

Follow these general guidelines for optimal performance:

� Install only one Macintosh System per hard disk.

� Back up all programs and files regularly.

� Use discretion when adding software programs, especially control 
panel and System extension (INIT) files.

Macintosh procedures:

Procedure Description

Using the mouse Clicking and double-clicking, selecting, and 
dragging.

Choosing commands Using pull-down and pop-up menus, dialog 
boxes, radio buttons and checkboxes.

Working with windows Opening and closing, re-sizing and 
repositioning, scrolling, understanding the active 
window.

Using the Macintosh 
hierarchical file system

Finding files and creating folders.
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Macintosh Terms Used in This Manual

Definitions The following terms are used in this manual:

Term Definition

Dialog 
Boxes

Appear when you need to make a decision or enter information. 
All other action on the monitor screen is suspended until you 
close the dialog box by clicking a button such as Cancel, OK, or 
Done.

Menus Provide access to various functions you can perform with the 
software. A triangle after a menu item indicates that a submenu 
appears. When you click that choice and hold the mouse button 
down, a submenu appears. These menus allow you to choose 
dialog box entries from specific lists of items.

Pop-up 
menus

Display a triangle and are found in dialog boxes. When you click 
a pop-up menu and hold the mouse button down, a submenu 
appears. These menus allow you to choose dialog box entries 
from specific lists of items.

Windows Display information, and in some cases allow you to edit or 
enter additional information. The top border of an active window 
always has six horizontal lines and usually has a close box in 
the upper left corner. If many windows are open, click one 
window to make it active. When a window is active, you can 
click the top border, hold the mouse button down, and drag the 
window to another location on the screen. When you are 
finished working with a window, click the close box to remove 
the window from the screen, or click another window.

Entry 
fields

Rectangular areas in which you can enter information. Click in 
an entry field to display a cursor, and use the keyboard to enter 
the information.

Check

boxes

Boxes that you click to select certain options in a dialog box. 
When you click an empty checkbox, an x appears in it, 
indicating that you have selected the option. You can usually 
select multiple checkboxes.

Radio 
Buttons

Small circles that appear in front of choices. When you click a 
radio button with the cursor, a black dot appears in the center of 
the circle to indicate your choice. You can select only one at a 
time.

Buttons Rectangles with rounded corners that allow you to accept or 
cancel the contents of a dialog box or perform functions (such 
as printing) within the dialog box. A button with a heavy outline 
is the default button that applies if you press the Return key. 
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Technical Support

Contacting
Technical Support

You can contact Applied Biosystems for technical support by telephone 
or fax, by e-mail, or through the Internet. You can order Applied 
Biosystems user documents, MSDSs, certificates of analysis, and other 
related documents 24 hours a day. In addition, you can download 
documents in PDF format from the Applied Biosystems Web site 
(please see the section “To Obtain Documents on Demand” following 
the telephone information below).

To Contact
Technical Support

by E-Mail

Contact technical support by e-mail for help in the following product 
areas:

Hours for
Telephone

Technical Support

In the United States and Canada, technical support is available at the 
following times:

Product Area E-mail address

Genetic Analysis (DNA 
Sequencing)

galab@appliedbiosystems.com

Sequence Detection Systems and 
PCR

pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

Biochromatography, PerSeptive 
DNA, PNA and Peptide Synthesis 
systems, CytoFluor®, FMAT™, 
Voyager™, and Mariner™ Mass 
Spectrometers

tsupport@appliedbiosystems.com

Applied Biosystems/MDS Sciex api3-support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time
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To Contact
Technical Support

by Telephone or
Fax

In North America

To contact Applied Biosystems Technical Support, use the telephone or 
fax numbers given below. (To open a service call for other support 
needs, or in case of an emergency, dial 1-800-831-6844 and press 1.)

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA 
Analyzer

1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 21

1-650-638-5981

Fluorescent DNA 
Sequencing

1-800-831-6844,
then press 22

1-650-638-5981

Fluorescent Fragment 
Analysis (includes 
GeneScan® applications)

1-800-831-6844,
then press 23

1-650-638-5981

Integrated Thermal 
Cyclers (ABI PRISM® 877 
and Catalyst 800 
instruments)

1-800-831-6844,
then press 24

1-650-638-5981

ABI PRISM® 3100 Genetic 
Analyzer

1-800-831-6844,
then press 26

1-650-638-5981

BioInformatics (includes 
BioLIMS™, BioMerge™, 
and SQL GT™ 
applications)

1-800-831-6844,
then press 25

1-505-982-7690

Peptide Synthesis (433 
and 43X Systems)

1-800-831-6844,
then press 31

1-650-638-5981

Protein Sequencing 
(Procise‚ Protein 
Sequencing Systems)

1-800-831-6844,
then press 32

1-650-638-5981

PCR and Sequence 
Detection

1-800-762-4001,
then press 1 for 
PCR,
2 for the 7700 or 
5700,
6 for the 6700
or dial 
1-800-831-6844, 
then press 5

1-240-453-4613
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Outside North America

Voyager‰ MALDI-TOF 
Biospectrometry and 
Mariner‰ ESI-TOF Mass 
Spectrometry 
Workstations

1-800-899-5858,
then press 13

1-508-383-7855

Biochromatography 
(BioCAD‚ Workstations 
and Poros‚ Perfusion 
Chromatography 
Products)

1-800-899-5858,
then press 14

1-508-383-7855

Expedite‰ Nucleic acid 
Synthesis Systems

1-800-899-5858,
then press 15

1-508-383-7855

Peptide Synthesis 
(Pioneer‰ and 9050 Plus 
Peptide Synthesizers)

1-800-899-5858,
then press 15

1-508-383-7855

PNA Custom and 
Synthesis

1-800-899-5858,
then press 15

1-508-383-7855

FMAT‰ 8100 HTS System 
and Cytofluor‚ 4000 
Fluorescence Plate 
Reader

1-800-899-5858,
then press 16

1-508-383-7855

Chemiluminescence 
(Tropix)

1-800-542-2369 
(U.S. only),
or 1-781-271-0045

1-781-275-8581

Applied Biosystems/MDS 
Sciex

1-800-952-4716 1-650-638-6223

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) 
and West Asia (Fairlands, 
South Africa)

27 11 478 0411 27 11 478 0349

South Africa 
(Johannesburg)

27 11 478 0411 27 11 478 0349

Middle Eastern Countries 
and North Africa (Monza, 
Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Product or
Product Area

Telephone
Dial...

Fax
Dial...
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Eastern Asia, China, Oceania

Australia (Scoresby, 
Victoria)

61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 758 8268 60 3 754 9043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 712 5555 32 (0)2 712 5516

Czech Republic and 
Slovakia (Praha)

420 2 61 222 164 420 2 61 222 168

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, 
and Estonia (Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20

Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 095 935 8888 7 095 564 8787

South East Europe 
(Zagreb, Croatia)

385 1 34 91 927 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands 
(Nieuwerkerk a/d IJssel)

31 (0)180 331400 31 (0)180 331409

Region
Telephone
Dial...

Fax
Dial...
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To Reach
Technical Support

Through the
Internet

We strongly encourage you to visit our Web site for answers to 
frequently asked questions and for more information about our 
products. You can also order technical documents or an index of 
available documents and have them faxed or e-mailed to you through 
our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

United Kingdom 
(Warrington, Cheshire)

44 (0)1925 825650 44 (0)1925 282502

All other countries not 
listed (Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509

Japan

Japan (Hacchobori, 
Chuo-Ku, Tokyo)

81 3 5566 6230 81 3 5566 6507

Latin America

Del.A. Obregon, Mexico 305-670-4350 305-670-4349

Region
Telephone
Dial...

Fax
Dial...

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request 
Forms, then select the relevant support region for the product 
area of interest.

3 Enter the requested information and your question in the 
displayed form, then click Ask Us RIGHT NOW (blue button with 
yellow text).

4 Enter the required information in the next form (if you have not 
already done so), then click Ask Us RIGHT NOW.

You will receive an e-mail reply to your question from one of our 
technical experts within 24 to 48 hours.
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To Obtain
Documents on

Demand

Free, 24-hour access to Applied Biosystems technical documents, 
including MSDSs, is available by fax or e-mail or by download from our 
Web site.

To order 
documents... Then...

by index 
number

a. Access the Applied Biosystems Technical Support 
Web site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you 
want, then find the document you want and record 
the index number.

c. Use the index number when requesting documents 
following the procedures below.

by phone for 
fax delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 
1-858-712-0317.

b. Follow the voice instructions to order the 
documents you want.

Note There is a limit of five documents per request.

through the 
Internet for fax 
or e-mail 
delivery

a. Access the Applied Biosystems Technical Support 
Web site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of 
document you want.

c. Enter or select the requested information in the 
displayed form, then click Search.

d. In the displayed search results, select a check box 
for the method of delivery for each document that 
matches your criteria, then click Deliver Selected 
Documents Now (or click the PDF icon for the 
document to download it immediately).

e. Fill in the information form (if you have not 
previously done so), then click Deliver Selected 
Documents Now to submit your order.

Note There is a limit of five documents per request 
for fax delivery but no limit on the number of 
documents you can order for e-mail delivery.
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Planning Genotyper 
Applications 2
Chapter Overview

Introduction This chapter discusses techniques for collecting and preparing sample 
data that will help you improve the overall quality of the GeneScan data 
you import into Genotyper. It also discusses how to plan for use of 
Genotyper features in your genotyping application.

In This Chapter This chapter contains the following topics:

Topic See Page

Preparing Sample Data for Genotyper 2-2

Completing a GeneScan Sample Sheet 2-3

Planning for Automation 2-6

Planning for Linking to GenBase 2-9

2
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Preparing Sample Data for Genotyper

Introduction Genotyper analyzes the results of fragment analysis data collected by 
an ABI PRISM instrument, and generated by GeneScan. 

Perfecting techniques for preparing fragment samples, collecting 
sample data, and using GeneScan to size and quantify fragments will 
simplify automation of many Genotyper tasks, and minimize editing 
tasks required to achieve quality genotyping results.

Preparing
Fragment Samples

The source of your fragment samples often affects peak resolution in 
Genotyper plot displays.

When preparing fragment samples for eventual sizing and quantitation 
by GeneScan, adjust pooling conditions to dilute the amplified products 
that consistently yield off-scale data. You can obtain optimal results with 
peak heights of ~1000 fluorescent units.

For more information on optimizing sample preparations for GeneScan 
analysis, see the GeneScan Chemistry Guide.

Optimizing Data
Collection

Optimizing run conditions on your ABI PRISM instrument will ensure a 
higher quality of fragment data.

� Make sure gel run parameters are consistent from run-to-run.

� Choose the right Matrix for the right type of gel and run parameters.

For more information on optimizing run conditions, see the user’s 
manual for the ABI PRISM instrument that you are using.
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Completing a GeneScan Sample Sheet

Introduction You must completely fill out a GeneScan Sample Sheet before running 
samples on your ABI PRISM instrument (Figure 2-1).

For detailed information on how to correctly fill out a GeneScan Sample 
Sheet, see the instrument user’s manual for the ABI PRISM instrument 
that you are using or the GeneScan Analysis User’s Manual.

Example of a
GeneScan Sample

Sheet

Sample Sheets identify the lane number and contents of each sample 
that you run when electrophoresing samples on an ABI PRISM 
instrument. 

Figure 2-1 Example of a GeneScan Sample Sheet
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How Genotyper
Uses Sample Sheet

Information

Sample Sheet information from GeneScan is essential for associating 
the nature of sample fragments with individual dye/lanes and tables in 
Genotyper. For example, Figure 2-2 shows how Genotyper 
incorporates information entered in the Sample Info and File Name 
fields of a GeneScan Sample Sheet into Genotyper tables.

Figure 2-2 GeneScan Sample Sheet data used in Genotyper tables

GeneScan Sample Sheet

Genotyper table
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Sample Subfield
Example

When you fill in the Sample Info field of the GeneScan Sample Sheet, 
you can edit the Sample Info field and create Sample subfields. You can 
use Sample subfields for Genotyper table entries when you create 
tables.

Example

Plan for the Find
Command

You can increase the utility of the Find command in Genotyper by 
carefully planning the format of the information you put into the Sample 
Info field of the GeneScan Sample Sheet.

Example

If you have 12 samples, numbered 1, 2, 3, ..., 12, and you enter these 
numbers into the Sample Info field, then, when you search for all 
dye/lanes containing a “1” in the Sample Info field, not only will you 
select sample 1, you will also get samples 10, 11, and 12. 

A better plan would be to number the samples 01, 02, 03, and so on, so 
that a search for the text “01” would select only the desired dye/lanes. 

In addition, you can place key words in the Sample Comments field that 
distinguish samples from each other. For example, enter “ladder” for 
those lanes or capillaries containing allelic ladders.

Vertical bars separate 
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Planning for Automation

Introduction In Genotyper, you can automate many of the repetitive genotyping 
tasks, simplifying such analysis procedures as importing GeneScan 
data, labeling peaks, filtering peak labels, and working with plot and 
table information.

Planning for automation involves choosing the appropriate Genotyper 
automation feature and the appropriate genotyping tasks to automate 
for each project.

Ways to Automate
To automate different genotyping tasks: 

Genotyping Task Automation Method See 

Importing Sample files Running the Set Import 
Macro

“Importing GeneScan 
Files” on page 3-13

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

Defining categories Defining Categories “Defining Categories 
for Labeling” on 
page 6-4

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

Selecting Dye/lanes Using the Find 
Command

“Searching and 
Sorting Through 
Lists” on page 5-9

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16
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Labeling peaks Automatic Peak 
Labeling

“Automatic Peak 
Labeling” on 
page 6-26

Defining Categories “Defining Categories 
for Labeling” on 
page 6-4

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

Filtering labels Automatic Label filtering “Filtering Labels” on 
page 6-29

Defining Categories “Defining Categories 
for Labeling” on 
page 6-4

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

Generating plots Defining Categories “Defining Categories 
for Labeling” on 
page 6-4

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

To automate different genotyping tasks: (continued)

Genotyping Task Automation Method See 
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Generating tables Defining Categories “Defining Categories 
for Labeling” on 
page 6-4

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Using a Template “Using and Creating 
Templates” on 
page 4-16

Exporting genotyping 
data

Using a Template “Using and Creating 
Templates” on 
page 4-16

Creating a Macro “Creating Macros 
from the Step List” on 
page 4-12

Setting Linked Program 
Preferences

“Planning for Linking 
to GenBase” on 
page 2-9

To automate different genotyping tasks: (continued)

Genotyping Task Automation Method See 
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Planning for Linking to GenBase

Introduction One of the components of the ABI PRISM Genotyping Software System, 
GenBase, is a genotype and phenotype database. It can store relevant 
sample, or disease information, phenotype information as well as 
Genotyper results data.

If you are planning to link to the GenBase database application after 
performing genotyping tasks, you must first install GenBase, and 
prepare the database for data exchanges.

Preparing
GenBase for

Linking

The following table shows which topics to refer to in the ABI PRISM 
GenBase User’s Manual for instructions. 

For instructions on... See 

Installing GenBase “Chapter 1, 
Introduction”

Planning for the kinds of Tables you are going to use 
when Linking to GenBase

“Chapter 2, 
Preparing the 
Database”

Preparing the database for data exchange with 
Genotyper

“Chapter 2, 
Preparing the 
Database”





Getting Started 3-1

Getting Started 3
Chapter Overview

Introduction This chapter discusses how to work with Genotyper Documents to 
produce results meaningful to your particular research activities. It 
covers some of the basic Genotyper procedures required for all 
genotyping applications.

In This Chapter This chapter contains the following topics:

Topic See Page

Choosing a Genotyping Application 3-2

Opening Genotyper Documents 3-8

Starting from the Main Window 3-9

Viewing Genotyper Document Windows. 3-11

Importing GeneScan Files 3-13

Editing Document Lists 3-16

Editing Document Windows 3-18

Locking and Unlocking Documents 3-19

Printing Genotyper Document Windows 3-20

3
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Choosing a Genotyping Application

Introduction The first step in using Genotyper is to decide what kind of genotyping 
application you want to run. Choosing a genotyping application is the 
first step in planning your Genotyper project. The features of Genotyper 
that you use, and how you use them depend on what kind of genotyping 
application you choose to run.

Kinds of
Genotyping

Applications

Genotyper enables you to organize your analyzed fragment data into 
tables. Tables can provide an interpretation of peak data meaningful to 
your particular genotyping studies. You can print Genotyper tables or 
export them to databases or other software applications for further 
analysis. 

Kinds of tables Genotyper can produce for some genotyping 
applications: 

 For this application... Genotyper can produce... For details see...

Linkage Mapping A table of alleles that you 
can export to a mapping
application or a database.

“Linkage 
Mapping” on 
page 3-4

Gene Expression 
Profiling

A comparative analysis 
table containing normalized 
data.

“Gene 
Expression 
Profiling” on 
page 3-6

AFLP A comparative analysis 
table of polymorphic peaks 
that shows the presence or 
absence of peaks.

“Web Site 
Information” on 
page 1-8

Paternity Testing A table of alleles that have 
been checked for Mendelian 
inheritance.

“Checking for 
Mendelian 
Inheritance” on 
page 8-37

Forensics/Human 
Identification

A genotype table to 
discriminate between 
individuals.

The ABI PRISM 
Genotyper 2.0 
Applications 
Tutorials

 SSCP A table of alleles identifying 
mutants and wild types.

The ABI PRISM 
Genotyper 2.0 
Applications 
Tutorials
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Loss of Heterozygosity A table of peak height ratios 
that identifies loss of 
heterozygosity in DNA 
samples from tumor cells 
and normal cells.

“Using Analyze 
and Calculate in 
Table 
Commands–An 
LOH Example” 
on page 8-26

Kinds of tables Genotyper can produce for some genotyping 
applications: (continued)

 For this application... Genotyper can produce... For details see...
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Linkage Mapping Linkage mapping applications identify polymorphic fragments by size.

Steps for using Genotyper for linkage mapping applications and where 
to find related task information for performing each step follow.

To import and analyze data: 

Step Action See 

1 Allocate enough memory for the number of 
GeneScan files that you are going to 
import.

“Setting Memory 
Allocation” on 
page 1-11

2 Import GeneScan data. “Importing GeneScan 
Files” on page 3-13

3 Are you using a Template?

Yes, go to step 5.

No, go to next step.

“Using and Creating 
Templates” on 
page 4-16

4 Define categories. “Defining Categories 
for Labeling” on 
page 6-4

5 Select dye lanes. “Working with 
Dye/lane Lists” on 
page 5-1

6 Label peaks. “Approaches to 
Labeling” on page 6-2

7 Filter labels. “Filtering Labels” on 
page 6-29

8 Make a table. “Setting Up a Table” 
on page 8-2



Getting Started 3-5

To review analyzed data: 

Step Action See

1 View plot data. “Viewing Plots of 
Imported Dye/Lanes” 
on page 7-2

2 Check for overflows.

Are there more than two alleles?

Yes, manually remove unwanted labels.

No, go to next step.

“Removing Labels” on 
page 6-42

3 Update table. “Updating Tables” on 
page 8-35

To export data: 

Step Action See

1 Export data:

� To GenBase � “Importing and 
Exporting 
Results Data” on 
page 10-4

� To a spreadsheet or linked programs � “Linking to 
Programs and 
Files” on 
page 11-1

� To a file � “Exporting Tables” 
on page 8-46

2 Print results. “Printing Genotyper 
Document Windows” 
on page 3-20
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Gene Expression
Profiling

Gene expression applications analyze the quantities of nucleic acid 
fragments in analyzed samples in terms of peak heights and peak 
areas.

Steps for comparing peak quantities and where to find related task 
information for performing each step.

To quantify sample fragments: 

Step Action See 

1 Allocate enough memory for number of 
GeneScan files you are going to import.

“Setting Memory 
Allocation” on page 1-11

2 Import GeneScan data. “Importing GeneScan 
Files” on page 3-13.

3 Are you using a Template?

Yes, skip Defining categories.

No, go to next step.

“Using and Creating 
Templates” on 
page 4-16

4 Define categories. “Defining Categories for 
Labeling” on page 6-4

5 Select dye/lanes in the Dye/lane list. “Working with Dye/lane 
Lists” on page 5-1

6 Label peaks. “Approaches to 
Labeling” on page 6-2

7 Filter labels. “Filtering Labels” on 
page 6-29

To compare sample quantities: 

Step Action See

1 Normalize labels by control peaks “Labeling Normalized 
Peaks—an Example” on 
page 6-45

2 View plot data “Viewing Plots of 
Imported Dye/Lanes” on 
page 7-2

3 Generate a table “Setting Up a Table” on 
page 8-2
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4 Normalize Labels

� Using scale factors � “Using Scale Factors 
for Quantitative 
Applications” on 
page 5-15

� Using Normalize Peaks command � “Labeling Normalized 
Peaks—an 
Example” on 
page 6-45

� Using Calculate in Table command � “Calculating Results 
from Table Data” on 
page 8-19

To export results data: 

Step Action See

1 Export data

� To a third-party application � “Linking to Programs 
and Files” on 
page 11-1

� To a file � “Exporting Tables” on 
page 8-46

2 Print results “Printing Genotyper 
Document Windows” on 
page 3-20

To compare sample quantities: (continued)

Step Action See
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Opening Genotyper Documents

Definition In Genotyper, you perform all tasks in a Genotyper Document. All 
Genotyper Documents show different representations of size and 
quantity data for associated GeneScan files and results of all analysis 
tasks performed in Genotyper.

You can view the different parts of a Genotyper Document by opening 
document windows from the Main window.

How to Open
Genotyper
Documents

The steps for opening Genotyper Documents differ depending on 
whether you are opening an existing Genotyper Document, or creating 
a new one. 

To open a Genotyper document: 

If you... Then...

Are working with an existing 
Genotyper Document or 
a template file

a. Choose Open...from the File 
menu.

b. Locate and select the 
document you want to open.

c. Click Open.

Do not have an existing 
Genotyper Document

Choose New from the File menu.
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Starting from the Main Window

Definition The Main window displays all parts of a Genotyper Document. You 
perform all Genotyper tasks from the Main window, or from Document 
windows you can open within the Main window that let you view 
GeneScan file data, and results data in different formats.

The Main Window When you open a new Genotyper Document, a blank Main window 
appears. Once you import GeneScan data and create all the parts of a 
Genotyper Document, the Main window will look like the figure below. 

Figure 3-1 The Main Window
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7
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Parts of the Main
Window

The following table describes the parts of the Main Window in Figure 3-
1 on page 3-9.

Item Name Description

1 Dye/lane list Shows specific dye/lanes available for 
analysis.

2 Upper Graphical 
Area

Shows electropherogram plots.

3 Lower Graphical 
Area

Shows peak labels.

4 Category list Shows criteria for a group of peaks selected 
on the basis of parameters you define using 
the category features. For example, dye color, 
size, or height.

5 Table Area Shows tabular data for created tables.

6 Macro list Lists the names of the macros that you have 
created and can run.

7 Window selection 
buttons

Open windows for a particular Genotyper 
document, and provides access to GenBase 
and GenoPedigree data.

8 Step list Contains the list of steps for the current Step 
Log or the macro selected in the Macro list.

Main window

Dye/lane List window

Plot window

Table window

Category window

GenoPedigree

GenBase



Getting Started 3-11

Viewing Genotyper Document Windows.

Introduction From the Main window, you can open windows that allow you to view 
parts of a Genotyper Document related to specific kinds of data. 

Opening
Document
Windows

Document windows display the different parts of a Genotyper 
Document.

Example

If you want to view details of plot data, you can open up the Plot 
window.

To use the selection buttons to open Document windows: 

To see the... Click... And Genotyper displays...

Dye/lane 
window

Category 
window
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Saving Documents You can save a Genotyper Document as a file. Although the different 
types of document windows for a document are not saved individually, 
all of the data for the document is saved in one file regardless of which 
windows are open at the time you save the document.

Plot window

Table window

To use the selection buttons to open Document windows: (continued)

To see the... Click... And Genotyper displays...
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Importing GeneScan Files

Introduction Importing GeneScan files supplies peak data for all Genotyper tasks. A 
GeneScan file can be a Sample file (GeneScan version 2.0 or later), or 
a Results file (GeneScan 1.x versions).

IMPORTANT You cannot import GeneScan Gel files.

Process When you import a GeneScan file in Genotyper, Genotyper extracts 
Sample file information and generates one Dye/lane list entry for each 
dye color of each lane. Each Dye/lane list entry contains size, quantity, 
and sample information for all fragments labeled with a single dye color 
and electrophoresed in a single lane.

For more information on how Genotyper generates dye/lanes from 
imported GeneScan data see, “Where Dye/lanes Come From” on 
page 5-2.

Ways to Import
GeneScan Files

You can either import GeneScan data all at once or in batches. There 
are advantages and disadvantages to both approaches.

The advantages and disadvantages of importing GeneScan data all at 
once or in batches:

Way to Import Advantages Disadvantages

All GeneScan data 
at once.

Useful when you are 
importing data from 
a few gels or 
approximately 36 
lanes or capillaries.

More convenient. You 
can see all results after 
performing the 
command just once.

� Requires that you 
allocate more 
memory to 
Genotyper for more 
than 36 lanes.

� Inefficient processing 
will slow down the 
operation.

In batches.

Useful when you are 
importing data from 
many gels or more 
than 36 lanes or 
capillaries.

� More GeneScan data 
can be processed 
more efficiently.

� Does not require as 
much memory 
allocated to 
Genotyper.

You cannot see all 
dye/lanes at one time.
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Storing GeneScan
Files

When setting up and running gels, the number of gels you run and the 
number of lanes in each gel determines the number of GeneScan 
sample files in a project.

Example

Number of Gels x Number of lanes = Number of GeneScan sample files

Note You usually do not need to refer to Gel files once Sample files have 
been generated from them.

You can optimize the performance of the ABI PRISM Genotyping 
Software System if you store all GeneScan sample files in one location, 
for example one shared disk on a file server, and process all data from 
that storage location. If you move GeneScan sample files around, then 
GenBase will not be able to locate them if you want to refer to them at a 
later time.

How to Import
GeneScan Files To import GeneScan files: 

Step Action

1 Choose Edit: Set Preferences...

The Set Preferences dialog box opens.
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Importing Project
Files

You can import all files in a GeneScan Project by selecting the project 
file and clicking import.

Import All does not include Project files. If you want to import from more 
than one project file, you must select each project file one at a time.

2 Select the appropriate checkboxes for import options.

3 Choose Import GeneScan Files...from the FIle menu.

The Import GeneScan Files dialog box appears.

4 Locate and select the GeneScan Sample file, or Results file that you 
want to import.

5 Click Import.

If you want to import all GeneScan files in a folder, select one file in 
the folder, then click Import All.

Genotyper remembers the last folder from which you imported files.

To import GeneScan files: (continued)

Step Action

If you 
select... Then Genotyper imports...

Import raw 
data

Unprocessed collection data, as well as data 
processed by GeneScan.

Note Not selecting the Import raw data 
checkbox will improve system performance 
when importing large numbers of GeneScan 
files.

Import colors Imports only sample fragment data labelled with 
the dye color you select.
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Editing Document Lists

Introduction Genotyper supplies a number of general editing tools that you can use 
to modify items in Genotyper Document Dye/lane lists, Category lists, 
or Macro lists.

Making a List
Active

A vertical bar to the left of a list indicates that list is active. This means 
that all the edit commands apply only to this list.

To make a list active, press the tab key repeatedly until the thin vertical 
bar appears to the left side of the list you want to make active.

Vertical bar
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Selecting Items in
a List

To edit entries for any list item in Genotyper, you must first select the 
items you are going to edit. 

To select items in a list: 

If you are selecting... Then...

A single item � Click on the item in the list.

The item is highlighted, indicating that it is 
selected.

A range of continuous 
items

� Click on an item in the list.

� Hold down the shift key and click on the last 
item in the range.

All the items in the range are highlighted.

Discontinuous items in a 
list

� Click on an item in the list.

� Hold down the command key and click on 
another item.

� Repeat the previous step for each item you 
want to select.

Only the items selected are highlighted.
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Editing Document Windows

Using the Cut,
Copy, and Paste

Commands

The Cut, Copy, and Paste commands available from the Edit menu 
allow you to transfer the same type of information from one window to 
another. For example, if you copy an item in a Macro list in one window 
and paste it into a Macro list in another window, all of the macro data 
will be transferred. However if you paste the same information onto 
another application, only the text is transferred; no data is transferred.

IMPORTANT Copying or pasting many dye/lanes from one document to 
another requires a lot of memory. Therefore, we recommend that you copy or 
paste only a few dye/lanes at a time.

Using the
Clipboard

Items you copy from Genotyper Document windows will appear on the 
Clipboard. 

To view the Clipboard, choose Show Clipboard in the Edit menu.

Note The Clipboard stores only the last item (or group of items) copied.

Copying Windows You can use the Copy Window command to copy a picture of the Main 
window or the Plot window.

To copy a window, choose Copy Window in the Edit menu.

A picture of everything in the active window (except the title bar) is 
copied to the Clipboard. You can now paste this image into a paint or 
draw program to edit it.
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Locking and Unlocking Documents

Introduction After you have created a set of categories, or macros, you can lock 
them to prevent accidental modification. Categories, macros, and steps 
that are locked cannot be edited or cleared until they are unlocked.

How to Lock
Documents

Choose Lock from the File menu.

Padlock icons appear next to the locked panes and in the File menu 
Lock is checked.

How To Unlock
Documents

Choose Unlock from the File menu.

The padlock icons disappear and in the File menu Unlock is checked.
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Printing Genotyper Document Windows

Introduction You can print any active Genotyper window in a Genotyper Document.

How to Print a
Document Window To print the Genotyper Document Window: 

Step Action

1 Select the Genotyper Document Window that you want to print.

2 Choose Page setup...from the File menu.

Your printer’s Page Setup dialog box appears.

3 Select the appropriate checkboxes and options.

4 Click OK.

5 Choose Print...from the File menu.

The Print dialog box appears.
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6 Enter a printing title.

If you are printing when the Main window is active, the Print dialog 
box prompts you to specify which part of the document that you 
want to print.

7 Select the appropriate radio button.

8 Click OK.

The Print dialog box appears.

9 Click Print to begin printing.

Note To print multiple dye/lane plots, choose Show Plot Window 
before printing.

To print the Genotyper Document Window: (continued)

Step Action
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Automating Genotyping 
Procedures 4
Chapter Overview

Introduction Genotyper can automatically perform all calculations, comparative 
analyses, and peak labeling activities once you specify appropriate 
settings and issue the appropriate sequence of commands. Using 
Genotyper macros, and templates, you can automate the setting of 
analysis parameters, and issuing of commands to perform either a 
particular analysis procedure, or all of the procedures for an entire 
genotyping application.

In This Chapter This chapter contains the following topics:

Topic See Page

Approaches to Automating Procedures 4-2

Running Macros 4-4

Recording Steps in the Step List 4-7

Editing the Step List 4-10

Creating Macros from the Step List 4-12

Using and Creating Templates 4-16

Using AppleScript Scripts 4-18

4
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Approaches to Automating Procedures

Introduction Genotyper uses templates, macros, and Apple Scripts to automate 
procedures for an application.

The macros and templates supplied with Genotyper automate 
procedures presumed necessary to complete particular genotyping 
applications. They serve as examples of actual procedures you might 
want to perform in your application. You must modify them for use with 
your particular Genotyper application.

Definitions
Definitions of terms used:

Term Definition

Template Templates are ready-to-use Genotyper applications. A 
Genotyper template contains the Category list and 
macros necessary for automatic analysis of particular 
applications.

Macro A macro is a sequence of commands or steps that you 
can run to perform a particular analysis procedure.

AppleScript AppleScript is a programming language that you use to 
create Scripts, lists of Genotyper commands for your 
computer to perform.
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Automation
Options

Genotyper supplies customizable templates for automating complete 
genotyping applications, and macros for automating individual 
procedures.

 Options for automating genotyping applications and procedures:

If you want to automate 
a Genotyping... And... Then See Topic

Application You know that a template 
for a similar application 
exists,

“How to Create 
Templates” on 
page 4-17.

Procedure within an 
application

You know that a macro 
exists for that procedure,

“How to Run 
Macros” on 
page 4-5.

You know that a macro 
does not exist for that 
procedure,

“How to Create a 
New Macro” on 
page 4-12.
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Running Macros

Introduction Running a macro executes a pre-defined set of Genotyper commands 
and functions that automates a procedure. Genotyper provides several 
macros that can serve as examples of the kinds of macros you can run 
to automate analysis tasks.

In addition to running supplied macros, you can create your own 
macros from the Step list, save them and run them. 

For more information on creating your own macros, see “Recording 
Steps in the Step List” on page 4-7.

Supplied Macros Genotyper supplies a number of sample macros on the Tutorials disk 
that you can select and run to perform Genotyper procedures. 

Tips for Running
Macros

You can set preferences so that you can run macros by double-clicking 
a macro after selecting it. Choose Set Preferences from the Edit menu, 
and select the Double-clicking runs macros & steps checkbox.
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How to Show the
Macro Window

The Macro window shows macros that are stored in the active 
Genotyper Document or Template.

How to Run
Macros

You can run any macro that is displayed in the Macro list.

To show the Macro window: 

Step Action

1 Open the Main window

2 From the Views menu, select Show Macro window.

The Macro window appears.

To run a macro: 

Step Action

1 From the Macro List, select a macro.

2 Choose Run Macro from the Macro menu.

All of the steps in the selected macro are run automatically.

Note You can assign a command key combination when a macro 
is created to run the macro. If a command key is assigned, simply 
press z-[assigned key] to run the macro.
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How to Run a
Macro After

Importing
GeneScan Data

You can use the Set Import Macro command to specify a macro that 
you want to run immediately after you have imported GeneScan data 
into Genotyper.

To use the Set Import command: 

Step Action

1 Choose Set Import Macro from the Macro menu.

The Set Import Macro dialog appears.

2 Type in the name of the macro that you want to run immediately 
after you import GeneScan data.

3 Select the checkbox to run the macro automatically, and click OK.

The name of the macro selected to run automatically appears in the 
Import GeneScan data dialog box.
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Recording Steps in the Step List

Definition The Step list records many of the Genotyper commands after you issue 
them. You can create macros from the steps you record in the Step list.

Location of Step
Window

The Step list appears in the Step window, located in the lower 
right-hand corner of the Main window. 

Step window
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How to Show the
Step Window

The Step window shows the current list of recorded steps, or the steps 
that make up a macro.

Displaying
Commands issued

in Documents

When you select Current Step Log in the Macro list of the Macro 
window, and show the Step window, Genotyper displays commands you 
have issued since you last cleared the Step Log.

To display the Step window:

Step Action

1 Open the Main Window.

2 Select a macro in the Macro list of the Macro window.

3 From the Views menu, select Show Step window. 

The Step window showing the steps for the currently selected 
macro, appears.
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How to Record
Steps

Genotyper records most tasks you perform or commands you issue as 
a step in the Step list. 

How to Turn Off
Step Recording

If you are not making a macro, and do not want to fill up the Step list, 
you can turn off step recording.

To record steps in the Step list: 

Step Action

1 Pull down the Macro menu and verify that Record Steps is checked, 
If it’s not checked, click it to activate it.

2 Actions you perform in Genotyper, such as marking, labeling, and 
filtering are recorded as steps in the Step list.

1st action
taken

2nd action

To turn off the recording of steps: 

Step Action

1 Pull down the Macro menu.

2 Click Record Steps to deactivate it.
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Editing the Step List

Introduction You can edit the contents of your current Step list before or after 
creating a macro.

How to Edit a Step You can edit steps in the Step list, and change the parameters set when 
you performed the step.You can only edit steps in the Step list that 
involve making selections from a dialog box. 

To edit steps in the Step list:

Step Action

1 Select a step from the Step list.

2 Choose Edit Step...from the Macro menu.

The dialog box for that step appears.

This figure shows an example of the dialog box that appears if you 
edit the step for a Label Peaks...command.

3 Change any of the parameter settings in the dialog box that 
appears.

4 Click Replace.

The step with edited parameter settings replaces the original step.

Note You cannot change a step to a completely different type of 
step.
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Copying and
Pasting from the

Step List

You can Cut, Copy and Paste steps to change the sequence of steps in 
the Step list.

How to Run a Step If you want to find out what genotyping task a step performs, you can 
run that step from the Step list.

To copy and paste steps in the Step list:

Step Action

1 Select a step in the Step list.

2 Choose Copy from the Edit menu.

3 Click on the step that precedes the place you want the copied step 
to be inserted.

4 Choose Paste from the Edit menu.

The step is pasted in the place you selected in the Step list.

To run a step in the Step list:

Step Action

1 Select a step in the Step list.

2 Choose Run Step from the Macro menu.

This runs the step you selected, and repeats that step in the Step 
list.

Note If you have set preferences appropriately, you can double-
click on a step to run it.
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Creating Macros from the Step List

Introduction If a macro does not already exist for a particular genotyping procedure 
that you plan on running repeatedly, you can create a macro that 
performs all of the steps in the procedure, and run it each time you want 
to repeat that procedure for a different set of GeneScan data. 

How to Clear the
Step List

Before you record steps for a macro, you will want to clear the Step list 
of steps that have been previously recorded.

How to Create a
New Macro

Once you have cleared the Step list of all previously recorded steps, 
you can create a new macro for a genotyping procedure by performing 
all of the steps in the procedure once. Genotyper records each of the 
steps in the Step list.

Note You can select more than one macro at a time from the Macro list to Cut, 
Copy, and Paste. If more than one macro is selected, nothing appears in the 
Step list.

To clear the Step list:

Step Action

1 Make sure that you have selected the Current Step Log in the 
Macro window.

2 Choose Clear Step Log from the Macro menu.

To create a new macro: 

Step Action

1 Pull down the Macro menu and verify that Record Steps is checked, 
If it’s not checked, click it to activate it.

2 Perform all of the steps in the genotyping procedure for which you 
want to create a macro.

Check the Step list to make sure that each step has been recorded.
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3 Choose Save Step Log...from the Macro menu.

The New Macro name dialog box appears

.

4 Enter the name of the new Macro in the text box.

5 Click the checkbox and enter the key you want to press with the 
command key to run this Macro from the keyboard.

6 Click OK.

7 The new Macro appears in the Macro list.

To create a new macro: (continued)

Step Action

Keyboard 
command for this 

New macro 
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How to Change a
Macro Name

You can change the name of any macro.

IMPORTANT If any other macros refer to the macro whose name was 
changed, you must edit those other macros to use the new name.

To change the name of a macro: 

Step Action

1 Select a macro from the Macro list.

2 Choose Change Macro Name...from the Macro menu.

The New macro name dialog box appears with the name of the 
macro in the text box.

3 Enter the new macro name.

4 Click OK.

The new macro name should now appear in the Macro list. The 
comment step at the beginning of a macro does not change when 
you change the name of the macro.
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How to Add a
Comment to a

Macro

You can add a comment about any macro in the Macro list, and make 
the comment appear in the macro.

To add a comment to a macro: 

Step Action

1 Choose Add Comment...from the Macro menu.

The Add Comment dialog box appears.

2 Type in a comment that you want to append to the macro.

3 Click OK.

The comment appears in the Current Step Log. 

4 To make the comment appear in a macro, you can cut and paste it 
into the macro.
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Using and Creating Templates

Definition Genotyper provides a number of templates that automate all 
genotyping and analysis tasks for specific applications. Each template 
is designed for a specific Genotyper application and uses sample 
GeneScan data to demonstrate how to use it.

Supplied
Templates

Genotyper supplies templates containing procedure examples for 
different kinds of Genotyper applications. The template name describes 
the kind of application it automates.
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How to Create
Templates

To create a template, you modify any existing template for your specific 
application.

Saving Templates
as Stationery Pads

Saving a template as a stationary pad prevents it from being changed 
accidentally. A stationary pad can be opened and used, but any 
changes made can only be saved as a separate document. 

To create a template for your specific application:

Step Action

1 Make a copy of a supplied template that describes the kind of 
application that you are running.

2 In the copy, delete the Category list.

3 Make a new Category list specific for your application.

4 Choose Save As....

5 Name the new template.

To save a template as a stationary pad:

Step Action

1 Click on a template icon in the Finder to select it.

2 Choose Get Info from the File menu.

The Template info window appears.

3 Click the Stationary pad checkbox at the bottom of the info window.

4 Click the Close box in the upper left-hand corner of the window.The 
Template is now saved as a stationary pad. The bottom right corner 
is folded.

Top right corner is folded

Bottom right corner is folded
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Using AppleScript Scripts

Introduction You can use the AppleScript programming language to create Scripts 
that can combine the capabilities of Genotyper with related analysis 
applications. Using Scripts, you can give your computer a list of things 
you want it to do, and let the computer do everything on your list.

System
Requirements

You can use Apple Scripts on Power Macintosh computers that use 
system software version 7.5.3 or later.

How to Create
Scripts

Like all programs that can be customized with Scripts, Genotyper has 
an AppleScript dictionary. Use the AppleScript editor provided with the 
system software to create Scripts for automating Genotyper 
procedures.

See the AppleScript documentation supplied with your Apple system 
software, for instructions about how to use AppleScript Scripts.

To create Scripts for your specific application:

Step Action

1 Turn on the Script Editor’s recorder and perform a set of Genotyper 
procedures.

AppleScript keeps a list of what you do while the recorder is turned 
on.

2 Turn the recorder off. 

You can see the recorded Script.

3 When you run the Script, your computer repeats your actions 
automatically.
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Working with 
Dye/lane Lists 5
Chapter Overview

Introduction Dye/lanes contain sample information for electrophoresed nucleic acid 
fragments. They provide the source data for all Genotyper procedures. 
Genotyper Documents contain a list of all dye/lanes related to that 
document. This chapter discusses how you can view, search, and use 
the information contained in Dye/lane lists to perform particular 
genotyping analysis tasks.

In This Chapter This chapter contains the following topics:

Topic See Page

Where Dye/lanes Come From 5-2

Viewing Dye/lane Lists 5-4

Searching and Sorting Through Lists 5-9

Editing List Contents 5-14

Using Scale Factors for Quantitative Applications 5-15

5
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Where Dye/lanes Come From

Introduction Dye/lane lists contain entries that correspond to imported GeneScan 
files. You use information contained in Dye/lanes for all Genotyping 
comparison and analysis tasks.

Phases of the
Process

Genotyper generates from one to four dye/lanes for each lane of each 
GeneScan file you import. The following diagram shows three phases in 
the process of generating Dye/lane list entries from electrophoresed 
dye-labeled nucleic acid fragments (Figure 5-1).

Figure 5-1 Where Dye/lane lists come from

Blue dye-labels

Green dye-labels

Yellow dye-labels

Red dye-labels

Import GeneScan data
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What Happens in
Each Phase

What happens in each phase of the dye/lane generation process. 

Phase Process

1 Nucleic acid fragments are labeled with one to four different dye 
colors (blue, green, yellow, red), and electrophoresed in a single 
lane (lane 2) of a gel based automated DNA sequencer.

2 GeneScan extracts fragment information from lanes or 
capillaries and generates one GeneScan file per lane or 
capillary. Each GeneScan file contains size and quantity 
information for each dye/labeled fragment.

3 When you import a GeneScan file in Genotyper, Genotyper 
extracts file information, and generates one dye/lane list entry for 
each dye color. Each dye/lane list entry contains size, quantity, 
and sample information for all fragments labeled with a single 
dye color and electrophoresed in a single lane. 
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Viewing Dye/lane Lists

Definition The Dye/lane list is a list of all dye/lanes in the GeneScan data that you 
have imported into Genotyper. Dye/lanes are added to the list as you 
import them from GeneScan. 

Settings in the Dye/lane sorting dialog box determines the sort order of 
the list. For more information on sorting dye/lane lists see “Searching 
and Sorting Through Lists” on page 5-9.

Setting Viewing
Preferences

You can set preferences for the information that appears in the Dye/lane 
list when you view it. Preference settings apply to all open Genotyper 
Documents, not just the active document, and are saved in the 
Genotyper Preferences file.

To set Dye/lane list viewing preferences: 

Step Action

1 Choose Set Preferences...in the Edit menu.

The Set Preferences dialog box appears.
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2 Under the bullet “Information to be shown in dye/lane list:”, select 
the checkboxes for what you want to view in the Dye/Lane list.

To set Dye/lane list viewing preferences: (continued)

Step Action

If you click... Then the Dye/Lane list displays...

File Name The name of the associated GeneScan 
file.

Dye color The dye color of sample fragment labels.

Sample Info Contents of Sample Info field of the 
GeneScan Sample Sheet.

Lane number The lane number, or injection number for 
ABI PRISM 310 samples, in which sample 
fragments were electrophoresed.

Scale factor Normalization factor that you can apply to 
dye/lane peaks.

Sample Comment Comments entered in the GeneScan 
Sample Sheet.
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Viewing the
Dye/Lanes

Window

The Dye/lanes window displays the Dye/lanes list, and also contains 
associated Sample Information and Sample Comments from 
GeneScan files.

To view the Dye/Lanes window: 

Step Action

1 From the Main Window, click the Dye/lane window icon. 

The Dye/lanes window appears.

2 Click on the dye/lane of interest, for example, the first one.

This displays Sample Information, and Sample Comments for the 
selected Dye/lane, and allows you to edit these items. These fields 
contain the same information that was entered in the Sample Sheet 
for associated GeneScan files.

! WARNING ! Information in the Dye/lanes window is not 
saved back into the original GeneScan files. The edited data in 
the Sample Info and Sample Comment fields applies only to 
the current Genotyper Document.
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Clearing the List Imported GeneScan data are appended to the Dye/lanes list. Therefore, 
if you are beginning a new Genotyping session, you might want to clear 
existing GeneScan data from the list

Selecting Dye
Colors

Using the Dye Selection buttons you can select those lanes that have 
sample fragments labeled with the dye color you select.

To clear the Dye/lane list:

Step Action

1 Choose Clear Dye/Lane List in the Analysis menu.

The Dye/Lane list is cleared.

Note If you want to undo this command, choose Undo in the Edit 
menu. The Undo command must be the next command.

To display Dye/lanes by the color of the dye-label on fragments in the 
lane: 

Step Action

1 If the Main window is not already displayed, choose Show Main 
Window from the Views menu.

The Main Window appears.

Selection 
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2 Click one of the four Dye Selection buttons to select only dye/lanes 
labeled with the selected dye colors; B (blue), G (green), Y (yellow), 
R (Red).

To add to your selection, hold down the Shift key and click another 
Dye Selection button.

To display Dye/lanes by the color of the dye-label on fragments in the 
lane: (continued)

Step Action
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Searching and Sorting Through Lists

Introduction For many Genotyper applications, particularly ones in which you import 
a large number of GeneScan files, you will often want to locate 
dye/lanes for particular GeneScan Sample files, or Results files. 
Genotyper offers several search and sorting features that make it easy 
for you to locate the particular dye/lane or GeneScan file.

How to Sort
Dye/lanes

You can sort the Dye/lanes by various items. You can choose a different 
sorting order for each Genotyper Document. 

To change the sort order of the Dye/lane list: 

Step Action

1 If the Main window is not already displayed, choose Show Main 
Window from the Views menu.

The Main Window appears.

2 Choose the Dye/lane sorting...command in the Views menu.

The Dye/lane Sorting dialog box appears.

3 From the pop-up menus, select items that you want Genotyper to 
sort next to the precedence number in which you want Genotyper 
to sort them. 

Example

If you choose File name after Precedence 1, and Lane number 
after precedence 2, Genotyper first sorts the list by File name, then 
sorts that list by lane number.
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How to Specify
Search Criteria

You can specify search criteria for finding one or more dye/lanes in the 
Dye/lane list. For example, you might specify all colors with the text 
“001101” in Sample Information. Find commands are recorded and can 
be used as steps in a Genotyper macro.

4 Click the radio button for how you want items in the list sorted, 
either in ascending order or descending order.

Dye colors are sorted in the following ascending order: blue, green, 
yellow and red.

Note If you use the Overlapped dyes, separate lanes option, the 
dye/lanes must be sorted by File name first and then Lane number.

5 Click OK to apply the sorting order to the active Genotyper 
Document.

Click Cancel to cancel the sorting selections you have made.

To change the sort order of the Dye/lane list: (continued)

Step Action

To specify a search criteria: 

Step Action

1 Choose Find...(z-F) in the Edit menu.

The Find dialog box appears.

2 Click the Find the following text radio button.

3 Type in the text you want to locate.
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4 Click the Look in the dye/lane list radio button. 

5 Select the checkboxes for how and where you want Genotyper to 
search for the text string that you have typed 
(see “How to Search for Dye/lanes” on page 5-12). 

Example

If you entered the text “001101” and selected the 
checkbox for In Sample Comment, Genotyper would search for the 
specified text in the Sample Comment fields of all dye/lanes.

6 Click OK.

To specify a search criteria: (continued)

Step Action
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How to Search for
Dye/lanes

Once you have defined search criteria (see page 5-10), choose how 
you want to search for dye/lanes in the list. The following table shows 
you how you can search for dye/lanes.

If you are... Then...

Searching for all occurrences at 
once

Click the Find all occurrences at once 
checkbox.

All dye/lanes with the designated text 
are selected. 

Adding dye/lanes to the current 
selection

Click the Add to current selection 
checkbox. 

Dye/lanes already selected remain 
selected. Dye/lanes located by this 
command are also selected.

Restricting the search to currently 
selected dye/lanes

Click the In selected dye/lanes only 
checkbox. 

This is useful for narrowing a selection 
by repeated use of the Find 
command.

Searching for the next occurrence 
of a selection

Choose Find Next (z-G) from the 
Edit menu.

The Find Next command repeats the 
last Find command, using the same 
options that were used in the last Find 
command.

Searching for text strings without 
regard to case

Choose Ignore upper/lower case 
differences.

The Find Next command locates all 
occurrences of the text string you 
have entered, ignoring the case of any 
letters you have entered.
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How to Locate
GeneScan Data

You can locate GeneScan data associated with a specific dye/lane.

To locate GeneScan data:

Step Action

1 Select a single dye/lane.

2 Choose Locate GeneScan File in the File menu.

The folder with the GeneScan sample file associated with that 
dye/lane is opened and the file is selected in the Finder.

Note If the file is located on an unmounted disk, a dialog box 
appears and asks you to insert the disk that the file is on.

IMPORTANT This feature works only if the dye/lanes are imported 
from GeneScan sample files. It will not work if the dye/lanes are 
imported from a BioLIMS database. You will need to open the 
Collection Browser to locate the GeneScan sample file in BioLIMS 
manually.
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Editing List Contents

Introduction If you want to change the information about any item in the Dye/lane 
list, you can edit related sample information in the Dye/lane window. 
These changes will affect only the Genotyper Document. The original 
GeneScan file remains unchanged.

Note You can make changes to only one dye/lane item at a time. If more than 
one dye/lane is selected or if none is selected, Sample information and Sample 
comments are grayed out.

How to Edit
Sample

Information

You can edit the sample information in the Sample Info field of the 
Dye/lanes window. 

How to Edit
Sample Comments

You can edit the Sample Comments in the Sample Comment field of the 
Dye/lanes window.

To edit the Sample Info field:

Step Action

1 Open the Dye/lanes window.

2 Select the item in the Dye/lanes list that you want to edit.

You can use the arrow keys on the keyboard to scroll up and down 
the items in the list.

3 Use the Tab key until the cursor goes to the Sample Info text box, or 
click in the box.

4 Type in any changes you want to make to the Sample Information.

To edit the Sample Comment field:

Step Action

1 Open the Dye/lanes window.

2 Select the item in the Dye/lanes list that you want to edit.

You can use the arrow keys on the keyboard to scroll up and down 
the items in the list.

3 Use the Tab key until the cursor goes to the Sample Comments 
field.

4 Type in any changes you want to make to the Sample Comments.
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Using Scale Factors for Quantitative Applications

Definition You can use dye/lane scale factors to normalize the height or area of 
peaks.

Why Use Scale
Factors

You can use scale factors for quantitative applications in which you are 
labeling peaks by height or area, and defining minimum and maximum 
peak heights in categories. 

By using scale factors you can normalize peak heights which helps 
correct for variations in starting quantities of nucleic acid samples, or 
variations in amount of samples initially loaded.

How to See Scale
Factors

When visible, scale factors appear next to each dye/lane in the 
Dye/lane list.

To show Scale Factors in the Dye/lane list:

Step Action

1 Choose Set Preferences...in the Edit menu.

The Set Preferences dialog box appears.

2 Under the bullet “Information to be shown in dye/lane list:”, select 
the Scale factor checkbox.

Scale factors now appear next to each dye/lane in the dye/lane list. 
The default scale factor is one.



5-16 Working with Dye/lane Lists

How to Calculate
Scale Factors

To calculate scale factors, determine parameters for the calculation, 
and then scale dye/lanes based on those parameters.

To calculate scale factors: 

Step Action

Determine parameters for calculation

1 In the Dye/lane list, select the dye/lane to which you want to scale 
other dye/lane peaks.

2 Choose Calculate Scale Factors from the Analysis menu.

The Calculate Scale Factors dialog box appears.

3 Select the radio button corresponding to how you want to scale 
peaks.

4 Optionally, you can restrict the calculation of scale factors to a 
particular range of peak sizes by typing in the peak sizes in the text 
boxes provided.

5 Click the Normalize button to set the scale factor of the first selected 
dye/lane peaks to 1.0.

IMPORTANT Record the number that fills in the divided by field 
after you click Normalize to first selected dye/lane. You will use it 
when you scale dye/lanes to defined parameters.

6 Click OK.

Scale dye/lanes to defined parameters

1 In the Dye/lane list, select all the dye/lanes that you want to scale to 
the parameters you just determined.
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Normalizing to the
First Dye/lane

If you are normalizing all dye/lanes to the first one in your selection, you 
do not have to perform the four steps listed under “Scale dye/lanes to 
defined parameters”. Instead, select all dye/lanes and perform the first 
six steps listed under “Determine parameters for calculation”.

How to Reset Scale
Factors to One

The default Scale Factor is one. To reset Scale Factors to one, choose 
the Clear All Scale Factors command from the Analysis menu.

Applying Scale
Factors to Other

Peaks

Once you have calculated scale factors for all peaks, you can apply the 
scale factors you have defined to any peaks in the Dye/lane list, not just 
the range you originally used to calculate the factor.

2 Choose Calculate Scale Factors from the Analysis menu.

The Calculate Scale Factors dialog box appears (see figure in step 
2 of “How to Sort Dye/lanes” on page 5-9).

3 In the Calculate Scale Factors dialog box, enter the same 
parameters that you entered when determining parameters for 
calculation, including the number in the divided by field.

IMPORTANT Do not click normalize to first selected dye/lane 
again.

4 Click OK.

To calculate scale factors: (continued)

Step Action
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Defining Categories 
and Labeling 6
Chapter Overview

Introduction You can label the fragment peaks that appear in plot displays with 
information such as fragment size, quantity, scan numbers, or 
customized text. Peak labels appear in the lower pane of the Main 
window. You can label peaks with more than one kind of label.

In This Chapter This chapter contains the following topics:

Topic See Page

Approaches to Labeling 6-2

Defining Categories for Labeling 6-4

Using Exclusive Peak Labeling–An Example 6-10

Creating Category Groups—an Example 6-13

Making Category Members 6-17

Sorting and Editing Categories 6-22

Offsetting Categories 6-24

Automatic Peak Labeling 6-26

Filtering Labels 6-29

Manually Putting Labels On Peaks 6-33

Customizing Text in Labels 6-35

Customizing the Color of Labels 6-38

Removing Labels 6-42

Labeling Normalized Peaks—an Example 6-45

Making Categories from Labels 6-49

6
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Approaches to Labeling

Example of a
Labeled Fragment

Peak

Figure 6-1 shows an example of a dye/lane fragment peak labeled with 
the size of the fragment in base pairs. Fragment size is one kind of label 
you can assign to peak data.

Why Label
Fragment Peaks

By labeling fragment peaks, you can: 

� Visualize size and quantity information for analyzed sample 
fragments.

� Discover which samples contain fragments in related categories.

� Identify relationships between sample fragments.

� Make decisions about how to configure comparison and analysis 
tables.

� Make decisions about which samples to export to tables in 
GenBase.

Peak label (size)

Peak 

Figure 6-1 Example of a fragment peak labeled with the size in base pairs
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Ways to Label
Fragments

Genotyper provides you with two ways to label fragment peaks: 
automatically and manually.

Automatic Label
Filtering

Genotyper’s automated labeling process screens out peaks resulting 
from PCR-related artifact fragments detected during electrophoresis. 
You define the stringency of this filtering process by setting filter 
parameters that will remove labels from artifact peaks.

For more information on filtering labels, see “Filtering Labels” on 
page 6-29.

The two ways you can label fragment peaks and where you can find 
detailed instructions for each labeling method. 

Labeling 
Method Description See Page

Automatic Simultaneously labels all peaks within 
selected dye/lanes with specified criteria.

6-26

Manual Places defined labels on individual peaks in 
plot displays when you click a peak.

Note When two or more 
electropherogram plots are superimposed, 
click-labeling is disabled.

6-33
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Defining Categories for Labeling

Definition Categories define which peaks in selected dye/lanes Genotyper will 
label, and how those peaks will be labeled. You can also use defined 
categories to specify the contents of tables.

Genotyper uses category information to label appropriate peaks as 
described in “Automatic Peak Labeling” on page 6-26.

The Categories
Window

The Categories window shows a list of all defined categories for select 
dye/lanes in the current Dye/lane list, as well as an abbreviated version 
of the Add Category dialog box.
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Adding Categories You can add categories that will define how peaks will be labeled when 
you automatically label peaks of interest.

To add categories: 

Step Action

1 Choose Add Category...from the Category menu.

The Add Category dialog box appears.

Figure 6-2 Add Category dialog box

2 Enter the range limits in base pairs for fragments that you want to 
label.

Range

Peak information

Peak

Group
Category

Display

Colors

Category

If you want to... Then...

Automatically fill in 
range limits

Select a rectangular area in the plot 
area, and choose the Add Category 
command. 

Specify starting and 
ending coordinates in 
the range

Use the pop-up menu to select to. Type 
in the starting and ending sizes in the 
range. For example, 120 to 140.

Specify a center 
coordinate and range

Use the pop-up menu to select ±. Enter 
a tolerance For example 120 ± 1.5.
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3 Click a radio button to specify which peaks to label within this 
category:

4 Click the dye color checkboxes for the colors you want labeled.

5 Optionally, define height requirements for peaks you want to label: 

Note If the dye/lane scale factor is 1.0, then the scaled height of a 
peak is the same as the peak height. If a different scale factor has 
been calculated for a dye/lane then the scaled height of a peak is 
equal to the peak height divided by the Dye/lane’s scale factor.

6 Enter a name for the Category. For example, Alpha.

7 Optionally, choose a display color for the Category. The entry in the 
Category list for this Category will appear in this color. Labels for 
the Category can optionally be displayed in this color.

8 Optionally, enter a descriptive comment about the Category. The 
comment will appear in the Category window after the name.

9 Click OK.

The name of the category appears in the Category list.

To add categories: (continued)

Step Action

If you want to label... Then click...

All peaks All peaks.

The highest peak Highest Peak.

The highest “n” peaks 
(where “n” is an integer)

Highest “n” Peaks, and type an 
integer for “n”.

Left most peak in a range Left Peak.

Right most peak in a range Right Peak.

If you want to define... Then click...

A minimum height for 
labeled peaks

With (scaled) height of at least, and 
type a number for the minimum peak 
height.

A maximum height for 
labeled peaks

With (scaled) height of at most, and 
type a number for the maximum peak 
height.
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Exclusive Peak
Labeling

The Exclusive checkbox in the Add Category dialog box is a priority 
labeling feature. When you select the Exclusive checkbox, any existing 
labels on a peak, besides those defined by the “Exclusive” category, are 
removed.

For more details on using exclusive peak labeling see, “Using Exclusive 
Peak Labeling–An Example” on page 6-10.

Adding Multiple
Categories

You can create multiple categories at once by using the Add Multiple 
categories command. This can be useful if you are performing 
applications such as microsatellite repeats where you want to label a 
large number of peaks that differ by multiples of 2 base pairs.

There are three stages to this process:

� Defining categories

� Choosing optional parameters

� Naming the categories

To define categories: 

Step Action

1 Choose Add Multiple Categories...from the Category menu. 

The Add Multiple Categories dialog box appears.
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2 In the Starting size field, enter the starting size for fragments that 
you want to include in the first category.

3 In the Category width ± field, enter the range of fragment sizes that 
you want to be included in the category. 

For example, 100 ±.50 labels fragments that are between 99.5 to 
100.5 base pairs in length as a single category.

4 In the Category spacing field, enter the number of base pairs 
between each category.

For example, if you enter 2, then the second category will begin for 
all fragments that are between 101.5 and 102.5 base pairs.

5 In the Number of Categories field, enter the number of categories 
that you want to create.

6 Select the dye color check boxes for the dye colors that you want 
included in the categories.

To choose optional parameters: 

Step Action

1 Select the Group Name checkbox and type a name to include all 
categories under a single group name.

2 Select the checkbox for “with (scaled) height of at least”, and enter 
a number if you want to limit the categories to only those peaks that 
generate a signal intensity of at least a particular height.

3 Select the checkbox for “with (scaled) height of at most”, and enter 
a number if you want to limit the categories to only those peaks that 
generate signal intensity of at most a particular height.

4 Select the checkbox for Exclusive, if you want to clear any existing 
labels on peaks.

To name the category: 

Step Action

1 In the Prefix field, type a 1 to 15 character alpha numeric prefix for 
the category names.

To define categories: (continued)

Step Action
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Example of
Category Naming

How Genotyper names categories based on parameters you enter:

2 In the First number field, enter the number to follow the prefix for the 
first category name.

3 In the Number increment, enter the number by which you want to 
increment each successive category number.

4 Click OK.

To name the category: (continued)

Step Action

If you define... Then categories are named...

Prefix: AB

First number: 10

Number increment: 3

AB10, AB13, AB16,...
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Using Exclusive Peak Labeling–An Example

Introduction The Exclusive option is a priority labeling feature. When the Exclusive 
check box is marked in the Add Category window, all other labels at 
peaks in the “Exclusive” category are cleared and the peak(s) is labeled 
with the desired information.

In general, category ranges should not overlap, but the Exclusive option 
allows you to use overlapping categories in special cases.

Example
Application

In this example, the peaks of a marker occur between 106 and 122 bp. 
Two particular alleles, named A1 and A2, are known to occur around 
116 bp and 118 bp. If either of these alleles are present, we would like 
them to be labeled by name, but if any others are present, we would like 
them to labeled with the text, “Unknown.” 

In the first part of the example, we will see what happens when the 
Exclusive option is not used. In the second part of the example, we will 
see how the Exclusive option allows us to obtain the desired results.

Labeling without
the Exclusive

Option

In the first part of this example, we will see what happens when we label 
peaks in the example application without using the Exclusive option.

To label peaks without the Exclusive option: 

Step Action

1 Assume categories have been created so that the Category list 
looks like the list below (note there are no exclusive peak labels).

2 Assume peaks have been labeled with the category name 
checkbox selected and all others de-selected.
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Result of
Specifying

Overlapping
Category Ranges

Note that the peaks at 116 bp and 118 bp each have two labels. This is 
one of the undesirable consequences of specifying overlapping 
category ranges. 

3 View the Plot window, which should now look like the plot below.

To label peaks without the Exclusive option: (continued)

Step Action
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How to Use
Exclusive Labeling

For this example, you can use the “A1” or “A2” labels exclusively for 
these peaks, by using the Exclusive option.

To label peaks using the Exclusive option: 

Step Action

1 Assume that you have defined Categories like those shown below. 

2 Label peaks.

3 View the resulting plot (shown below); known peaks are labeled 
correctly A1 and A2, others are labeled “Unknown”.

Filter Stutter Peaks

1 Choose Filter Labels… from the Analysis menu.

2 Click OK, to use the default filtering parameters. The plot area now 
shows the two known alleles, and a third, spurious peak labeled 
“Unknown.”
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Creating Category Groups—an Example

Introduction Category groups may be useful when you want to identify individual 
alleles within the range of a marker category.

IMPORTANT If Category groups in the same dye color overlap, some 
commands may not perform as expected

In this example, you will make two sets of categories and specify the 
groups they are associated with. You will also collapse one of those sets 
of categories into a single entry in the Category list.

Note These categories are only for illustration and have no biological 
relevance.

Create a Category
Group

Category groups organize groups of similarly defined categories under 
a single name.

To create two sets of categories and specifying the groups with which 
they are associated: 

Step Action

1 Choose Add Category...from the Category menu. 

The Add Category dialog box appears (see figure in step 1 of 
“Adding Categories” on page 6-5).

2 Name the first Category “A1.” 

3 Click Member of group checkbox and enter “Alpha”.

4 Click the All Peaks radio button.

5 Enter 138 and 140 for the “Size” range limits. 

6 Click the blue checkbox and de-select the checkboxes for the other 
colors.

7 Click OK.
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8 Repeat steps 2-7 using the following values:

� A2; Alpha; All peaks, 140-142; blue

� A3; Alpha; All peaks, 146-148; blue

� B1; Beta; All peaks, 121-123; blue

� B2; Beta; All peaks, 123-125; blue

� B3; Beta; All peaks, 129-131; blue

You have created two groups: Alpha and Beta, with three 
Categories in each group.

9 Choose Show Categories Window from the Views menu.

The Categories window shows the two marked Category groups 
you created.

To create two sets of categories and specifying the groups with which 
they are associated: (continued)

Step Action
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Unmark a Group
of Categories

Using Category groups allows you to conveniently mark or unmark all 
entries in that group at the same time, rather than marking or 
unmarking each one individually.

For more information on marking and unmarking Categories, see 
“Marking or Unmarking Categories” on page 6-26.

To unmark the alpha category group:

Step Action

1 Select “Alpha” in the Categories window.

2 Choose Unmark (z-U) from the Edit menu. 

All three Categories in the Alpha group are now unmarked.

Note If all Categories in a group are marked, the group will have 
a bullet next to its name. If some Categories in a group are marked, 
and some unmarked, the group name will have a dash (-) next to its 
name.
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Collapse a Group
of Categories

Collapsing a group of categories can make viewing of the Category list 
easier, by reducing the members of a group to a single entry in the 
Categories list.

To collapse the beta category to a single entry in the categories list:

Step Action

1 Select the category named Beta in the Categories window.

2 Choose Collapse Categories (z-]) from the Views menu. 

The Beta group of categories is collapsed into a single line.
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Making Category Members

Introduction You can make members of categories that represent a distribution of 
peak height ranges within a particular category. This allows you to 
categorize marker data based on a distribution of fragment quantities 
for applications such as AFLP. 

For complete details for running AFLP applications look for information 
soon to be available on the Applied Biosystems web site.

Example of
Category
Members

Figure 6-3 shows an example of the distribution of peak heights or 
fragment quantities for five category members (B,C,H,D,A). For 
example, the peak shown here belongs to category member “B”.

Figure 6-3 Example of peak height distribution for category members
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How to Make
Category
Members

In order to use this command you have to have already created a 
table.The table must have columns defined for categories and peak 
height.

Note The following steps refer to an AFLP example soon to be available on 
the Applied Biosystems web site. 

To make category members: 

Step Action

1 Choose Show Table window from the Views menu.

This displays a table with rows of peak height and category data 
such as that shown in this figure.

2 Choose Make Category Members...from the Category menu

The Make Category Members dialog box appears.

3 Choose the category column from the Look in table column for 
group names pop-up menu. 

This defines chosen categories as groups.

4 Choose the peak height column from the Look in table column for 
scaled heights pop-up menu. 
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5 For each marked category group, Genotyper calculates the 
distribution of peak heights (for the group) by looking at the 
appropriate rows in the table. Type in the percentile of this 
distribution that you want to use for the “reference height.” For 
example, if you want the largest height to be the reference height, 
type in “100” for the percentile.

6 Select from one to five checkboxes for the number of members you 
want to add to each marked category, and type in a name, and a 
range that is a percentage of the defined reference height.

7 Click OK.

For each box that you checked, Genotyper adds a member, that 
has a height range that is a certain percentage of the referenced 
height that you calculated.

8 Choose Show Categories Window from the Views menu.

The Categories window appears and displays new members for 
each category with varying scaled height ranges as shown in this 
figure.

To make category members: (continued)

Step Action
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Searching for Categories

Introduction You can define search criteria for categories and locate a particular 
category or categories in the list of defined categories.

How to Specify
Search Criteria

To specify a search criteria:

Step Action

1 Choose Find...(z-F) in the Edit menu.

The Find dialog box appears.

2 Click the Find the following text radio button.

3 Type in the text you want to locate.

4 Click the Look in the category list radio button. 

5 Select the checkboxes for where you want Genotyper to search for 
the text string that you have typed.

6 Select the checkboxes for how you want Genotyper to search for the 
text string that you have typed (Table 6-1 on page 6-21). 

7 Click OK.
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How to Search for
Categories

Once you have defined search criteria, choose how you want to search 
for dye/lanes in the list. The following table shows you how you can 
search for categories.

Table 6-1 Ways to search for categories:

If you are... Then...

Searching for all occurrences at 
once

Click the Find all occurrences at once 
checkbox.

All categories with the designated text 
are selected. 

Adding categories to the current 
selection

Click the Add to current selection 
checkbox. 

Categories already selected remain 
selected. Categories located by this 
command are also selected.

Searching for the next occurrence 
of a selection

Choose Find Next (z-G) from the 
Edit menu.

The Find Next command repeats the 
last Find command, using the same 
options that were used in the last Find 
command.

Searching for text strings without 
regard to case

Click Ignore upper/lower case 
differences.

The Find Next command locates all 
occurrences of the text string you 
have entered, ignoring the case of any 
letters you have entered.

Restricting the search to 
categories defined for particular 
dye colors only

Click the checkboxes for the particular 
dye colors you want to search.



6-22 Defining Categories and Labeling

Sorting and Editing Categories

Introduction Once you create a number of different categories, you can easily sort 
the category list, edit existing categories, and create new categories 
from existing ones.

Sorting the
Categories List

You can change the sort order of the Category list.

To sort the category list:

Step Action

1 Choose Category Sorting...from the Views menu. 

The Category Sorting dialog box appears.

2 Choose the precedence of sorting the items (name, size/scan, 
minimum height, comment, or dye color) by clicking and holding 
down the pop-up menus.

3 Choose the sort order of these items in ascending or descending 
order by clicking the appropriate radio buttons.

The “Everything” category always appears first in the Category list.

Exclusive categories are sorted after non-exclusive categories, 
within their groups.
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How to Edit
Category

Parameters

Once you have added a category, you can edit the parameters for that 
category at any time.

To edit category parameters:

Step Action

1 Select a category in the Category list.

2 Choose Edit Category...from the Category menu.

The Edit Category dialog box appears. This dialog is identical to the 
Add Category dialog box, except for the title (see figure in step 1 of 
“Adding Categories” on page 6-5).

3 Modify parameter settings.

Note You cannot edit a member of a group to be a member of 
another group. A group contains categories, each of which applies 
to the same set of dye colors.

4 Click Replace.

The parameters you changed will replace the previous settings for 
this category.
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Offsetting Categories

Introduction You can use either the Offset Category, or the Calculate an Offset... 
command to temporarily shift the size range of a category. 

How to Offset
Categories

To use the Offset Category command:

When to Calculate
an Offset

The Calculate Offset command automates the Offset Category 
command. Use the Calculate Offset command if you have run the same 
samples in the same lanes of two or more different gels or capillaries. 
Calculating an offset can help eliminate run-to-run variability of 
fragment size values in categories.

The Calculate Offset command is particularly useful for genotyping 
applications that make use of allelic ladders.

Step Action

1 Select one or more categories from the Category list in the Main 
window.

2 Choose Offset Categories from the Category menu.

The Offset Categories dialog box appears.

3 Enter a number, positive or negative, for how many base pairs you 
want to offset the current size range defined for a given category. 

4 Click OK.

For the selected category in the Category list, the number you 
entered appears in parentheses next the size range. For example, if 
you entered –0.2, (–0.2) appears next to the size range, and the 
start and end point of the size range is decreased by –0.2 base 
pairs.
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How to Calculate
an Offset

To use the Calculate Offset command:

Step Action

1 For GeneScan data from each gel, establish a standard set of 
category values for peak data.

2 Import all GeneScan data that you are using in your application.

3 Select one or more categories from the Category list in the Main 
window.

4 Choose Calculate Offset... from the Category menu.

The Calculate Offset... dialog box appears.

5 Enter the number for the size in base pairs of your reference peak. 

6 From the pop-up menu, select the category from which you want to 
calculate the offset. 

7 Click OK.
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Automatic Peak Labeling

Introduction Automatic peak labeling allows you to label peaks in selected dye/lanes 
using criteria defined in marked categories, and the Label Peaks dialog 
box.

Note Repeated use of the Label Peaks...command will produce duplicate 
labels of the same type at a peak. Use the Clear All labels command to remove 
all previously added labels.

Peak Label Limit No more than 500 peaks should be labeled in any one dye/lane. If more 
than 500 peaks are labeled, then some commands (such as Filter 
Labels) may not be available.

Marking or
Unmarking
Categories

When you add a category to the Category list, it is marked. Marked 
categories are used for automatic labeling of peaks. Unmarked 
categories are ignored.

To mark or unmark Categories:

Step Action

1 Select one or more Categories from the Category list.

2 Choose Mark (z-M) or Unmark (z-U) from the Edit menu, or 
double-click a single category to toggle between a marked and 
unmarked state.

A bullet appears to the left of categories, indicating the categories 
are marked.
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How to Label
Peaks

Automatically

To automatically label peaks:

Step Action

1 Mark categories that define how you want peaks labeled.

2 Select the dye/lane or dye/lanes that contain the peaks you want to 
automatically label.

3 Choose Label Peaks...from the Analysis menu.

4 Click the appropriate checkboxes for what you want to appear on 
labels:

5 Click OK.

6 To view the peak labels, click the Plot window icon, and show the 
Plot data window.

If you want to label Peaks with... Then click...

Fragment size in base pairs

Note Size can be rounded to nearest 
integer.

the size in bp.

Height in units defined by GeneScan

Note Height can divided by Dye/lane 
scale factor.

the peak height.

Area in units defined by GeneScan

Note Area can be divided by Dye/lane 
scale factor.

the peak area.

Number of scans required to detect the 
peak

the scan number.

A pre-defined text description the text, and type in 
a peak label.

A text box that you can annotate after 
putting a blank label on a peak

Note For click labeling only.

the requested text.

Either Manual or Auto depending how the 
peak was labeled

label/peak source.

A score for each peak that indicates how 
well the peak image resolves with respect 
to the background

the peak 
modulation score.
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When to Round
Integers

When setting parameters for how you want to automatically label peaks, 
select the round integers checkbox only if you are labeling large sized 
fragments where the numbers to the right of the decimal point can be 
ignored.

IMPORTANT Do not round size labels to the nearest integer if you are 
performing a microsatellite application. You will not obtain satisfactory results. 

Changing Existing
Labels

The Change Labels command enables you to change labels within 
marked categories on currently selected dye/lanes. If you are running a 
genotyping application that uses genetic marker allele designations, 
you can change existing labels, by renaming allele labels from size in 
base pairs to a category or allele name.

To change existing labels:

Step Action

1 Choose Change Labels...from the Analysis menu.

The Change labels dialog box appears.

2 Click the checkboxes for what you want to now appear on peaks 
with existing labels.

3 Click OK.
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Filtering Labels

Definition Genotyper may label some peaks that, for various reasons, you may not 
want to be labeled. You can use Genotyper’s filtering feature to remove 
these unwanted labels.

How to Filter
Labels

Note When viewing by scan, only the first option in the Filter labels dialog box 
is available. The other options are intended to be used only when viewing by 
size.

To filter labels:

Step Action

1 Choose Filter Labels...from the Analysis menu. 

The Filter Labels dialog box appears.

Generally, the default settings in the Filter Labels dialog box 
remove most of the “stutter” bands and noise from 
electropherograms. These filtering parameters are designed for 
dinucleotide microsatellite data repeats.

Note The filtering operations listed in the dialog box are 
performed one at a time, in the order they are listed. You can isolate 
the effect of each filtering operation by performing only one 
operation at a time.

2 You can change settings to remove labels from peaks that do not 
represent significant fragment data (see figure in step 1).



6-30 Defining Categories and Labeling

Kinds of Peaks You
Can Filter

Figure 6-4 shows the kinds of peaks for which you can filter labels and 
remove them from plot displays.

Figure 6-4 Kinds of peaks you can filter

How to Remove
Spurious Peak

Labels

Spurious peaks are often large thin peaks that appear on the far left of 
plot displays. They can result from primers, excessive salt in samples, 
or from pooling samples during PCR preparation.

Description of each of the numbered peaks in Figure 6-4:

Peak Number Description

1 Spurious peaks at known locations.

2 Small peaks.

3 Small peaks on the shoulders of stutter peaks 
(“+A” peaks).

4 Stutter peaks.

1 3

3

4

2

To remove spurious peak labels at known locations:

Step Action

1 In the Filter Labels dialog box, click the first checkbox and enter the 
size range of the spurious peaks that occur in selected 
electropherograms plots.

2 De-select the other checkboxes.

3 Click OK.
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How to Remove
Labels from Small

Peaks

Small peaks close to the baseline are referred to as background noise, 
and can result from spectral overlap or other GeneScan matrix file 
problems. 

How to Remove
Labels from Small

Peaks on Peaks

One of the most common errors in automated genotyping results from 
the tendency of Taq DNA Polymerase to add an additional (non-
templated) nucleotide, usually an A, to the end of the extending strand. 
This results in the production of PCR fragments one nucleotide longer 
than the true allele product which display as small peaks on allele 
peaks in Genotyper. These “+A” peaks can display on either the left or 
right side of the true allele peak, usually 1 nucleotide in length.

IMPORTANT When the peak height of the “true” allele product and that of the 
+A allele are similar, Genotyper may recognize the +A bands as the true allele, 
resulting in a genotyping error of about 3-5%. 

In addition to using the Filter Labels command, you can define 
categories so that only the left or right peak in a pair of peaks is labeled, 
and the peak that results from the +A artifact remains unlabeled.

 To remove small peaks:

Step Action

1 In the Filter Labels dialog box, click the second checkbox and type 
in a percentage of the height of the highest peak, for which peaks 
that are less than this percentage will be removed.

2 De-select the other check boxes.

3 Click OK.

 To remove small peaks on the shoulders of allele peaks:

Step Action

1 In the Filter Labels dialog box, click the third checkbox from the top, 
and enter the peak range, for peaks you want removed.

2 De-select the other check boxes.

3 Click OK.
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How to Remove
Stutter Peaks

Stutter peaks can occur when genotyping microsatellite samples, and 
can be caused by slippage of the polymerase enzyme during PCR.

To remove stutter peaks:

Step Action

1 In the Filter Labels dialog box, click the fourth checkbox and enter 
the peak range of peaks to include in the filtering process.

2 Click the Higher by at least checkbox, and type the percentage 
height that a preceding peak must be to removed.

3 De-select the other checkboxes.

4 Click OK.
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Manually Putting Labels On Peaks

Introduction You can label individual peaks in plot displays by locating the peak or 
peaks of interest, and then clicking on the peak. When you click on the 
peak a second time, the label is removed.

You can label peaks with more than one label, for example, size and 
height. Peak labels appear in the lower pane of the Main window.

How to Manually
Label Fragment

Peaks

To label fragment peaks manually, define what you want to appear in 
the label and then click on the peaks that you want to label.

To manually label peaks: 

Step Action

1 Choose Set Click Options... from the Analysis menu.

The Set Click Options dialog box appears.
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2 Click the appropriate check boxes for what you want to appear on 
labels:

3 Click OK.

4 Select a dye/lane that contains peaks you want to label.

5 Move the cursor in the electropherogram part of the Plot area until 
the vertical line jumps to the peak that you want to label.

6 Click the peak with the mouse button.

A label for that peak appears in the lower pane of the plot area.

To manually label peaks: (continued)

Step Action

If you want to label Peaks with... Then click...

Fragment size in base pairs the size in bp.

Height in units defined by GeneScan the peak height.

Height divided by scale factor divided by scale 
factor.

Area in units defined by GeneScan the peak area.

Area divided by scale factor divided by scale 
factor.

Number of scans required to detect the 
peak

the scan number.

A Pre-defined text description the text, and type in 
a peak label.

A text box that you can annotate with 
different text each time you click a peak

the requested text.

Either Manual or Auto depending how 
the peak was labeled

label/peak source.

A score for each peak that indicates how 
well separated the peak is from 
background.

the peak modulation 
score.
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Customizing Text in Labels

Introduction Once you have assigned labels to peaks, you can customize the text in 
the labels.

Note Text and color customizations you make to labels apply only to the 
labels in the active (frontmost window) Genotyper Document. However, each 
document can have its own independent customization.

How to Show
Labels that Have

Been Manually
Removed

You can show labels that have been manually removed to provide an 
audit trail of adjustments to labels that have been automatically 
assigned to peaks.

For more information on removing labels from peaks, see “Removing 
Labels” on page 6-42.

For more information on automatically labeling peaks, see “Automatic 
Peak Labeling” on page 6-26.

To display labels that have been manually removed: 

Step Action

1 Choose Plot Options in the Views menu, then choose the Label 
Options...submenu.

The Label Options dialog box appears.

Figure 6-5 Label Options dialog box

Box 1
Box 2

Box 3
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How to Add Data
Type Prefixes

If you want to identify the data type of a peak label, you can add a prefix 
to labels that identify the type of the label. Data Types and associated 
default prefixes include:

� Category (ct)

� Size (sz)

� Height (ht)

� Text (tx)

� Scan (sc)

� Area (ar)

2 Labels that have been manually removed are shown with slashes 
in plot displays.

To display labels that have been manually removed: (continued)

Step Action

To add data type prefixes to labels: 

Step Action

1 Click Box 2 in Label Options dialog box (see Figure 6-5 on 
page 6-35).

2 Enter the prefixes you want or use the default prefixes.

3 Click OK.

The labels are assigned prefixes for data type. This figure shows an 
example of labels with size prefixes (sz).
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How to Add a
Prefix to Manually

Changed Labels

You can add a prefix to labels to mark labels that were either added or 
removed manually.

To add a prefix to labels that were added or removed manually:

Step Action

1 Click Box 3 in the Label Options dialog box (see Figure 6-5 on 
page 6-35).

2 Enter the prefixes you want or use the default prefixes.

3 Click OK.

The prefix “AM” appears on the labels that were added manually; 
the prefix “RM” appears on the labels that were removed manually.
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Customizing the Color of Labels

Introduction To distinguish between different types of labels you can customize the 
color of the labels.

How to Draw
Labels in Black

and White

If you are planning to print results data, or display labels on a black and 
white monitor, you may want to draw labels in black and white. 

How to Use the
Same Colors for
Labels and Dyes

You can make peak labels the same color as their associated peaks. 
For example, blue electropherograms will have all blue labels and green 
electropherograms will have all green labels.

To draw labels in black and white:

Step Action

1 Select Plot Options in the Views menu and choose Label Options....

The Label Options dialog box appears (see Figure 6-5 on 
page 6-35).

2 Select the Draw labels in black and white radio button in the Label 
Options dialog box.

3 Click OK.

To color labels the same as associated peaks:

Step Action

1 Select Plot Options in the Views menu and choose Label Options....

The Label Options dialog box appears (see Figure 6-5 on 
page 6-35).

2 Select the Use same colors for labels and dyes radio button.

3 Click OK.
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How to Use the
Same Colors for

Labels and
Category Names

The Add Category dialog box (Figure 6-2 on page 6-5) allows you to 
associate a color with a category for display purposes. The name of the 
category in the Category list will appear in this color. This option allows 
you to display labels that have the same color as a particular category.

To color labels the same as associated categories:

Step Action

1 Select Plot Options in the Views menu and choose Label Options....

The Label Options dialog box appears (see Figure 6-5 on 
page 6-35).

2 Select the Use same colors for labels and category names button.

3 Click OK.
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How to Choose
Color Labels by

Data Type

You can color labels according to the type of data that the label 
describes. Data types include:

� Category

� Peak Size

� Peak Height

� Label Text

� Scan number

� Peak Area

To color labels according to data type:

Step Action

1 Select Plot Options in the Views menu and choose Label Options....

The Label Options dialog box appears (see Figure 6-5 on 
page 6-35).

2 Select the Color labels by data type radio button.

3 Click OK.

4 Click and hold down the pull-down menu for color selection by data 
type.

5 Select a color.

6 Repeat step 5 for each data type label you want to color.

The data types appear in the selected colors in the Plot window.
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How to Select a
Custom Color for

a Data Type Label

To select a custom color for a data type: 

Step Action

1 Select Plot Options in the Views menu and choose Label Options....

The Label Options dialog box appears (see Figure 6-5 on 
page 6-35).

2 Select Color labels by data type radio button.

3 Click OK.

4 Click and hold down the pull-down menu for color selection by data 
type.

5 Select the last color in the list (the one with the ellipsis (...)).

Note Selecting a custom color may temporarily change the 
highlight color used by the Finder. 

The Pick a color dialog box appears.

6 Place the cursor on the color wheel and click on the color of your 
choice.

7 Click OK.

8 Repeat steps 5-7 for each data type color you want to change.
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Removing Labels

Introduction During a genotyping session, you will often want to remove fragment 
labels from peaks.

Ways to Remove
Labels

You can remove all labels from peaks, select specific kinds of labels and 
remove those labels automatically, or remove individual labels by 
locating them in plot displays and clicking on the labels you want 
removed.

Removing All
Labels

If you want to remove all peak labels in all dye/lanes (whether selected 
or not), choose Clear All Labels from the Analysis menu.

How to Remove
Specific Labels

You can specify the range of peaks for which labels will be removed.

To remove labels within a specified size range: 

Step Action

1 Select the dye/lanes from which you wish to remove labels.

2 Choose Remove Labels...from the Analysis menu.

The Remove Labels dialog box appears.

3 Type in the range in base pairs, then click Insert (z-I).

The size range appears in the list of ranges.

Note You can also specify the size range by choosing “±” from 
the pop-up menu, for example, 105 ± 10.

4 Repeat Step 2 for each range you want to include.

List of ranges
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How to Correct
Errors in the Size

Range

To correct size range errors in the Remove Labels dialog box (see step 
2 of “How to Remove Specific Labels” on page 6-42):

Removing a Range
From the Range

List

To remove a range from the range list in the Remove Labels dialog box 
(see step 2 on page 6-42):

Removing
Common Labels

Removing common labels is useful for genotyping applications such as 
AFLP where you have many labeled peaks of which you are only 
interested in labels that represent a polymorphism.

5 Click OK.

Labels in the specified ranges in all currently selected dye/lanes 
are cleared.

To remove labels within a specified size range: (continued)

Step Action

Step Action

1 Select the range from the range list.

2 Type in the new range.

3 Click Replace Range (z-R).

4 Click OK.

Step Action

1 Select the range from the range list.

2 Click Delete (z-D).

3 Click OK.

To remove common labels: 

Step Action

1 Select two or more dye/lanes.

Note If only one dye/lane is selected, all labels for that dye/lane 
will be cleared.
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2 Choose Clear Common Labels...from the Analysis menu.

The Clear common labels dialog box appears.

3 Enter the tolerance in base pairs.

Two peaks are considered to be at the same location if their peaks 
are within the specified tolerance.

4 If you do not want to clear labels when the peaks in different 
dye/lanes have a significant height difference, select the checkbox.

5 Click OK.

Labels are cleared at those peaks that are labeled in all of the 
currently-selected dye/lanes. For example, if a peak at a particular 
location is labeled in five out of six lanes, none of the labels will be 
cleared; only if labels are present for six out of six lanes will they all 
be cleared.

To remove common labels: (continued)

Step Action
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Labeling Normalized Peaks—an Example

Introduction In quantitative applications, where relative peak height is important, you 
can normalize peak heights relative to the height of a control peak.

This example shows you how to perform the three procedures required 
for labeling normalized peaks:

� Defining a control peak

� Normalizing peaks to the control peak

� Labeling normalized peaks

Define a Control
Peak

The first procedure in labeling normalized peaks is to define a control 
peak.

To define a control peak: 

Step Action

1 Select a dye/lane.

2 In the Plot pane, select a range that includes the control peak.

3 Choose Add Category...() from the Analysis menu.

The Add Category window appears.

4 Click the Highest peak radio button.

5 Name the Category Control Peak.
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Normalize Peaks
to the Control

Peak

Once you define a control peak, normalize the heights of other peaks to 
the height of your control peak, which serves as a reference.

6 Click OK.

To define a control peak: (continued)

Step Action

To normalize peaks to the control peak: 

Step Action

1 In the plot pane, select a range that contains a peak to be 
normalized.

2 Choose Add Category....

3 Name the peak “Peak 1”.

4 Click the Highest Peak radio button.

5 Click OK.

6 Repeat this procedure for another peak to be normalized.

The Category list should now look like this figure.
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Label Normalized
Peaks

Once you have defined a control peak and the other peaks to be 
normalized, you can label them.

To label peaks: 

Step Action

1 Choose Label Peaks...from the Analysis menu.

The Label Peaks dialog box appears.

2 Click the peak height and/or peak area check box.

3 Click OK.

4 Choose Normalize Labels... from the Analysis menu.

The Normalize Labels dialog box appears.
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5 From the upper set of pop-up menus, choose the Categories to be 
normalized, for example, Control peak, Peak1, and Peak2.

6 From the middle pop-up menu, choose the name of the Category 
you defined as a control, for example Control Peak.

7 Click the “in the same lane” radio button.

8 Click OK.

The plot pane of the Main window now displays peaks with 
normalized labels.

To label peaks: (continued)

Step Action
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Making Categories from Labels

Introduction For genotyping applications that require making categories from one 
distinct set of peaks, you can make categories from defined labels. For 
certain kinds of applications, this process of defining Categories will be 
easier than defining them as described in “Defining Categories for 
Labeling” on page 6-4.

When to Make
Categories from

Labels

Genotyping applications for which making categories from labels may 
be useful include:

� AFLP applications

� Allelic ladders

For most microsatellite genotyping applications, you will not want to 
make categories from labels. Usually you want to define categories 
while looking at the distribution of several allele peaks, not just one. 

For more information on defining categories while viewing allele 
distributions, see “Editing Categories in Histograms” on page 9-22.

How to Make
Categories from

Labels

For select dye/lanes, you can make a separate category for each 
labeled peak according to what you have specified for each peak label.

To make categories from labels: 

Step Action

1 Import GeneScan data, for either allelic ladders or AFLP studies.

2 Select dye/lanes for which you want to make categories from 
labeled peak data.

3 Label peaks for which you want to create categories.
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4 Choose Make from Labels... from the Category menu.

The Make from Labels... dialog box appears.

5 Type in the Category tolerance.

6 Select checkboxes for either including, or skipping overlapping 
categories.

7 Name categories that will be created.

For information on how Genotyper names categories see “Example 
of Category Naming” on page 6-9.

To make categories from labels: (continued)

Step Action
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8 Optionally, select “with” and make created categories a group, or 
members of a group:

9 The remaining category definition checkboxes have the same 
meaning as those described for the “Add Category dialog box” on 
page 6-5.

10 When you are satisfied with all your choices for defining categories, 
click OK.

Genotyper makes a category for each peak that has a label.

To make categories from labels: (continued)

Step Action

If you want to make each 
category... Then click... And...

A group to which you can 
add member categories

member type in the 
name of the 
first member 
of the group.

A member of a group group name type in the 
name of the 
group.
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Working with Plot 
Data 7
Chapter Overview

Introduction Genotyper Documents display dye/lane data as electropherogram 
plots. This chapter explains how to make use of the many options 
Genotyper offers for viewing, interpreting, and customizing plot displays 
within a Genotyper Document.

In This Chapter This chapter contains the following topics:

Topic See Page

Viewing Plots of Imported Dye/Lanes 7-2

Viewing and Interpreting Peak Data 7-7

Zooming In and Out 7-11

Customizing Plot Areas 7-14

Viewing Table Data in Plots 7-22

Comparing Plot Data to Reference Plots 7-24

7
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Viewing Plots of Imported Dye/Lanes

Introduction Genotyper generates plot data from imported dye/lanes in the form of 
electropherograms (see Figure 7-1).

Figure 7-1 Example of an electropherogram

Electropherograms are peak representations of the size and quantity 
data from dye-labeled nucleic acid fragments that have been 
electrophoresed on an ABI PRISM instrument and analyzed in 
GeneScan.
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The Plot Window The Plot window provides an expanded full screen view of the plot area, 
allowing you to view each selected dye/lane as an individual 
electropherogram.

Note In the Main window, labels are shown only if one dye/lane is selected. If 
more than one dye/lane is selected, choose Show Plot Window to view all the 
labels.

1

2

3

Figure 7-2 The Plot window
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Parts of the Plot
Window

Parts of the Plot window:

How to View Plots
of a Single

Dye/lane

You can view electropherogram plots of any imported dye/lane that 
appears in the Dye/lane list.

Item Name Description

1 Peak Description Area Displays information about scan line 
number, size, height, area, and 
category for peaks the cursor is on.

2 Upper Pane A reference area where you can 
display one or more “reference” 
plots. 

3 Lower Pane Plot area where you can display one 
or more plots. You can scroll this 
area and visually compare these 
plots to those in the Upper Pane.

To view plot data of imported dye/lanes: 

Step Action

1 In the Dye/lane list, locate the dye/lane for which you want to 
display plot data.

2 Select the dye/lane in the Dye/Lane list.

An electropherogram plot showing peaks for each analyzed nucleic 
acid fragment in the sample appears in the Plot Area.

The vertical scale on the right is relative peak height. The default 
horizontal scale at the top is fragment length.

3 Click the Plot window icon to display an expanded view of the 
electropherogram in the Plot window (Figure 7-2 on page 7-3).
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How to View Plots
of Multiple

Dye/lanes

You can view an electropherogram plot showing all detected peaks for 
multiple dye/lanes.

Note If you have selected many dye/lanes to be shown, a light gray 
background, instead of the electropherogram plots, will appear briefly in the plot 
area. This means Genotyper is processing the electropherograms in the 
background and will draw them when they are ready. You may continue to run 
other Genotyper commands or change the dye/lane selections during this time.

To show plot data for multiple dye/lanes. 

Step Action

1 In the Dye/lane list, locate the dye/lane or dye/lanes for which you 
want to display plot data.

2 Select the dye/lanes in the Dye/lane list.

An electropherogram plot appears showing overlapping peaks for 
each selected dye/lane in the Plot Area. The highest peak fills the 
available area. The vertical scale disappears because each 
dye/lane plot is scaled independently to occupy the full height 
available.
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The Order of Plot
Displays

For plots derived directly from the dye/lane list, the order that the plots 
are displayed is determined by the dye/lane list order preferences 
(determined by the Dye/lane Sorting command).

For plots derived from table rows, the order of plots is determined by the 
table row order.

Low Memory
Warning

If a dark gray background appears in the plot area, Genotyper is 
running low on memory. Save your work as soon as possible, quit from 
Genotyper, then allocate more memory to Genotyper.

For more information on allocating memory to Genotyper, see “Setting 
Memory Allocation” on page 1-11.

3 To view each selected dye/lane as an individual electropherogram 
plot, click the Plot window icon.

The Plot window opens, displaying individual electropherograms for 
each selected dye/lane. This figure shows a plot window for multiple 
dye/lanes.

To show plot data for multiple dye/lanes. (continued)

Step Action

Plot 
Window 
icon
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Viewing and Interpreting Peak Data

Introduction Peak data in electropherograms can show you size and quantity data 
for imported GeneScan files. Following are some key terms for 
interpreting peak data.

Definitions of terms:

How to View
GeneScan Peak

Data

You can view the following data for peaks resulting from GeneScan 
analysis of electrophoresed sample fragments:

� Scan number

� Peak size

� Peak height

� Peak area

� Genotyper Category

Term Definition

Peak Height A representation of the quantity of sample for a given 
fragment. The height of a peak is determined by the 
intensity of signal at the highest point that fluoresces 
for each dye-labeled fragment.

Scan Number For automated gel data collection software, the laser 
samples data each time it scans across the gel. Each 
sampling is stored as a data point. The scan number 
describes the location of the data point.

Base Pairs A unit of fragment size. The number of base pairs 
indicates the estimated length of a nucleic acid 
fragment, relative to the size standard.

To view peak data for imported GeneScan files: 

Step Action

1 Select dye/lanes of interest, and view plot data.
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How to View
Relative Peak Size

and Quantity

The horizontal and vertical scales for plot data can inform you of the 
approximate size and quantity of fragment peaks.

2 Use the mouse to move the cross hairs along the plot.

The vertical line “jumps” from peak to peak. Information about each 
peak appears above the horizontal scale.

To view peak data for imported GeneScan files: (continued)

Step Action

Vertical line

Peak information

To view approximate size and quantity values for peak data:

If you want to know... Then read...

The relative quantity of a dye/lane 
fragment

The vertical scale. It displays 
fragment quantity in terms of peak 
height.

The relative length of a dye/lane 
fragment in base pairs

The Default horizontal scale at the 
top is fragment length in base pairs. 

Relative time required for a 
dye/lane fragment to be detected

The Default horizontal scale at the 
top is fragment length in base pairs. 
You can change this scale to Scan 
number.

Vertical scale
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How to Change the
Size and Quantity

Scale

You can change the scale Genotyper uses for the horizontal axis. 

How to Compare
Peak Heights

For qualitative comparisons of fragment quantities in select dye/lanes, 
you can compare peak heights in a plot view.

 To change the peak sizing scale: 

Step Action

1 Select dye/lanes of interest, and view plot data.

2 From the Views menu, choose how you want to display size and 
quantity information for peak data.

Note If you did not use GeneScan to call fragment sizes, or if no 
sized peaks were found in a dye/lane, then you will not be able to 
view the electropherogram when you choose DIsplay by Size. The 
text No Size Data will appear in the Plot area. To view the 
electropherogram choose Display by Scan.

If you choose... Then the horizontal scale displays...

Display by Size Base pairs.

Display by Scan Number of scans required to detect sample 
fragment data.

To compare peak heights of select dye/lanes: 

Step Action

1 Select dye/lanes of interest, and view plot data.

2 Use the mouse to move the “cross hairs” to the vertical scale area.

A horizontal line appears across the length of the plot. You can use 
this line as a “straight edge” to compare relative peak heights.

“Straight edge” “Cross hairs”
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How to Adjust
Peak Heights

You can adjust the signal height of peaks by choosing a scaling factor 
for each of the four dye colors. Dye scaling affects only the appearance 
of the electropherogram plots. All other data, such as the values 
appearing in the cursor information line above the plot, remain 
unchanged.

To adjust the height of dye-colored peaks: 

Step Action

1 Select dye/lanes of interest, and view plot data.

2 Choose Plot Options from the Views menu.

3 Drag the arrow pointer to the submenu, and choose Dye Scaling...

The Dye Scaling dialog box appears.

Signal heights for each color are multiplied by the indicated factor 
before being plotted. The vertical scale reflects the adjusted 
heights.

4 Choose the peak colors that you want to scale, and type in a 
number for the percent by which you want to scale the peak height.

Example

If you want all the blue peaks to display at half of their current 
height, type in .50.

5 Click OK.
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Zooming In and Out

Introduction Zooming in and out of a plot view, allows you to view particular peaks 
closer up by zooming in, or see a wider range of peaks by zooming out.

How to Zoom in on
the Plot Area

For a closer view of particular peaks, or a group of peaks, you can zoom 
in on the Plot Area.

How to Zoom in on
a Selected Range

For a closer view of a group of peaks, you can zoom in on a particular 
region, or range of the Plot Area.

To zoom in on the entire Plot Area: 

Step Action

1 Select dye/lanes of interest, and view plot data.

2 Choose Zoom In from the Zoom submenu in the Views menu.

You can now view the middle 50% of the plot.

To zoom in on a selected range of the Plot Area: 

Step Action

1 Select dye/lanes of interest, and view the Plot Area.

2 Drag the cross hairs across the region you want to zoom in on.

The vertical bar becomes a dotted rectangle that indicates the 
lower and upper limits of the area you selected.

Lower limit Upper limit
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How to Zoom Out For a view of a wider range of peaks in the Plot Area, you can zoom out.

How to Zoom Out
to Full Range

To view all of the peaks in select dye/lanes you can zoom out to full 
range.

3 Choose Zoom In (Selected Range) in the Views menu.

The range you selected is magnified to fill the Plot Area.

Note Only the left and right boundaries of the selection rectangle 
apply to the Zoom In (Selected range) command. The top and 
bottom boundaries are not used.

To zoom in on a selected range of the Plot Area: (continued)

Step Action

To partially zoom out for a broader view of the plot:

Step Action

1 Select dye/lanes of interest, and view plot data.

2 Choose Zoom Out (z- –) from the Zoom submenu in the Views 
menu.

You can now view about 50% more of the plot.

To zoom out: 

Step Action

1 Select dye/lanes of interest, and view plot data.
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How to Zoom to a
Specific Range

You can specify a range of peaks that you want to view in the Plot Area. 
The table below shows you how to zoom to ranges that you specify.

2 Choose Zoom Out (Full Range) (z-H) from the Zoom submenu in 
the Views menu.

You can now view the entire plot. The dotted rectangle in the plot 
area indicates the range limits that existed before you zoomed out 
to full range.

To zoom out: (continued)

Step Action

Range limits before zooming out

If you want to zoom to... Then...

A specific size range of fragments a. Choose Zoom to...from the 
Zoom submenu.

b. The Set Plot dialog box appears.

c. Enter the plot range 
(from size__to size__).

d. Click OK.

The range of one or more 
Categories

a. Select one or more categories in 
the Categories list.

b. Choose Zoom to Category in the 
Zoom submenu.

c. You can now view the range that 
includes the range of the 
selected categories.

The range of the next marked, 
unselected Category

a. Choose Zoom to Next Category 
in the Zoom submenu.

b. The next marked Category in the 
plot is selected automatically.
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Customizing Plot Areas

Introduction By default, the upper graphical pane in the Main window is the 
electropherogram view area; the lower graphical pane is reserved for 
peak labels. However, you can customize the settings to make these 
areas serve different purposes. Likewise, you can customize the upper 
and lower panes of the Plot window.

Note You can set the Plot Options for the Plot window only when the Plot 
window is displayed.

The Main Window
Plot Area

The upper pane and lower pane of the Main window plot area.

Upper pane

Lower pane

Figure 7-3 Location of upper and lower panes in the Main window
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The Plot Window
Panes

The upper pane and lower pane of the Plot window.

Upper pane

Lower pane

Figure 7-4 Location of upper and lower panes in the Plot window
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How to Customize
Plot Displays

You can customize the plot display in the upper and lower panes of 
either the Main window (Figure 7-3) or the Plot window (Figure 7-4).

To customize plot displays: 

Step Action

1 Choose the kind of plot display that you want to customize.

If you want to 
customize... Then...

The Main window

Upper pane Select Upper Pane, Main window from the 
Plot Options sub-menu of the Views menu.

Lower pane Select Lower Pane, Main window from the 
Plot Options sub-menu of the Views menu.

The Plot window

Upper pane Select Upper Pane, Plot window from the Plot 
Options sub-menu of the Views menu.

Lower pane Select Lower Pane, Plot window from the Plot 
Options sub-menu of the Views menu.
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2 Select the checkboxes for the kind of plot that you want to view.

To customize plot displays: (continued)

Step Action

If you click... Then the plot displays...

Analyzed signal Peaks that have been baselined and analyzed 
by GeneScan.

Raw signal Peaks from fragments that have not been 
baselined or analyzed by GeneScan.

Grayscale 
signal bands

A display that looks like autoradiography 
signals, but is derived from the 
electropherogram.

Labels Size and quantity labels on peaks.

Use colors for 
different dyes

Electropherograms in color; if unchecked, 
electropherograms will be drawn in black.

Use fixed 
y-scale

Draws all plots to a specified vertical scale.

Category 
boundaries

Boundaries around peaks in a category.

Note Not recommended for Main window 
displays or overlapped displays.
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Adding More
Detail to the Plots

You can add more details to your plot displays. 

To add more detail to customized plot displays: 

Step Action

1 From the Plot Options dialog box, click More Choices.

This displays a dialog box that offers you more choices of what you 
can display for the plot area you have chosen to customize.
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2 Choose the radio buttons for the kind of plot you want to view.

To add more detail to customized plot displays: (continued)

Step Action

If you click... Then the plot area displays...

Marked or unmarked 
dye/lanes

Electropherogram plots for all selected 
dye/lanes. This is the default.

Marked dye/lanes 
only

Only plots for dye/lanes that are both 
selected, and marked.

Unmarked dye/lanes Only plots for dye/lanes that are both 
selected, but not marked.

Dye/lanes for Table 
rows

Plots for all rows in the associated table.

Selected table rows Plots for table rows you select.

Overlapped 
dye/lanes

Plots for each selected dye/lane on top 
of each other in the pane.

Separate dye/lanes Plots for each selected dye/lane 
separate from one another.

Overlapped dyes, 
separate lanes

All dye colors in a lane superimposed on 
each other, but each lane appears 
separately from the others.
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3 Select the checkboxes for kind of data to include in each plot

To add more detail to customized plot displays: (continued)

Step Action

If you click... Then the plot area displays...

Sample Info text Text for associated Sample Info field.

Analyzed Signal Plots of peaks that have been 
baselined and analyzed by GeneScan.

Raw Signal Fluorescent signal before GeneScan 
analysis.

Horizontal scale A horizontal scale.

Vertical scale A vertical scale.

Peaks (without signal) a vertical line for each peak.

Grayscale signal 
bands

Bands similar to a Autoradiograph.

Labels Any labels put on peaks.

Show horizontal 
cursor

A horizontal cursor.

Show vertical cursor A vertical cursor.

Use common vertical 
scale

All plots are drawn to the same vertical 
scale. When this box is unchecked (the 
default), each plot fills the amount of 
vertical space available.

Use fixed 
y-scale

All plots drawn to the specified vertical 
space.

Note When selected, then Use 
common vertical scale is disabled.

Use colors for 
different dyes

All dye colors in a lane superimposed 
on each other, but each lane appears 
separately from the others.
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4 In the Plot height pop-up menu, you can adjust the height of plots 
that display in the Plot Area. 

5 Click OK to accept your selections. 

To add more detail to customized plot displays: (continued)

Step Action

If you choose... Then the Plot Area...

small Fits more plots in the window.

default Shows a medium-sized plot.

large Shows more detail in the plot.
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Viewing Table Data in Plots

Introduction You can view information from tables in plot displays.

For more information about working with Tables, see “Parts of the Plot 
Window” on page 7-4.

Plot Data
Associated with

Dye/lanes

Genotyper generates all plots from data in dye/lanes. Do not delete 
dye/lanes that contain data shown in your table or you will not be able to 
view plots of rows that contain that data. 

How to Show Table
Data in Plots

When you display plot data for select dye/lanes, you can include 
information from related tables in the plot display.

To show table row text in plot displays: 

Step Action

1 Open the Genotyper Document that contains the table information 
you want to display in the Plot window.

2 Open the Plot window from the Main window.

3 Open the Table window.

4 Select the rows in the table for which you want to display 
corresponding plots.

Note A row is considered selected if any cell in the table is 
selected.

5 Choose the Plot Options from the Views menu.

6 Select the Plot window, lower pane plot option.

The Plot window, lower pane dialog box appears.

7 Click the More Choices button. The More Choices dialog box 
appears. See figure in step 1 of “Adding More Detail to the Plots” 
on page 7-18.

8 Choose one of the radio buttons after “Dye/lanes for”:

9 Select the Text from table row checkbox if you want to display the 
row text in the corresponding plot display.

If you choose... Then the Plot window displays...

Table rows Plots for all rows in the table.

Selected table rows Plots for table rows you select.
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Automatic
Scrolling

When you select a row in a table, the plot automatically scrolls to the 
corresponding peak data in the plot display.

10 Click OK.

The Plot Window displays plots and associated information for 
selected table rows.

To show table row text in plot displays: (continued)

Step Action
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Comparing Plot Data to Reference Plots

Introduction You can designate selected dye/lanes as reference plots, and display 
one or more of these reference plots in the upper pane of the Plot 
window (Figure 7-2 on page 7-3). 

Once you have set up a reference plot, you can display plots for one or 
more dye/lanes in the lower pane of the Plot window and compare their 
plots to the reference plots in the upper pane.

Setting Up
Reference Plots

You can compare plot information from the reference pane to scrollable 
plot data in a lower pane.

To set up reference plots: 

Step Action

1 In the Dye/lane list, locate the dye/lane or dye/lanes for which you 
want to display reference plots.

2 Choose the Mark Command from the Edit menu, or double-click the 
dye/lanes, marking them with a bullet.

The bullet signifies that plots for those dye/lanes are reference 
plots.

3 Select the dye/lanes you marked as reference plots, and any 
dye/lanes that you want to compare to the reference plots.

4 Click the Plot window icon to display an expanded view of the Plot 
window (Figure 7-2 on page 7-3).

The upper pane of the Plot window displays reference plots, and 
the lower pane displays plots for the dye/lanes that you want to 
compare to the reference plots. You can scroll plot data in the lower 
pane.

Note The upper pane does not scroll, so you will probably only 
want one or two dye/lanes displayed in this pane.
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Working with Tables 8
Chapter Overview

Introduction Putting your results data into a table allows you to organize it in a 
manner meaningful to your genotyping application. You can use tabular 
data for comparison analysis, as well as export results to a database.

In This Chapter This chapter contains the following topics:

Topic See Page

Setting Up a Table 8-2

Arranging Columns of Labeled Peak Data 8-7

Specifying Columns for Number of Labels in a Row 8-9

Specifying Warning Columns for Edited Tables 8-11

Specifying Modulation Warning Columns 8-13

Specifying Low-signal Warning Columns 8-15

Specifying Saturation Warning Columns 8-17

Calculating Results from Table Data 8-19

Analyzing Data in Tables 8-23

Using Analyze and Calculate in Table Commands–An 
LOH Example

8-28

Editing Table Cells and Column Headings 8-28

Sorting the Rows in a Table 8-30

Searching for Table Entries 8-33

Updating Tables 8-35

Deriving a Second Table from an Existing Table 8-36

Checking for Mendelian Inheritance 8-37

Formatting Tables for Export 8-45

Exporting Tables 8-46

8
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Setting Up a Table

Sources of Table
Data

Table contents are generated from labeled fragment peaks within select 
dye/lanes. Before setting up a table make sure that the appropriate 
dye/lane peaks are labeled with the kind of information that you want to 
present in your table. 

For more information on how to label fragment peaks in dye/lanes, see 
Chapter 6, “Defining Categories and Labeling”.

Choosing a Table
to Create

The following table shows examples of tables you can create for 
different genotyping applications. 

Column Number
Limit

There is a limit of 128 columns in a table.

For this genotyping 
application... You can create this kind of table...

Linkage Mapping

Gene Expression 
Profiling

Loss of 
Heterozygosity
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How to Determine
Row Contents

Genotyper generates row contents from dye/lanes in the Dye/lane list 
and categories in the Category list.

To determine row contents in your table: 

Step Action

1 Mark those Categories in the Category list that define the kind of 
peak data that you want to include in the table.

2 From the table menu, choose Set Up Table...

The Set up Table dialog box appears.

Figure 8-1 The Set up Table dialog box

3 In the Contents per row field, click one of the two radio buttons.

If you want each row to correspond to... Then Click...

 Marked categories and selected dye/lanes Category & 
dye/lane.

Sample Information entered in the Sample 
Info field for a dye/lane entry

Sample.



8-4 Working with Tables

How to Determine
Column Contents

You can select the column contents for the rows in your table from a list 
of checkboxes in The Set Up Table dialog box (“The Set up Table dialog 
box” on page 8-3). The order in which you select the checkboxes 
determines the order in which the column contents will appear from left 
to right in your table.

To determine column contents for each table row: 

Step Action

1 From the Table menu, choose Set Up Table....

The Set Up Table dialog box appears (Figure 8-1 on page 8-3). 

As shown at the bottom of the dialog box, the checkboxes selected 
beneath the “Include Data in Columns” heading are the current 
settings for column headings.

2 Click OK to accept the current selections for the column contents, 
or click the Uncheck All button to clear all the selections.

Checkboxes that you can select for column headings depend on 
the kind of contents per row you defined. The text of unavailable 
checkboxes appears in gray.

Note To change the column heading text, see “Editing Table Cells 
and Column Headings” on page 8-28.
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3 Select checkboxes under the Include Data in Columns heading:

To determine column contents for each table row: (continued)

Step Action

If you want to define a column for... Then click...

Name of an imported GeneScan file Name of GeneScan file.

The lane number of a dye/ lane Lane number.

The color of the dye for the dye/lane in 
a row

Dye letter.

The lane number and dye color of the 
dye/lane containing peak data

Lane and dye.

Contents of Sample Info field Sample info.

Contents of Sample comment field in 
Sample Sheet, and Dye/lane window

Sample comment.

The name of a selected category Name of category.

Labeled Peak data Labels.

The number of labels on peaks in the 
category, dye/lane, or sample

Number of labels.

GeneScan size-calling method Size-calling method.

GeneScan size standard Size standard file name.

Scale factors, if defined Dye/lane scale factor.

The name of associated Gel files Gel file name.

Text, when more than a specified 
number of labels are detected in a 
category, dye/lane, or sample

Text if > N labels.

Text, when less than a specified 
number of labels are detected in a 
category, dye/lane, or sample

Text if < N labels.

Your own comments User comment.

Data for, and results of inheritance 
check

Marker name & 
Individual ID.

A warning when labels are edited Edited-label warning.

A warning when cell contents edited Edited-table warning.

A warning for low dye/lane signal Low-signal warning.

A warning for intensity of signal Saturation warning.

Lowest modulation score value Minimum modulation.

A warning for low modulation scores Modulation warning.
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How to Append
Rows to a Table

Once you have created a table, you can append rows to the table.

Re-importing
Dye/lanes

If you have made a table and deleted or cleared all dye/lanes, select a 
table cell, then choose Re-import Dye/lane from the File menu.

4 Click OK when you have defined all the columns that you want to 
include in your table.

To determine column contents for each table row: (continued)

Step Action

To append rows to a table:

Step Action

1 If it is not already open, open the Genotyper Document that 
contains the table to which you want to append rows.

2 Select those dye/lanes that have sample information that you want 
to add to the table.

IMPORTANT Genotyper puts all information from dye/lanes into 
the existing format of rows in the current table. All rows in a table 
must have the same number of columns and the same column 
headings. 

3 From the Table menu, choose Append to Table.

A row containing sample information from select dye/lanes is added 
to the bottom of the table.
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Arranging Columns of Labeled Peak Data

Introduction For each row in a table, you can order columns of labeled peak data 
according to the kind and number of labels defined by selected 
categories.

How to Arrange
the Order of Peak

Label Columns

To specify the order of peak columns that contain peak data labels: 

Step Action

Select Source of Peak Labels

1 Make sure that you mark the categories that define the kind of 
labeling you want to include in the table.

2 From the Table menu, choose Set Up Table....

The Set Up Table dialog box appears (“The Set up Table dialog box” 
on page 8-3). 

Arrange Columns of Peak Labels

1 Select the Labels checkbox.

2 Click the Options button. 

The Label Options dialog box appears.
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3 Select the radio button for how you want to arrange the order of 
columns containing peak label data:

4 Modify columns based on kinds of peak labels in select categories:

5 Click OK to accept all of your selections.

To specify the order of peak columns that contain peak data 

Step Action

If you want to put columns of... Then click...

Labeled data from the same peaks next to 
each other (for example: size, height, size 
height)

labels from same 
peak are next to 
each other.

The same type of labeled peak data next 
to each other (for example: size, size, 
height, height)

labels of same type 
are next to each 
other.

If you want to... Then Select..

Duplicate labels, when only one is found 
in a category

Note When working with homozygote 
STRs, you assume that any single peak is 
a result of a homozygotic state.

If only one labeled 
peak in category, 
and duplicate the 
label(s).

Display a text message when no labeled 
peaks are found in a category

If category has no 
labeled peaks, click 
Put this text in all 
cells, type a text 
message.

Display a pre-defined category comment 
in all label cells of a row when no labeled 
peaks are found in a category

Select If category 
has no labeled 
peaks, click Put 
Category comment 
in all cells.

Display a text message when no labeled 
peaks are found in cells defined as 
columns for peak label data

If some label cells 
are empty, put this 
text in empty cells, 
type in a text. 
message.
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Specifying Columns for Number of Labels in a Row

Introduction You can specify that columns with specified text appear when the 
number of labels for a particular row is greater than or less than a 
specified number.

How to Specify
Columns for Label

Detection

In the Set Up Table dialog box, you can specify that columns with 
customized text are appended to all rows where more or less labels are 
detected than the number that you specify.

To specify columns for labels in a row: 

Step Action

1 In the Dye/lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the Categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table...

The Set Up Table dialog box appears (“The Set up Table dialog box” 
on page 8-3). 

4 Choose what kind of column and text you want to display for the 
number of labels detected for a specific set of peak labeled data:

5 Click the Options button. 

The Label detection dialog box appears.

6 For N, type in the number of labels for which you want to display a 
message if more or less than that number are detected in a 
specified row.

If you want to display text when the 
number of labels is... Then click...

More than a specific number Text if > N labels.

Less than a specific number Text if < N labels.
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7 Type in the warning text that you want to appear in the column 
appended to the end of affected rows.

8 Click OK to accept all of your selections.

To specify columns for labels in a row: (continued)

Step Action
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Specifying Warning Columns for Edited Tables

Introduction You can select checkboxes in the Set Up Table dialog box (Figure 8-1 
on page 8-3) that specify that columns with specified text will appear to 
warn you when any row in a table, or any peak label in a row has been 
edited.

How to Specify
Warnings for

Edited Labels

When setting up a table, you can specify that Genotyper append a 
column containing warning text when a peak label has been manually 
edited in a category and dye/lane before the table was made.

To specify warnings for edited labels:

Step Action

1 In the Dye/lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the Categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table....

The Set Up Table dialog box appears (“The Set up Table dialog box” 
on page 8-3). 

4 Select the Edited-label warning checkbox.

5 Click the Options button. 

The Edited-label warning dialog box appears.

6 Type in the warning text that you want to appear in the column.

7 Click OK to accept all selections.
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How to Specify
Warnings for
Edited Tables

When setting up a table, you can specify that Genotyper append a 
column containing warning text to the end of any row that contains cells 
that have been edited after initial creation of the table.

To specify warnings for rows containing edited table cells:

Step Action

1 In the Dye/Lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table...

The Set Up Table dialog box appears (“The Set up Table dialog box” 
on page 8-3). 

4 Select the Edited-table warning checkbox.

5 Click the Options button. The Edited-table dialog box appears.

6 Type in the warning text that you want to appear in the column.

7 Click OK.
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Specifying Modulation Warning Columns

Introduction When setting up a table, you can specify that Genotyper append a 
column containing warning text in any row that contains peaks that have 
a modulation score lower than what you specify to be adequate for your 
application.

What is
Modulation

Modulation refers to the degree to which peak data resolves with 
respect to its immediate background. 

Modulation Scores Modulation scores measure the quality of peak resolution. The following 
figure shows an example of peaks labeled with modulation scores. Note 
the correlation between modulation scores and the degree of 
separation of individual peaks from neighboring valleys. Higher scores 
show a greater degree of separation from the background.

Figure 8-2 Peak modulation scores
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How to Specify a
Modulation

Warning

To specify warnings when peaks do not meet specified modulation 
scores:

Step Action

1 In the Dye/Lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table...

The Set Up Table dialog box appears (Figure 8-1 on page 8-3). 

4 Select the Modulation warning checkbox.

5 Click the Options button. 

A dialog box appears.

6 Type in the modulation score for the minimum acceptable degree of 
peak modulation for your Genotyper application.

7 Type in the warning text that you want to appear in the column, if 
peaks are found that are less than the modulation score you have 
specified.

8 Click OK to accept all your selections.
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Specifying Low-signal Warning Columns

Introduction When setting up a table, you can specify that Genotyper append a 
column containing warning text to the end of any row that contains 
peaks that have a fluorescent signal lower than what you specify to be 
adequate for your application.

What Causes a
Low-Signal

A weak fluorescent signal is often caused by problems during sample 
preparation; in particular problems with PCR, or errors during loading of 
samples on your ABI PRISM instrument.

Low Signal
Example

Figure 8-3 shows an example of a Genotyper plot display showing the 
vertical axis maximum set at 150 for peak heights. The peaks in the 
display are labeled with peak heights. If you create a table using the 
default value for low signal warning of less than 200, Genotyper will 
append a column containing warning text to the end of the row 
containing these peak labels.

Figure 8-3 Low signals in Genotyper
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How to Specify a
Low-signal

Warning Column

To specify warnings when peaks data has been generated from a signal 
defined as low:

Step Action

1 In the Dye/Lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table...

The Set Up Table dialog box appears (Figure 8-1 on page 8-3). 

4 Select the Low-signal warning checkbox.

5 Click the Options button. A dialog box appears.

6 Type in the minimum amount of signal data acceptable before 
issuing a low signal warning for the associated labeled peak data.

7 Type in the warning text that you want to appear in the column, if 
peak data has been generated from fluorescent signals less than 
the amount you specified in the previous step.

8 Click OK to accept all of your selections.
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Specifying Saturation Warning Columns

Introduction When setting up a table, you can specify that Genotyper append a 
column containing warning text to the end of any row that contains 
peaks that have a fluorescent signal higher than what you specify to be 
adequate for your application; a saturation warning.

What Causes
Saturation

When you import raw data from GeneScan files, you may also import 
saturated signals. Saturated signals result when the fluorescent signal 
from an excess of PCR product exceeds the detection limit of your ABI 
PRISM instrument. Consequently, if left undetected, Genotyper will count 
resulting artifact peaks, such as primer peaks, as actual sample peaks. 
By identifying peaks caused by saturated signals, you can prevent 
erroneous peak identification.

Saturation
Example

Figure 8-4 shows an example of imported dye/lanes displaying peaks 
with saturated signals.

Figure 8-4 Saturated signals in Genotyper
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How to Specify a
Saturation

Warning Column

How to specify warnings when peaks data has been generated from a 
saturated signal:

Step Action

1 In the Dye/Lane list, select the dye/lanes whose labels you want to 
put into a table.

2 Make sure that you mark the categories that define the kind of 
labeling you want to include in the table.

3 From the Table menu, choose Set Up Table...

The Set Up Table dialog box appears (Figure 8-1 on page 8-3). 

4 Select the Saturation warning checkbox.

5 Click the Options button. 

The Saturated signal dialog box appears.

6 Type in the maximum amount of raw signal data acceptable before 
issuing a saturated signal warning for the associated labeled peak 
data.

7 Type in the warning text that you want to appear in the column, if 
peak data has been generated from fluorescent signals greater 
than the amount you specified in the previous step.

8 Click OK to accept all of your selections.
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Calculating Results from Table Data

Introduction You can use the Calculate in Table... command to perform numerical 
calculations of table cell contents. You can review results of calculations 
in a results column you define when setting up the table.

For an example of how the Calculate in Table command is used for a 
genotyping application, see “Using Analyze and Calculate in Table 
Commands–An LOH Example” on page 8-26.

Setting Up Results
Columns

Genotyper puts results of table data calculations in a column you 
specify. The column for the results must already exist. So, if you plan to 
calculate results from table data, create some extra columns for your 
results when setting up columns.

For more information on setting up table columns, see “Setting Up a 
Table” on page 8-2.

Reading the Text
Box

The key to using the Calculate in Table... command is to read the text 
box at the bottom of the dialog box as you enter parameters. The text 
box explains the calculation and what the result will be. It is easier to 
read the text box then it is to review settings in the dialog box.
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Kinds of
Calculations

Table 8-1 shows the kinds of calculations you can perform after 
specifying values in The Calculate in Table...dialog box. “Fields you can 
use” refers to those fields shown in the table in “How to Calculate 
Results From Table Data” on page 8-21.

Table 8-1Kinds of Calculations you can perform on table data

Kind of Calculation Description Fields you can use

Sum of Sum of values defined. 
Useful for many quantitative 
applications

A,B,C,D

Difference (A - B) A minus B. Useful for 
applications such as HMA 
where the difference in 
mobility for a given 
fragment determines the 
degree of similarity or 
difference.

A, B

Absolute difference 
 |A -B|

Absolute value of A minus 
B

A,B

Ratio (A/B) A divided by B. Useful for 
Loss of heterozygosity 
applications.

A,B

Average of Average of values chosen A,B,C,D

Product of Product of values chosen. A,B,C,D

Member for category 
(A) and size/scan (B)

Treat the text in column A 
as the name of a category 
group; look through the 
members of that group and 
see which one involves size 
or scan value in column B. 
The result is the name of 
the category member.

A, B 
(must be column 

value only).

Difference squared 
 (A -B) * (A - B) of

Square of the difference 
between value of A and 
value of B.

A, B

Square root (A) of Square root of the value of 
A.

A
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How to Calculate
Results From

Table Data

Use the Calculate in Table... command to calculate results from table 
data.

To calculate results from table data: 

Step Action

1 Open the Table window from the Main window.

2 Choose Calculate in Table...from the Table menu.

The Calculate in Table dialog box appears.

3 Choose the radio button for the rows that you want to include in 
your calculation.

Note If you choose “for every row”, Genotyper counts row 1 as 
the title row, and row 2 is the first row in the table that contains data. 
However, Groups do not count the title row, and row 1 is the first 
row that contains data.
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4 From the first pop-up menu, choose the kind of calculation that you 
want to perform. 

5 In fields A-D, choose the table data on which you want to perform 
the calculation. Type in constants, or choose the column number 
from the pop-up menus.

For example, if your table has data for peaks in columns 5 and 6, 
and you want to calculate the sums of the those two peaks, choose 
column 5 in field A, and column 6 in field B.

6 In the field “and put the result in column”, choose the column and 
optionally the row or group, where you want to put the calculated 
result.

7 Review the text box at the bottom of the dialog box which explains 
the calculation you’ve specified. If this is what you intend to do, click 
OK.

8 Check the Table window to verify that results have been calculated 
in the table.

For example, if you specified that results from the calculation 
described in step 5 be placed in column 7 of your table, the 
resulting table will look like.

To calculate results from table data: (continued)

Step Action
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Analyzing Data in Tables

Introduction Genotyper provides some of the functionality found in spreadsheet 
applications such as Excel. For example, you can select rows in tables, 
and perform comparison analysis of cell contents. You can review 
results of analysis algorithms in a results column you define when 
setting up the table.

Reading the Text
Box

The key to using the Analyze Table...command is to read the text box at 
the bottom of the dialog box as you enter conditional parameters in the 
Analyze Table dialog box (Figure  on page 8-24). The Text Box provides 
a verbal explanation of the calculation and its results. It is often easier to 
read the text box then to review settings in the dialog box.

Example Text Box

For every row, examine columns 3-5; if exactly 2 of these cells in the 
row are not empty, and if the values in at least 2 cells are greater than 1, 
then put “Normal” in column 2.

Error Message in
Text Box

If the word ERROR appears in the text box, there is a logical 
inconsistency in the conditional parameters that have been entered. For 
example, if you specify that Genotyper analyze the cell contents of two 
columns in a row, but also specify that three of these cells not be empty, 
Genotyper will issue an error message in the text box.

Examples of
Applications

Examples of applications for which you can use the Analyze Table 
command include:

� Trisomy

� DMD Analysis

� Loss of Heterozygosity

� Gene Quantitation
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How to Analyze
Data in Tables

Use the Analyze Table command to specify conditions for logical 
comparisons of table cell contents. If the analysis conditions you specify 
are met, Genotyper writes a message you specify into a results column. 

To analyze data in tables: 

Step Action

1 Choose Analyze Table from the Table menu.

The Analyze Table dialog box appears.

2 Choose the radio button for the rows that you want to include in 
your analysis.

Note Groups do not count the title row, and row 1 of the group is 
the first row that contains data.

3 In the Examine column(s) pop-up menus, choose the range of 
columns that you want to include in your analysis. 

4 In the When pop-up menu, choose the comparison conditions for 
the columns you are analyzing.

Note “at least zero”, means for every cell.

5 Optionally select the “and” checkboxes if you want to add conditions 
to your analysis. Choose relational operators from the pop-up 
menus, and type in peak size criteria.
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Clearing Columns You can clear entire columns by specifying that if at least zero cells are 
not empty then clear the column. At least zero, means for every cell.

Example Text Box

For every cell examine column 5. Whether or not the cell is empty, put 
(blank) in column 4. 

In other words, clear column 4. 

6 In the “then” field, type in the message text that you either want to 
“put” or “append” in a select column if the conditions you have 
specified are met.

7 Review the text box at the bottom of the dialog box which explains 
the conditions you’ve specified. If this is what you intend to do, click 
OK.

8 Check the Table Window to verify that the results of your analysis 
have been added to your table.

To analyze data in tables: (continued)

Step Action
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Using Analyze and Calculate in Table Commands–An LOH Example

What is LOH? Loss of Heterozygosity (LOH) is the loss of polymorphic DNA markers 
in tumors compared with normal cells, and often indicates somatic 
deletion of tumor suppressor genes. LOH detection has application to a 
wide range of cancers involving tumor suppressor genes.

Genotyper
Commands Used

to Detect LOH

You can use the Calculate in Table and Analyze Table commands to 
assess the presence or absence of LOH for labeled DNA fragment data 
from patient samples. 

Example LOH
Table

Figure 8-5 shows a table that was created using the Calculate in Table 
Command. Allele peaks were identified, labeled, filtered, and a table 
was created with columns for allele size and height.

Figure 8-5 Example of table created to assess LOH presence

Using the
Calculate in Table

Command

To create the table shown in Figure 8-5, we used the Calculate in Table 
Command to calculate:

� A ratio of allele 1 to allele 2 for each sample.

� The ratio of the tumor signal to that of the normal signal (T1/T2 over 
N1/N2). This value is called the Allelic Imbalance or AI.
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Using the Analyze
in Table Command

To create the table shown in Figure 8-5, we used the Analyze Table 
Command to calculate the ratios in Ht Ratio T/N column for presence or 
absence of LOH. For example, if the ratio is less than 0.67 or more than 
1.35, then LOH is entered into a column named Assessment, otherwise 
Normal is entered in the same column.
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Editing Table Cells and Column Headings

Introduction Once you have created a table, you can edit the contents of some of the 
cells in each row, or change the names of any of the column headings. 
However, all rows in a table must have the same column headings.

IMPORTANT Changes you make to the contents of table cells affect only the 
table you are editing. For example, if you edit the peak label information in a 
table cell, the corresponding information in other parts of the Genotyper 
Document such as dye/lanes or plot displays remains unaffected.

Marking Rows as
Edited

When setting up a table, you can select a checkbox in the Set Up Table 
dialog box (Figure 8-1 on page 8-3), that enables Genotyper to notify 
you of any row in a table that has been edited. After any cell in a row is 
edited, Genotyper enters a text string that you specify in a column at the 
end of the row.

For more information on setting up table features such as this, see 
“Specifying Warning Columns for Edited Tables” on page 8-11.

Kinds of Cell Data
You Can Edit

There are the three kinds of data you can manually edit in table cells.

They are:

� Column headings

� Peak label information

� User comments
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How to Edit Table
Cells

To edit cells in a table:

Recording Steps
For Editing Table

Cells

If you are making a macro, the Step list records edits of individual cells 
as “selected cells”. If you run the macro, the macro will change 
whatever you have selected to include the text you enter.

How To Edit
Column Headings

To edit column headings in tables:

Recording Steps
For Editing

Column Headings

If you are making a macro, the Step list records edits of column heading 
cells as applying to a specific column number of the first row.

Step Action

1 Open the Genotyper Document that contains the table that you 
want to edit.

2 Optionally, open the Table window from the Main window.

3 Select the table cell that you want to edit.

4 Choose Edit Cell from the Edit menu.

5  Type in your changes. 

When you save the Genotyper Document, the changes will be 
saved in the table.

Step Action

1 Open the Genotyper Document that contains the table that you 
want to edit.

2 Optionally, open the Table window from the Main window.

3 Select the table cell that you want to edit.

4 Choose Edit Cell from the Edit menu.

5 Type in your changes.

When you save the Genotyper Document, the changes will be 
saved in the table.
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Sorting the Rows in a Table

Introduction Rows in tables are initially not sorted; they appear in the order in which 
they were added to a table. However, you can sort the rows on 
command.

The Concept of
Precedence

The concept of precedence is important when sorting rows in a table. 
The precedence for a column number establishes a priority when 
sorting rows. 

Example

If you choose the Category column as a precedence 1, and Sample Info 
as a precedence 2, and the sort type is alphabetical, rows will first be 
sorted in alphabetical order according to category name, and then, 
within categories, sort them in alphabetical order according to entries in 
the Sample Info column.
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How to Sort Rows
To sort rows in multiple columns of a table: 

Step Action

1 To view the Table window more easily, choose Show Table Window 
from the Views menu.

The Table window appears.

2 Choose Sort Table...from the Analysis menu.

The Sort Table dialog box appears.

3 Under Column number, you can choose from 1 to 3 different 
columns to sort, by choosing the appropriate pop-up menu.
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4 Under Sort Type, choose the radio button for how you want each 
column to be sorted, in Alphabetical, or Numerical order. 

5 Under Sort Order, choose either ascending or descending order.

To sort rows in multiple columns of a table: (continued)

Step Action
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Searching for Table Entries

Introduction You can use the Find command to locate one or more entries in a table.

How to Find a
Table Entry

You can search for table entries by alphanumeric text string.

To locate a table entry using the Find command: 

Step Action

1 Make the table active to make it easier to view the results of this 
command.

Tab until the vertical bar is on the left of the table. If the table is not 
active, the selection will be outlined, not highlighted. Or, open the 
Table window.

2 Choose Find.. .(z-F) in the Edit menu.

The Find dialog box appears.

3 In the Text box, enter the alphanumeric text you want to find.

4 Click the Look In the table radio button.
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How to Find the
Next Occurrence

You can use the Find Next command to repeat the last Find command 
using the same options as the last Find command. The Find Next 
command is equivalent to the most recently used Find command, but 
eliminates the need to click the OK button in the Find dialog box.

Choose Find Next (z-G) from the Edit menu. 

The next occurrence of the text is selected.

5 Select checkboxes to specify how you want to search for table 
entries:

6 Click OK.

To locate a table entry using the Find command: (continued)

Step Action

If you want to... Then click...

Restrict the search 
to a particular 
column

Look in column, and enter the number of 
the column where you want to search.

Find all entries in 
the table with the 
designated text

Find all occurrences at once.

Select additional 
table cells located 
by the command

Add to current selection.

Ignore case 
differences in text 
searches

Ignore upper/lower case differences.
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Updating Tables

Introduction If you have created a table, and made changes to peak labels, you can 
update the corresponding information in your table.

IMPORTANT The Update Table command should only be used to update 
label data in the table. If you change any other information that can appear in 
the table, such as the sample information or the name of a category, then you 
should use the Clear Table command and start over with a new table.

How To Update
Tables

Update tables after making changes to information in other parts of your 
Genotyper Document.

To update table contents:

Step Action

1 Select dye/lanes that have labels that have been changed.

2 Choose Update Table from the Table menu.

Table cells that contain data that has been changed are 
automatically updated to match the labels.
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Deriving a Second Table from an Existing Table

Introduction You can create Derived tables by copying the contents of a table and 
saving it as a Derived table. You can compare the contents of the 
Derived table to the original table, and export the Derived table.

How to Derive
Tables

You can derive a second table from an existing table. A Derived table is 
not linked to dye/lanes or categories like the table from which it was 
derived. 

To derive a second table:

Step Action

1 Open the Genotyper Document that contains the table for which 
you want to derive a copy.

2 Open the Table window from the Main window.

3 Choose Show Derived table from the Views menu.

A blank Derived table window appears.

4 Choose Derive table from the Analysis menu.

5 Choose the Copy Table submenu.

The table in the Table window is copied to the Derived table window.
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Checking for Mendelian Inheritance

Introduction Performing a Mendelian inheritance check on Genotyper table data 
verifies that alleles from members of a family follow Mendelian 
inheritance.

Example
Applications

Examples of applications for which performing a Mendelian inheritance 
check can help you verify genotyping results include:

� Microsatellite analysis

� Disease gene mapping

� Forensic research

� Paternity testing

Why Perform a
Mendelian

Inheritance Check

Mendelian inheritance checks can help you identify samples which do 
not follow expected patterns of Mendelian inheritance. Consequently, 
you can investigate where possible errors occurred in sample handling 
during your genotyping experiment, as well as verify non-paternity in 
paternity testing.

Using GenBase to
Access Pedigree

Data

To perform an inheritance check you must be able to access pedigree 
data from GenBase. GenBase can store actual pedigree structures that 
show family member relationships. For example, each individual in a 
family study has an ID assigned.

GenoPedigree can export pedigree information to GenBase. GenBase 
places this information in its pedigree table. You can then access this 
pedigree data from Genotyper.

For information on how to access GenBase from Genotyper, see 
“Communicating with GenBase” on page 10-1.
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Start with a Table Figure 8-6 shows an example of the kind of table you must first create 
before you can perform a Mendelian inheritance check in Genotyper. 

Figure 8-6 Example of table created for Mendelian inheritance check

The table in Figure 8-6 contains rows for categories and samples. The 
numbers in the peak 1 and peak 2 columns are the allele names.

For detailed instructions on how to create the table shown in Figure 8-6, 
see Part 2 of the Microsatellite tutorial, in the ABI PRISM Genotyper 
Applications Tutorials. The steps used to create the table in that part of 
the tutorial are the same as you would use to set up a table for most 
kinds of Mendelian inheritance checks.
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Sorting the Table For ease of viewing, you can sort the table using the Sort table 
command. Sorting by markers, you can group all the family members 
and identify presence or absence of alleles in particular family 
members. 

Typically, you would sort the table by category name first, and then by 
Sample Information. For more information on how to sort tables, see 
“Sorting the Rows in a Table” on page 8-30.
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How to Add
Columns for
Inheritance

Checking

Once you have set up a table such as that shown in Figure 8-6, you 
must add additional columns to the table before performing the 
inheritance check. 

To add columns to your table: 

Step Action

1 Clear the table.

2 Select the Set up Table command, this displays the settings for the 
original table shown in Figure 8-6.

3 Select checkboxes for Marker name & individual ID, Pedigree data, 
and Inheritance check. This adds seven columns to the original 
table.

Note The columns shown above already have inheritance check 
data in them. This data is not added until you perform the 
inheritance check.

4 Choose Append to Table from the Table menu. 

This appends rows to the table, adding the allelic information to the 
table.

5 Sort table by category name and file name.
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How to Import
Pedigree Data

To import pedigree data from GenBase:

Step Action

1 Choose Import Inheritance Data from GenBase. This imports the 
pedigree data from GenBase.

2 A dialog box appears and prompts you for the structure ID that 
specifies the particular set of pedigree data to use.

The ID’s are imported and placed in columns right next to the 
appropriate family member sample data.
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How to Check for
Mendelian

Inheritance

Genotyper uses the pedigree IDs to check and see if siblings have inherited 
alleles according to Mendelian principles.

To check Mendelian inheritance in tables: 

Step Action

1 Choose Check Inheritance...from the Table menu.

The Check Inheritance dialog box appears.

2 Select the columns that contain allele information from the Alleles 
are in columns pop-up menus.

3 Click the radio button for how you want to compare alleles:

Note Select Marker is sex-linked checkbox if you know you are 
working with sex-linked alleles.

If you want to compare... Then click...

Allele values Compare allele values, with 
tolerance, and type in a tolerance.

Allele text Compare allele text.
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Evaluating Results For any table cells that contain family members that have been labeled 
as possible mismatches, you can select the table cell for that individual 
and display the associated plot view for that individuals allelic 
information. This allows a graphical depiction of the potential mismatch.

Parents
Inconsistent Check

This check verifies that an individual is the child of the identified parent. 
The check verifies that children:

� Have one allele in common with each known parent for each locus.

� Not have any alleles not found in the parents.

4 Click the radio button for the rows you want to check:

5 In the Text Options text boxes, type in messages that you want to 
appear when certain conditions are met after the inheritance check.

6 Click OK. Genotyper performs an inheritance check on family 
member data in the table.

OK should appear in the column next to siblings that have inherited 
alleles from parents according to Mendelian principles.

7 You can export the table to GenBase send results to GenBase for 
storage and possibly later retrieval.

To check Mendelian inheritance in tables: (continued)

Step Action

If you want to check... Then click...

All rows in the table All rows.

Only rows you have selected in the table Selected rows.
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Siblings
Inconsistent Check

This check verifies that the set of individuals identified as siblings are in 
fact siblings. This check does not depend on the parents. If the check 
fails, then all purported siblings are labeled with the warning text. This 
check verifies that:

� No more than four alleles per locus are allowed among the siblings.

� A single allele cannot be paired with more than two other alleles for 
a locus.

� If one sibling is homozygous, no more than three alleles for that 
locus are allowed.

� If two siblings are homozygous for different alleles, no more than 
two alleles for that locus are allowed.
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Formatting Tables for Export

Introduction Some third party applications require that you re-format tables before 
exporting them from Genotyper. To format tables so that they are 
compatible, you can use the Flip Table command and flip tables before 
exporting them.

How to Format
Tables for Export

To flip and format tables for export:

Example of
Flipped Table

Figure 8-7 shows an example of a table before and after flipping

Figure 8-7 Table before (top) and after (bottom) using Flip Table command

Step Action

1 Choose Derive Table from the Analysis menu.

2 Choose the Flip Table submenu.

The table in the Table window is flipped, copied and placed in the 
derived table.

See Figure 8-7 for an example of how the Flip Table command 
reformats a table.
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Exporting Tables

Introduction You can export the contents of tables to databases, linked programs, 
and other Genotyper System applications.

How to Export
Tables

The following table explains where you can find information for how to 
export tables to different target applications.

How to Export
Derived Tables

There is a different command to export derived tables, than there is to 
export tables.

IMPORTANT You can only export derived tables as text files.

To Export Tables to... See

GenBase “Exporting Tables to GenBase” on page 10-10.

GenoPedigree The ABI PRISM GenoPedigree User’s Manual.

Linked Programs “Exporting and Copying Tables” on page 11-8.

Files “Exporting and Copying Tables” on page 11-8.

To export derived tables:

Step Action

1 Use the Derive Table command to copy the table you want to 
export.

For instructions on how to use the Derive Table command, see 
“How to Derive Tables” on page 8-36.

2 Choose Export Derived Table from the Analysis menu.

A file selection dialog box appears.

3 Choose the folder location for where you want to export the table.

4 In the Export Table as field, type in the name of the exported table.
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Working with 
Statistical Data 9
Chapter Overview

Introduction This chapter discusses how you can generate and view statistical data 
and histograms for peak data in Genotyper Documents.

In This Chapter This chapter contains the following topics:

Topic See Page

Generating Statistical Data 9-2

Choosing the Source of Data 9-4

Choosing a Value Type 9-9

Determining the Bin Size 9-13

Viewing Statistics 9-15

Viewing Histograms 9-17

Setting Histogram Viewing Options 9-20

Editing Categories in Histograms 9-22

9
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Generating Statistical Data

Introduction Genotyper generates statistical data from select parts of the active 
Genotyper Document. You can display generated statistical data in 
tables or histograms. 

Kinds of Statistical
Data

The following table describes the kinds of statistical data Genotyper can 
calculate for Genotyper Document contents. 

Information appearing in the Statistics window:

Kind of Statistic Description

Source Within a Genotyper Document, the source of data 
from which statistics are generated.

Value Type The kind of data for which Genotyper generates 
statistics. Possible Value Types are size in base pairs, 
scan number, peak height, peak area, and label text.

Number of Data 
Points

The total number of counts.

Minimum The minimum value for a range of quantities you 
define by the Value Type you specify.

Maximum The maximum value for a range of quantities you 
define by the Value Type you specify.

Mean The average value for a set of values defined by the 
Value Type you specify.

Median The center value of a series of quantities you define 
by the Value Type you specify.

Standard Deviation The standard deviation from the mean of a set of 
values defined by the Value Type you specify.

Bin The range of Value Types over which Genotyper 
calculates a count and frequency.

Count The number of Value Types found within a Bin.

Frequency The number of Value Types found within a Bin divided 
by the total number of data points.
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Setting Statistics
Options

Genotyper generates statistical data and histograms based on settings 
you make in the Set Statistics Options dialog box. 

To set statistics options, and where you can find instructions for each 
step:

Step Action See Page

1 “Choosing the Source of Data” 9-4

2 “Choosing a Value Type” 9-9

3 “Determining the Bin Size” 9-13
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Choosing the Source of Data

Introduction You can specify the source of data in a Genotyper Document for which 
Genotyper generates statistics. There are two sources of data:

� Labeled peaks

� Tables

IMPORTANT For labeled peak sources, calculated statistics do not depend on 
the particular type or contents of a label, only whether or not a peak has a label.

Labeled Peak Data
from Plot
Selections

Calculate statistics for a range of labeled peaks you select in plot 
displays.

To calculate statistics from plot selections of data: 

Step Action

1 In the Dye/lane list, select the dye/lane or dye/lanes for which you 
want to calculate and display statistical data.

An electropherogram plot showing peaks for each analyzed nucleic 
acid fragment in the sample appears in the Plot Area.

2 Click the Plot window icon, to open the Plot window.

IMPORTANT Peaks in the Plot window must be labeled to include 
them in statistical calculations. If they are not labeled, label them.
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Labeled Peak Data
from Categories

You can calculate statistics for the range of peaks defined by a selected 
category.

3 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears.

Figure 9-1 Set Statistics Options dialog box

4 In the Source field, select the Plot selection radio button.

5 Use the mouse and select a rectangular range in the 
electropherogram plot.

6 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.

To calculate statistics from plot selections of data: (continued)

Step Action

 To choose categories as the source of peak data: 

Step Action

1 In the Dye/lane list, select the dye/lane or dye/lanes for which you 
want to calculate and display statistical data.

An electropherogram plot showing peaks for each analyzed nucleic 
acid fragment in the sample appears in the Plot Area.

2 Select the category from the Category list which defines the range 
of peaks for which you want to generate statistical data.
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Labeled Peak
Fragment Size

You can specify a range of fragment sizes in base pairs. Genotyper 
generates statistical data for all peaks in the selected dye/lane of your 
active Genotyper Document that are within the fragment size range you 
specify.

3 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears (see Figure 9-1 on 
page 9-5).

4 In the Source field, select the Range of (first) selected category 
radio button.

5 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.

 To choose categories as the source of peak data: (continued)

Step Action

To specify a range of fragment sizes as the source of peak data:

Step Action

1 In the Dye/Lane list, select the dye/lane or dye/lanes for which you 
want to calculate and display statistical data.

An electropherogram plot showing peaks for each analyzed nucleic 
acid fragment in the sample appears in the Plot Area.

2 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears (see Figure 9-1 on 
page 9-5).

3 In the Source field, select the Fixed Range radio button.

4 Type in the size range in base pairs for fragments that you want to 
specify as the source of peak data.

5 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.
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Table Cell
Contents from

Selection

You can calculate statistics for the contents of selected table cells.

Table Cell
Contents from

Column Selection

You can specify a range of table columns to include as a source of data.

To choose the contents of table cells as the source of data: 

Step Action

1 Select the cell or cells in the table for which you want to generate 
statistics.

2 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears (see Figure 9-1 on 
page 9-5).

3 In the Source field, select the Table Selection radio button.

4 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.

To specify a range of table columns as the source of peak data: 

Step Action

1 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears (see Figure 9-1 on 
page 9-5).

2 In the Source field, select the range of Table columns for inclusion 
as source data. 

3 From the table column pop-up menus select the columns that 
define the beginning and ending range or conditions for source 
peak data.

4 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.
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Table Cell
Contents from
Category and

Column Selection

You can specify categories in table columns as a source of data.

To specify a category in a table column as the source of data: 

Step Action

1 Select the cell or cells in the table for which you want to generate 
statistics.

2 From the Analysis menu, choose Set Statistics Options.

The Set Statistics Options dialog box appears (see Figure 9-1 on 
page 9-5).

3 In the Source field, select when name of first selected 
category/group is in table column. 

4 From the table column pop-up menus select table column 
containing the category or group that you want to define as the 
source of your data.

5 See “Choosing a Value Type” on page 9-9, for instructions on 
selecting the appropriate Value Type radio button in the Set 
Statistics Options dialog box.
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Choosing a Value Type

Introduction The Value Type is the kind of data for which Genotyper generates 
statistics. Possible Value Types are size in base pairs, scan number, 
peak height, peak area, and label text.

Size in Base Pairs When you choose “Size in Base Pairs” as a Value Type, Genotyper 
generates statistics based on the size of fragments associated with 
your source peak data.

Scan Number When you choose Scan number as a Value Type, Genotyper generates 
statistics based on the number of scans used by your ABI PRISM 
instrument to detect the fragments associated with your source peak 
data.

To choose the Size in Base Pairs as a Value Type: 

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Size in bp radio button.

4 See “Determining the Bin Size” on page 9-13, for instructions on 
selecting the appropriate range of fragment sizes, for which 
Genotyper calculates a count, frequency of occurrence, as well as 
related statistics.

To choose the Scan number as a Value Type: 

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Scan Number radio button.
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Peak Height When you choose Peak height as a Value Type, Genotyper generates 
statistics based on the height of a select source of peak data.

Peak Area When you choose Peak area as a Value Type, Genotyper generates 
statistics based on the area of specified source peaks.

4 See “Determining the Bin Size” on page 9-13, for instructions on 
selecting the appropriate range of Scan numbers, for which 
Genotyper calculates a count, frequency of occurrence, as well as 
related statistics.

To choose the Scan number as a Value Type: (continued)

Step Action

To choose peak height as a Value Type: 

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source for peak data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Peak height radio button.

4 Optionally, select the checkbox for divided by scale factor.

5 See “Determining the Bin Size” on page 9-13, for instructions on 
selecting the appropriate range of peak data, for which Genotyper 
calculates a count, frequency of occurrence, as well as related 
statistics.

To choose peak area as a Value Type: 

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Peak area radio button.

4 Optionally, select the checkbox for divided by scale factor.
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Labeled Text When you choose Labeled text as a Value Type, Genotyper calculates 
statistics based on the number of text labels within a specified range of 
source peak data.

Cell Value When you choose Cell value as a Value Type, Genotyper generates 
statistics based on the numerical value in table cells.

5 See “Determining the Bin Size” on page 9-13, for instructions on 
selecting the appropriate range of peak data for which Genotyper 
calculates a count, frequency of occurrence, as well as related 
statistics.

To choose peak area as a Value Type: (continued)

Step Action

To choose Labeled text as a Value Type:

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Label text radio button.

Note For the Labeled text Value Type, Genotyper only calculates 
the Number of Data Points, count, and frequency of text labels 
located within a specified range.

To choose Cell value as a Value Type: 

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Cell value radio button.
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Cell Text When you choose Cell text as a Value Type, Genotyper generates 
statistics based on the text in table cells.

4 See “Determining the Bin Size” on page 9-13, for instructions on 
selecting the appropriate range of peak data for which Genotyper 
calculates a count, frequency of occurrence, as well as related 
statistics.

To choose Cell value as a Value Type: (continued)

Step Action

To choose Cell text as a Value Type:

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of data.

See “Choosing the Source of Data” on page 9-4.

3 In the Value field, select the Cell Text radio button.

Note For the Cell Text Value Type, Genotyper only calculates the 
Number of Data Points, count, and frequency of Cell text labels 
located within a specified range.
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Determining the Bin Size

Definition The Bin size defines an interval within which Genotyper calculates a 
count and frequency of each occurrence of labeled peak data that 
matches criteria defined by the Source and Value Type. Results of the 
calculations are displayed in the Statistics Window, and Histogram 
window.

Guidelines for Bin
Size Selection

If you choose too small of a number for your Bin size, you will have a 
large number of bins making it difficult to view a histogram 
representation of the statistical data.

There is a limit of 5000 bins that can be displayed in the Statistics 
window.

How to Define the
Bin Size

You define the Bin size in the Set Statistics Options dialog box.

To define the Bin size:

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data. 

See “Choosing the Source of Data” on page 9-4.

3 If you have not already done so, choose a Value Type.

See “Choosing a Value Type” on page 9-9.

4 In the Bin size field, type in an interval within which you want to 
calculate the count and frequency of occurrences of the specified 
Value Type.

5 Determine the starting bin.

See “How to Determine the Starting Bin” on page 9-14.
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How to Determine
the Starting Bin

The Starting bin determines the initial value of the Bin size. You can 
either determine the Starting bin automatically, or specify a starting 
value.

To define the Starting bin:

Step Action

1 If it is not already open, open the Set Statistics Options dialog box 
by choosing Set Statistics Options from the Analysis menu. See 
Figure 9-1 on page 9-5.

2 If you have not already done so, choose a source of peak data.

See “Choosing the Source of Data” on page 9-4.

3 If you have not already done so, choose a Value Type.

See “Choosing a Value Type” on page 9-9.

4 In the Bin size field, type in an interval within which you want to 
calculate the count and frequency of occurrences of labeled peak 
data.

5 In the Starting bin field, determine the Starting bin:

6 When you are satisfied with all the settings in the Set Statistics 
Options dialog box, click OK.

If you want to... Then click...

Use the first bin containing one or 
more counts

Determine 
automatically.

Define the Starting bin size At value, and type in the 
Starting bin.
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Viewing Statistics

Introduction Once you have set statistics options, you can show statistics for the 
kinds of data you have selected.

The Statistics
Window

The Statistics window displays the statistics of selected data.

Figure 9-2 The Statistics window
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How to View Peak
Statistics

Once you have set statistics options, you can show the Statistics 
window at any time.

How to Locate
Bins in Tables

You can use the Locate in Table button to find data in a table that 
corresponds to bins in the Statistics window. The Locate in Table button 
is enabled when you are using table columns (not table selection) as 
the source of data for statistics.

To view the Statistics window:

Step Action

1 Complete the Set Statistics Options dialog box (Figure 9-1 on 
page 9-5).

2 Select the data from the appropriate part of the Genotyper 
document that corresponds to the source you selected in Set 
Statistics Options dialog box.

3 Choose Show Statistics window from the Views menu.

The Statistics window appears (Figure 9-2 on page 9-15).

To see statistics from a different source of data, or of a different 
Value Type, or of a different Bin size, make changes in the Set 
Statistics Options dialog box.

To locate bins in tables:

Step Action

1 Open the Table window.

2 Select one or more cells in contiguous rows in the Statistics window 
(Figure 9-2 on page 9-15).

3 Click the Locate in Table button.

Cells in the table that correspond to selected bins are highlighted.
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Viewing Histograms

Introduction Histograms show a graphical representation of data shown in the 
Statistics window.

The Histogram
Window

The Histogram window displays a histogram of data based on settings 
you have made in the Set Statistics Options dialog box.

Figure 9-3 The Histogram window

How to View the
Histogram

Window

You can show the Histogram window at any time once you have 
completed the Set Statistics Options dialog box.

To view the Histogram window: 

Step Action

1 Complete the Set Statistics Options dialog box (Figure 9-1 on 
page 9-5).

2 Select the data from the appropriate part of the Genotyper 
document that corresponds to the source you selected in Set 
Statistics Options dialog box.
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Displaying Bin
Statistics

The bars in the Histogram window show statistics for defined Bin sizes. 
To display Statistical information for that bin at the bottom of the 
Histogram window, use the mouse to select a range in the Histogram 
window. Bin statistics for the range you selected display at the bottom of 
the window (Figure 9-4).

Figure 9-4 Bin statistics for a selected range

3 Choose Show Histogram window from the Views menu.

The Histogram window appears (Figure 9-3). The bars in the 
Histogram window represent the defined bin sizes. Putting your 
cursor on a bar displays Statistical information for that bin at the 
bottom of the Histogram window.

To see a different kind of histogram, make changes in the Set 
Statistics Options dialog box.

To view the Histogram window: (continued)

Step Action

Bin statistics
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Viewing
Histograms with

Small Bin Sizes

If the text “WARNING - “Bin sizes too small to display” appears at the 
bottom of the Histogram window, this means that the width of one or 
more bins is too narrow to be displayed on your computer screen.

To view histograms with small bins sizes, do one of the following:

� Choose Set Statistics Options from the Analysis menu, and 
increase the Bin size to a value adequate for viewing.

� Zoom in on the region of the histogram that you want to view.

� Increase the size of the histogram window.
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Setting Histogram Viewing Options

Introduction You can set options for viewing histograms which allows you to 
associate histogram data with corresponding data in plot displays and 
tables.

How to Set Plot
Zooming Options

You can associate data in histograms with corresponding Plot displays, 
so that when you zoom to a region of peaks in the Plot window, the 
histogram view zooms to the corresponding region of data. Plots views 
also zoom to corresponding regions of peak data when you zoom to the 
region in the histogram.

To set display options for histograms: 

Step Action

1 View the Histogram for peak data you want to associate with 
corresponding plot display.

2 Choose Set Histogram Options from the Analysis menu.

The Set Histogram Options dialog box appears.

3 Select Zoom histogram with plot.

4 Open the Plot window, and select a region of the electropherogram.

5 Choose Zoom to a selected range (z-R).

The Histogram window zooms to the region in the histogram that 
contains the corresponding peak data.
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Viewing
Histograms of

Table Data

If you want to view histograms of data from tables, you need define the 
value type of the data in the table. 

For example, if your table contains peak sizes and peak heights, and 
you have chosen to make a histogram of the peak heights by selecting 
table columns, then select the Peak height radio button in the Set 
Histogram Options dialog box(Figure ).

For more information on choosing a source of data for histograms 
see“Choosing the Source of Data” on page 9-4. 

To set display options for histograms: 

Step Action

1 View the Histogram for the table you defined as a source of peak 
data.

2 Choose Set Histogram Options from the Analysis menu.

The Set Histogram Options dialog box appears.

3 In the “Treat table values as:” field, click the value type of the data in 
your table.

4 Click OK.

The Histogram window should now display the same type of peak 
data as the associated table.
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Editing Categories in Histograms

Introduction The Histogram window provides a graphical display of peak size 
ranges. When viewing the Histogram window you can define new 
categories or edit existing ones.

How to Define the
Range for a New

Category

You can define the range of peak sizes in the Histogram window to 
include in a new category.

To define the range for a new category: 

Step Action

1 View the appropriate histogram by showing the Histogram window.

2 Place the cursor on the part of the histogram that displays peak 
sizes for the start point of the range of peak sizes that you want to 
include in your new category.

3 Drag the mouse across the histogram display drawing a box around 
the range of peak sizes that you want to include in your new 
category.

4 Choose Add Category...from the Category menu.

The Add Category dialog box appears. A size range of from/to will 
be defined by the Add Category dialog box. If you instead hold 
down the Shift key when choosing Add Category, the range will be ± 
a fixed number centered on the weighted average of bins in the 
selected range (or a center value if no bins have been selected).



Working with Statistical Data 9-23

How to View
Category Size

Ranges

You can edit existing categories from the Histogram window, redefining 
the range of peak sizes included in the category.

5 Type in the name of the new category.

The name of the newly defined category is added to the Category 
pop-up menu of the Histogram window.

To define the range for a new category: (continued)

Step Action

To view category size ranges in histograms: 

Step Action

1 Generate a histogram of peak sizes.

2 Choose a category from the Category pop-up menu.

All category groups and non-member categories will have ranges 
shown with dashed boxes. The selected category will have handles.

3 To view ranges for category members, choose a member in the 
Member pop-up menu.

All members of selected groups will have ranges shown with 
dashed boxes. Selected members will have handles.
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How to Change
Category Size

Ranges

You can change the size range of categories from the Histogram 
window.

To change the category size ranges in histograms: 

Step Action

1 Generate a histogram of peak sizes.

2 Show the Histogram window.

3 Choose a category or a member from the appropriate pop-up 
menu.

4 Move the cursor to the handle of selected category.

5 Using the mouse, drag the handle on the box until the size range is 
modified to your specifications.

Note The range will be changed to align with bin boundaries. 
Overlapping categories will not be allowed. If the text “WARNING - 
Bin sizes too small to display” appears at the bottom of the 
Histogram window, you will not be able to modify the categories by 
this method. Use the Set Statistics Options command to increase 
the bin size to an adequate value.
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How to Select
Another Category

After you have adjusted the size range of one category, you can select 
another category from the Histogram window, and modify its size range 
as well. There are four different ways that you can select another 
category:

� Select another category from the Category pop-up menu. The 
handles move to the dashed box of the selected category.

� Click within the dashed box representing the size range of a 
category. The category name of your selection changes in the 
Category pop-up menu.

� Make your selection from the Category list.

� Press z-J, the Zoom to next category command.
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Communicating with 
GenBase 10
Chapter Overview

Introduction This chapter discusses how you can expand your genotyping research 
efforts by communicating with GenBase, a database of genotyping 
results data. Once you establish a link to GenBase, you can import data 
relevant to your research into your Genotyper Documents, or export 
your results data to GenBase for storage or later retrieval. GenBase 
also provides you access to data exported from GenoPedigree and 
other linkage analysis applications.

In This Chapter This chapter contains the following topics:

Topic See Page

Linking to GenBase 10-2

Importing and Exporting Results Data 10-4

Importing Tables from GenBase 10-6

Exporting Tables to GenBase 10-10

Importing and Exporting Categories 10-15

Importing and Exporting GenoPedigree Data 10-16

10
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Linking to GenBase

What is GenBase GenBase is a database application that enables you to create large 
databases of genotyping results data without reformatting. In GenBase, 
you can manipulate genotyping results data and other information 
related to Genotyper Documents, GeneScan files, or GenoPedigree 
drawings.

For detailed information about interacting with GenBase to perform any 
of the procedures discussed in this Chapter, refer to the ABI PRISM 
GenBase User’s Manual.

Why Link to
GenBase

By linking to GenBase, you can exchange Genotyper results data with 
relevant research data stored in GenBase tables. 

Some reasons why you might want to communicate with GenBase 
include:

� Importing or exporting genotypes or genotyping data such as 
sample, patient, pedigree information.

� Accessing genetic disease research information such as 
penetrance data and patient sample information relevant to your 
applications.

� Improving error checking by maintaining an audit trail of previous 
genotyping activities. 

By linking to GenBase, you can retrieve information about sample 
types, gel conditions, or patient related information such as 
pedigree data, patient ID from previous genotyping applications and 
compare it to your most recent data.

� Creating a repository of allelic bin settings.

� Calculating frequency of markers used in previous studies similar to 
your application.

� Performing Mendelian inheritance checks.



Communicating with GenBase 10-3

How to Link to
GenBase

After you link to GenBase, you can import or export results data from 
Genotyper. You only need to perform the following steps for linking to 
GenBase once. After you have established a link, the next time you 
start Genotyper, you only have to click the GenBase icon from the Main 
Window to access the database. 

To link to GenBase from Genotyper:

Step Action

1 Install GenBase on the same computer as Genotyper.

2 Select Links from the File menu.

3 Select Choose GenBase.

An application selection dialog box appears.

4 Highlight the version of GenBase to which you want to connect. 

5 Click Select and Genotyper is connected to GenBase. 

Once you’ve established a link to GenBase, each time you want to 
access the database, click the GenBase icon on the Main window.
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Importing and Exporting Results Data

Introduction GenBase stores all results data in a Genotype Record. Once you have 
linked to GenBase from Genotyper, you can import information from the 
Genotype Record or export Genotyper results data to the Genotype 
Record. Using GenBase commands, you can manipulate the exported 
Genotyper data. 

IMPORTANT Once you begin communicating with GenBase, do not attempt 
to switch to another GenBase data file while Genotyper is still running. Quit both 
programs first, before switching GenBase to a different data file. If you save a 
Genotyper document that contains dye/lanes or a table, do not attempt to use 
this file with a different GenBase data file other than the one originally used with 
the document, even if you quit both programs first.

The Genotype
Record

The Genotype Record window in GenBase shows all of the fields in a 
Genotype Record.

Figure 10-1 The Genotype Record

For a detailed description of fields in the Genotype Record, see the ABI 
PRISM GenBase User’s Manual.
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Kinds of Results
Data You Can

Exchange

Genotyper can exchange results data for tables and categories with 
GenBase. The following table shows which pages to refer to for 
instructions on how to either import or export the specified results data.

Kinds of results data Genotyper and GenBase exchange: 

If you want to... See Page

Import tables 10-6

Export tables 10-10

Import categories 10-15

Export categories 10-15
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Importing Tables from GenBase

Introduction GenBase organizes all genotyping results data into function-specific 
tables. For example, data for populations, samples, and allele 
definitions are organized in separate tables. You can import data from 
GenBase tables into Genotyper for modification or inclusion in 
Genotyper tables.

Kinds of GenBase
Tables

GenBase tables are stored in the Genotyper Record. This table shows 
the kind of GenBase tables that contain data appropriate for import and 
use in Genotyper.

Kinds of GenBase tables: 

GenBase Table 
Name Description

Category 
Members

Stores category definitions from Genotyper.

Genotypes Stores genotyping results from Genotyper.

Individuals Keeps track of information on every individual in your 
study and provides convenient cross-references for 
sorting and searching through patient populations.

Markers Defines markers. You can specify map locations (for a 
particular map) and alternate names (for a particular 
Alternate Marker Name Set).

Pedigrees Provides information that is imported from 
GenoPedigree. Can be set up manually if you don’t 
have GenoPedigree.

Pedigree 
Structures

List of names of hypotheses for pedigree 
relationships.

Samples Assigns IDs to your nucleic acid samples, and 
provides cross-references to individuals and their 
samples.
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How to Specify the
Format

Before you import data from a GenBase table into Genotyper, use the 
Set Up Table... command in Genotyper to specify formats for imported 
GenBase data.

 To import GenBase tables into Genotyper: 

Step Action

1 Link to GenBase.

2 Select Clear Table from the Analysis menu.

3 Select Set Up Table from the Table menu.

The Set Up Table dialog box appears.
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How to Import
Tables

You can import data from GenBase tables, and further analyze it with 
Genotyper commands.

4 Select the following checkboxes:

� Sample Info

� Name of category

� Labels

The following fields are optional:

� Name of GeneScan file

� Lane number

� Dye letter

� Lane and dye

� Text if >N labels

� Edited-label warning

� Edited-table warning

Note Other fields are not available for import.

5 Click OK.

 To import GenBase tables into Genotyper: (continued)

Step Action

To import GenBase tables into Genotyper: 

Step Action

1 Link to GenBase.

2 Open the Genotypes Summary Table in GenBase.

3 Select and show records that you want to import, and append to 
your Genotyper table.

4 In Genotyper, set up the kind of table to which you want to append 
rows of Genotype Records.

For more information on setting up tables in Genotyper, see “Setting 
Up a Table” on page 8-2.

5 From the Table menu, choose Append from GenBase.

A dialog box appears telling you how many records, or rows 
Genotyper will append to your table.
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6 Click OK and Genotyper imports select records and appends them 
as rows to your table.

Note If you plan to edit the table data in Genotyper and then 
export the table to GenBase, you must use the Re-import Dye/lane 
command to import the associated dye/lanes into the Dye/lane list 
before exporting the table.

For more information on using the Re-import Dye/lane command, 
see “Re-importing Dye/lanes” on page 8-6.

To import GenBase tables into Genotyper: (continued)

Step Action
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Exporting Tables to GenBase

Introduction GenBase organizes all genotyping results data into function specific 
tables. For example, data for populations, samples, and allele 
definitions are organized in separate tables. You can export data from 
Genotyper tables for inclusion in specific GenBase tables.

IMPORTANT The label data must be set up correctly in the table for the 
Export to GenBase...command to give satisfactory results. If the table is not set 
up correctly in Genotyper, then the data in GenBase may end up in the wrong 
format.

How to Specify the
Format

Before you export data from a Genotyper table into GenBase, use the 
Set Up Table command in Genotyper to specify formats for exported 
GenBase data.

 To specify format of tables for export to GenBase: 

Step Action

1 Link to GenBase.

2 Select Clear Table from the Analysis menu.

3 Select Set Up Table from the Table menu.

The Set Up Table dialog box appears.
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4 Select the following checkboxes:

� Sample Info

� Name of category

� Labels

The following fields are optional, and will only be sent if checked:

� Size-calling method

� Text if >N labels

� Low-signal warning

� Saturation warning

� Minimum modulation

� Modulation warning

The following fields are sent automatically and do not need to be 
checked:

� Name of GeneScan file

� Lane number

� Dye letter

� Name of Gel file

� Edited-label warning

� Edited-table warning

Note Other fields are not available for export.

 To specify format of tables for export to GenBase: (continued)

Step Action
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How to Export
Tables

You can export data from Genotyper to specific GenBase tables stored 
in the Genotype Record.

IMPORTANT The Export to GenBase command sends data from the 
dye/lanes as well as the table. If associated dye/lanes have been deleted or are 
not present in dye/lane list, do not export the table to GenBase.

5 Choose the kind of label data that you want to send to GenBase:

Note If you choose sizes and allele names, make sure that every 
labeled peak has two labels. For a description of how to set up your 
categories to insure that all peaks are labeled with either the correct 
allele name or with the name “Unknown” to indicate a new allele has 
been detected, see “Using Exclusive Peak Labeling–An Example” 
on page 6-10.

6 Click OK.

 To specify format of tables for export to GenBase: (continued)

Step Action

If your labeled peaks 
have... Then...

Size labels only Choose one label per peak in the 
labels options of the Set Up 
Table...command.

Sizes and allele names Choose two labels per peak in the 
labels options of the Set Up 
Table...command.

Note Category member names 
correspond to allele names.

To export Genotyper tables to GenBase: 

Step Action

1 Establish a link to GenBase.

2 Open the Genotyper Document that contains the data that you want 
to export.

Note If a document does not already exist, import the GeneScan 
files that contain the sample data that you want to export.
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3

For more information on setting up tables in Genotyper, see “Setting 
Up a Table” on page 8-2.

4 Select the dye/lanes from the Dye/lane list that you want to include 
in the Table.

5 Select the category that specifies the kind of peak data you want to 
include from select dye/lanes.

6 Select Append to Table from the Table menu, and the selected 
dye/lane peak information appears in the Table view of the Main 
Window.

To export Genotyper tables to GenBase: (continued)

Step Action

If the Genotyper 
Document... Then...

Contains a Table that you 
want to export

Go to step 7.

Does not contain a Table you 
want to export

Choose Set Up Table from the 
Table menu, and specify the 
format for the table you want to 
export.
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How to Update
Tables in GenBase

If you have appended rows to a Genotyper table from a GenBase table, 
and then edited the contents of that table either by editing cells or by 
clicking on labels and updating the table, you may want to update the 
corresponding table in GenBase with your edited table.

To update tables in GenBase with table data edited in Genotyper, 
choose Update Table in GenBase from the Table menu.

Note Remember that the associated dye/lanes must be present in the 
Dye/lane list in order for you to update the table in GenBase.

7 Select Export to GenBase from the Table menu.

To export Genotyper tables to GenBase: (continued)

Step Action
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Importing and Exporting Categories

Introduction Once you have linked to GenBase, You can import marker data and 
categories from GenBase, and Export Genotyper categories to 
GenBase.

IMPORTANT You can only export members of category groups to GenBase. 
The first time you attempt to export a non-member category, Genotyper issues 
an alert. reminding you that such categories will not be sent to GenBase.

A Comparison of
Markers and

Categories

GenBase stores categories and markers. Although it is not uncommon 
to use the terms interchangeably, GenBase allows you to make a 
distinction between the two terms and assign multiple categories to 
each marker.

How to Import
Categories

To import Genotyper categories from GenBase:

How to Export
Categories

To export Genotyper categories to GenBase:

Step Action

1 Link to GenBase.

2 Open the Category Members table in GenBase, and make sure that 
only those categories that you want to import are currently shown in 
the table.

3 Choose Import Categories from Database, from the Category 
menu.

Note Categories are imported from GenBase and appear in the 
Category list of your active Genotyper Document.

Step Action

1 Mark the categories to export from the Category list in the Main 
window. 

2 Select Export Marked Category to Database from the Category 
menu.
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Importing and Exporting GenoPedigree Data

Introduction Establishing a link to GenBase provides a means of exchanging results 
data between Genotyper and GenoPedigree, the pedigree drawing 
software application. 

Through GenBase, you can import pedigree drawings, marker and 
allele data into Genotyper from GenoPedigree, and export table and 
category information from Genotyper to GenoPedigree.

For detailed instructions on how to import and export GenoPedigree 
data, see the ABI PRISM GenoPedigree User’s Manual.

How to Link to
GenoPedigree

Data

You can link to GenoPedigree from the Genotyper Main window, if you 
have installed the pedigree drawing program on the same system as 
Genotyper.

To link to GenoPedigree from Genotyper:

Step Action

1 Select Links from the File menu.

2 Select Choose GenoPedigree.

An application selection dialog box appears.

3 Highlight the version of GenoPedigree to which you want to 
connect. 

4 Click Select and Genotyper is connected to GenoPedigree. 

Once you’ve established a link to GenoPedigree, each time you 
want to access the database, click the GenoPedigree icon on the 
Main window.
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Linking to Programs 
and Files 11
Chapter Overview

Introduction This chapter discusses how you can expand your genotyping research 
efforts by linking Genotyper to third-party programs or files and 
transferring results data.

In This Chapter This chapter contains the following topics:

Topic See Page

Planning to Link to Programs and Documents 11-2

Choosing Linked Programs and Documents 11-5

Running a Macro or Script in a Linked Program 11-7

Exporting and Copying Tables 11-8

11
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Planning to Link to Programs and Documents

Introduction If you are planning to link to third-party programs or spreadsheet 
applications, after performing genotyping tasks, you need to set up 
Genotyper so that you can generate results data that is compatible with 
the program you are planning to use.

How to Set
Preferences for

Linking to
Programs

You can set preferences for opening a linked program or document 
when you start Genotyper. These linking preferences apply to all open 
Genotyper Documents, not just the active document. Genotyper 
remembers all links you have established when you quit Genotyper.

Note Preference settings are saved in the Genotyper preferences file in the 
System Preferences folder.

To set preferences for linked programs: 

Step Action

1 Choose Set Preferences...in the Edit menu.

The Set Preferences dialog box appears.
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2 Under the bullet “Automatic options for linked program & 
document:”, select the checkboxes for how you want to link to third-
party programs and documents when opening and quitting 
Genotyper.

Note These preference settings do not apply to GenBase or 
GenoPedigree.

3 Click OK.

To set preferences for linked programs: (continued)

Step Action
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How to Set
Preferences for

Exporting a Table
to a File

You can export Genotyper tables to a file. Some programs or 
documents that read this file require the data to be in a specific format; 
for example, fields must be delimited by tabs or commas. These format 
options are available in the Set Preferences dialog box.

Note Preference settings are saved in the Genotyper preferences file in the 
System Preferences folder.

To set preferences for exporting tables to files: 

Step Action

1 Choose Set Preferences...in the Edit menu.

The Set Preferences dialog box appears.

2 Under the bullet “Options for exporting tables:”, click the appropriate 
radio buttons for field delimiting and line delimiting.

3 Click OK.



Linking to Programs and Files 11-5

Choosing Linked Programs and Documents

Introduction You can link Genotyper to spreadsheet programs or data base 
programs that have Apple Event capabilities and use the Apple Event 
table suite. You may want to link to third-party programs if you have 
specialized applications that require different analysis procedures than 
those offered by GenBase or GenoPedigree.

Example
Programs

Some examples of third-party programs you might want to link to and 
transfer your results data include:

� Microsoft Excel

� Claris FileMaker Pro

How to Choose a
Linked Program

To choose a program to link to from Genotyper: 

How to Choose a
Linked Document

You can choose a document in the linked program after you have 
chosen the linked program. If you do not choose a specified linked 
document, Genotyper will use the untitled default document, if any, 
opened by the linked program.

Step Action

1 From the File menu, point to Links and click on Choose Linked 
Program...

The Directory dialog box appears.

2 Locate and select the program to be linked.

Step Action

1 From the File menu, point to Links and click on Choose Linked 
Document...

The Directory dialog box appears.

2 Locate and select the document to be linked.
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Opening a Linked
Program

If you have configured the Set Preferences dialog box to open the linked 
program automatically, and if the linked program was already opened by 
Genotyper, then you do not need to use the Open Linked Program 
command. 

IMPORTANT If a program is already opened, but was not opened using the 
Open Linked Program command in Genotyper, you still need to choose Open 
Linked Program.

Opening a Linked
Document

To open a linked program:

Step Action

1 Choose Open Linked Program in the File menu.

The linked program opens.

To open a linked document:

Step Action

1 Choose Open Linked Document in the File menu.

A specific document in the linked program opens.
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Running a Macro or Script in a Linked Program

Introduction You can run a macro or script from Genotyper that you created in a 
linked program.

How to Run a
Macro/Script in a
Linked Program

To run a macro/script in a linked program: 

Examples of
Macros in Linked

Programs

The following are examples of how you can define macros in different 
kinds of linked programs:

� FileMaker Pro users enter the name of the FileMaker Pro script.

� Microsoft Excel users enter the following:

[name of Macro Sheet]![name of macro]()

Example

Macro1!Record()

IMPORTANT The macro will not work for Excel programs without the pair of 
parentheses at the end.

Step Action

1 Create and name a macro/script in the linked program.

2 In Genotyper, choose Run Linked Macro/Script...in the Macro 
menu.

3 Enter the name of the macro that was defined in the linked program.

4 Click OK.

The macro runs in the linked program.
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Exporting and Copying Tables

Introduction You can export a Genotyper table to a plain text file so that you can read 
it using a word processing or spreadsheet application. You can open 
this file in Simple Text to view it.

IMPORTANT Once a table is exported to a file it cannot be imported back into 
Genotyper. If you want to continue working with the table, save your work as a 
Genotyper Document by using the Save command. This will save the dye/lanes, 
categories, or labels, and will allow you to continue your work at a later time.

How to Export a
Table

To export a table to a file:

How to Copy
Tables

As an alternative to making a table in a linked spreadsheet document, 
you can copy a table to a spreadsheet document.

Step Action

1 Choose Export Table...from the Edit menu.

The standard Macintosh Directory dialog box appears.

2 Enter the name of the file in the text box.

3 Designate where you want to place that file (for example, desktop or 
in another folder).

4 Click Save.

To copy tables to spreadsheets:

Step Action

1 Select a contiguous portion of the Genotyper table.

2 Choose Copy in the Edit menu.

3 Select the spreadsheet program.

4 Choose Paste in the Edit menu.
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Menu and Command 
Reference 12
Chapter Overview

Introduction This chapter provides a reference for the names, locations, and 
definitions of all menus and commands available in Genotyper 2.5.

In This Chapter This chapter contains the following topics:

Topic See Page

Genotyper Menus 12-2

The File Menu 12-3

The Edit Menu 12-5

The Analysis Menu 12-7

The Category Menu 12-9

The Table Menu 12-11

The Views Menu 12-13

The Macro Menu 12-16
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Genotyper Menus

Introduction You can access all Genotyper commands and options from pull-down 
menus listed on the menu bar.

The Menu Bar The menu bar displays across the top of your computer screen after you 
start the Genotyper application.

Menu Items Menus you can access from the menu bar:

Menu Description

The File menu Lists commands for working with Genotyper 
Documents and GeneScan files.

The Edit menu Lists commands for editing Genotyper 
Documents and table contents.

The Analysis menu Lists commands for labeling fragment peak data, 
and determining statistical data for fragment 
peaks.

The Category menu Lists commands for defining categories.

The Table menu Lists commands for setting up Tables and working 
with tabular data.

The Views menu Lists commands for opening windows for 
Genotyper Document windows in the Main 
window, and for customizing viewing of these 
windows.

The Macro menu Lists commands for creating and running macros 
for automating Genotyper procedures and 
applications.
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The File Menu

Definition The File menu contains commands for working with Genotyper 
Documents.

Menu Options The figure below shows the list of commands you can access from the 
File menu.

Commands
Commands in the File menu: 

Command Description

New Opens a new, untitled Genotyper 
document.

Open... Opens a previously saved Genotyper 
document.

Close Closes the active window.

Save Saves the active Genotyper document.

Save As... Saves the Genotyper document under a 
new name.

From GeneScan File Brings up a dialog box which allows you 
to import a GeneScan file or multiple 
GeneScan files.
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From BioLIMS Opens BioLIMS Collection Browser if a 
database connection has been 
established.

Locate GeneScan File When you select an entry in the 
Dye/lanes list, and then choose this 
command, the Finder locates the original 
GeneScan file for that selection and 
opens its folder.

Re-Import Dye/lane Re-imports dye/lanes if you have 
made a table and deleted or cleared 
all dye/lanes.

Locate in GenBase Finds specified text in a GenBase 
database if you are linked to it.

Links Sub-menu with several choices for linking.

Open GenoPedigree Provides access to the GenoPedigree 
program.

Open GenBase Provides access to GenBase.

Choose GenoPedigree Provides link to GenoPedigree program.

Choose GenBase Provides link to GenBase database.

Choose GenBase File... Provides link to files in GenBase.

Open Linked Program Opens an application program that is 
linked to Genotyper.

Open Linked Document Opens a document that is linked to 
Genotyper.

Choose Linked Program... Brings up a dialog box which allows you 
to choose a linked program.

Choose Linked Document... Brings up a dialog box which allows you 
to choose a linked document.

Commands in the File menu: (continued)

Command Description
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The Edit Menu

Definition The Edit menu contains commands for editing Genotyper documents.

Menu Options The figure below shows the list of commands you can access from the 
Edit Menu.

Commands
Commands in the Edit menu: 

Command Description

Can’t Undo Undoes the last command (whenever possible).

Cut Cuts the selection and places it on the Clipboard.

Copy Copies the selection to the Clipboard.

Paste Pastes the selection at the cursor location.

Clear Clears the currently selected entries in the 
Dye/lane list, Categories list, Macro list, or Step 
list.

Select All Selects every entry in the selected list or table.

Select

� Blue � Selects all entries in the Dye/lane list that have 
a blue dye color.

� Green � Selects all entries in the Dye/lane list that have 
a green dye color.

� Yellow � Selects all entries in the Dye/lane list that have 
a yellow dye color.
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� Red � Selects all entries in the Dye/lane list that have 
a red dye color.

� Orange � Selects all entries in the Dye/lane list that have 
an orange dye color.

Copy Window Copies the active window to the clipboard.

Edit cell... Allows you to change the contents of individual 
cells in tables.

Find... Shows a dialog box which allows you to locate 
and select an alphanumeric text in the Dye/lane 
list, Category list, or the table.

Find Next Allows you to locate and select the next case of a 
previously defined alphanumeric text, without the 
need to repeatedly use the Find dialog box.

Mark Places a bullet ( •) in front of the Categories list or 
Dye/lane list item. When a dye/lane is not 
marked, the plot corresponding to that item 
appears in the upper Plot window. When a 
category is marked, it is used by labeling and 
table commands.

Unmark Removes a bullet ( •) from the Category or 
Dye/lane list item. When a dye/lane is not 
marked, the plot corresponding to that item no 
longer appears in the upper Plot window. When a 
category is not marked, it is not used by labeling 
and table commands.

Set Preferences... Shows a dialog box which allows you to set 
options for exporting tables, define additional 
windows to be opened with the main window, 
define information to be shown in the Dye/lane 
list, and set automatic options for a linked 
program or document.

Show Clipboard Shows items that have been cut, or copied, and 
still reside in the clipboard.

Commands in the Edit menu: (continued)

Command Description
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The Analysis Menu

Definition The Analysis menu contains commands for labeling fragment peak 
data, and determining statistical data for fragment peaks.

Menu Options The figure below shows the list of commands you can access from the 
Analysis Menu.

Commands
Commands in the Analysis menu: 

Command Description

Set Click Options... Shows a dialog box in which you can set 
parameters for manual labeling of peaks (for 
example, labeling by size, height, scan number, 
or area).

Set Statistics Options... Shows a dialog box in which you can set 
parameters for what displays in the Statistics 
window. Settings include: calculate statistics for 
peak size, scan number, bin size. 

Set Histogram Options... Shows a dialog box in which you can set 
parameters for how the histogram window 
interacts with other parts of a Genotyper 
Document.
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Label Peaks... Shows a dialog box which allows you to label 
peaks for selected dye/lanes that have been 
defined by marked category parameters.

Change Labels... Shows a dialog box which, for selected lanes in 
the Dye/lane list, allows you to change the 
labels at currently labeled peaks.

Normalize Labels... Shows a dialog box which allows you to 
normalize data in several peak labels to data in 
a specific (control) label.

Filter Labels... Removes unwanted labels from peaks.

Remove Labels... Shows a dialog box which allows you to remove 
labels from specified peak locations of selected 
dye/lanes in the dye/lane list.

Clear Common Labels... In currently-selected set of dye/lanes, remove 
labels for peaks that (within tolerance) are at the 
same location and are labeled in each of the 
dye/lanes; shows a dialog box to set the 
tolerance.

Calculate Scale 
Factors...

Normalizes the height or area of peaks.

Derive Table... Enables you to derive a second table from an 
existing table. A derived table is not linked to 
dye/lanes or categories like the table from which 
it was derived. 

Copy Table Copies the table in the Table window to the 
Derived table window.

Flip Table Flips the table in the Table window, copies it and 
places it in the derived table window.

Export Derived Table Exports derived tables as text files.

Clear Category list Clears all entries in the Category list.

Clear All Labels Removes all labels from all peaks 
(whether selected or not) in the Plot window.

Clear Table Removes all rows and columns from the table.

Clear Dye/Lane list Removes all entries from the Dye/lane list.

Clear All Scale Factors Resets all scale factors from dye/lanes in the 
Dye/lane list to 1.0.

Commands in the Analysis menu: (continued)

Command Description
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The Category Menu

Definition The Category menu contains commands for defining categories.

Menu Options This figure shows the list of commands you can access from the 
Category menu.

Commands
Commands in the Category menu: 

Command Description

Add Category... Shows a dialog box which allows you to set 
category parameters for new categories.

Add Multiple Categories... Shows a dialog box which allows you to 
create multiple categories at once.

Edit Category... Shows a dialog box which allows you to 
change the parameters of the selected 
category.

Offset Categories... Allows you to adjust the size range for 
peak labeling for selected categories.

Calculate Offset... Automatically adjusts the size range for 
peak labeling for selected categories.

Export Marked Categories to 
Database

Exports marked Genotyper categories to 
GenBase.

Import Categories from 
Database

Imports Genotyper categories from 
GenBase.

Make from Labels... Shows a dialog box that allows you to 
create categories from labels.
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Make Category Members... Shows a dialog box that allows you to 
create member categories for specialized 
applications.

Commands in the Category menu: (continued)

Command Description
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The Table Menu

Definition The Table menu contains commands for setting up Tables and working 
with tabular data.

Menu Options This figure shows the list of commands you can access from the Table 
menu.

Commands
Commands in the Table menu: 

Command Description

Set up Table... Shows a dialog box which allows you to 
define the contents and order of rows and 
column headings for tables.

Append to Table Adds rows to an existing table.

Update Table If you have created a table, and made 
changes to peak labels, updates the 
corresponding information in your table.

Sort Table... Shows a dialog box which allows you to sort 
the rows of a table in a Genotyper document.

Analyze Table... Allows you to specify conditions for logical 
comparisons of table cell contents.

Calculate in Table... Allows you to perform numerical calculations 
of table cell contents.
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Check Inheritance... Shows a dialog box that allows you to check 
Mendelian inheritance in the table.

Export to File... Exports table contents to a text file.

Export to GenBase... Exports select tables to GenBase.

Update to GenBase... Updates GenBase tables with information 
from select Genotyper tables.

Export to Link... Exports table contents to a linked program 
(other than GenBase or GenoPedigree).

Append from GenBase... Allows you to append rows to Genotyper 
tables from GenBase tables.

Import IDs from GenBase... Imports data from GenBase for inheritance 
checking.

Add Rows to Table... For compatibility with Genotyper versions 1.x 
only.

Add Rows to Link... For compatibility with Genotyper versions 1.x 
only.

Commands in the Table menu: (continued)

Command Description
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The Views Menu

Definition The Views menu contains commands for opening windows for 
Genotyper Document windows in the Main window, and for customizing 
viewing of these windows.

Menu Options This figure shows the list of commands you can access from the Views 
Menu.

Commands
Commands in the Views menu: 

Command Description

Display by Size Changes the horizontal scale in the plot areas to 
base pairs.

Display by Scan Changes the horizontal scale in the plot areas to 
scan line.

Expand Categories Displays all categories in a selected category 
group in the Category list.

Collapse Categories Displays only the category group name of a 
selected category in the Category list.
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Show Main Window Shows all parts of a Genotyper Document in one 
window, the Main window.

Show Dye/lanes 
Window

Opens an additional, larger window that shows 
only the Dye/lane list.

Show Plot Window Opens an additional, larger window that shows 
only the plots and peak labels. The window 
expands vertically to fill the computer screen.

Show Categories 
Window

Opens an additional, larger window that shows 
only the Category list.

Show Table Window Opens an additional, larger window that shows 
only the table.

Show Macro Window Opens an additional, larger window that shows 
only the Macro list.

Show Step Window Opens an additional, larger window that shows 
only the Step list.

Show Statistics Window Opens window displaying statistics of selected 
peaks (number of labeled peaks, minimum, 
maximum, median, standard deviation, count, 
and bin).

Show Histogram 
Window

Opens window displaying histogram 
representation of statistics of selected peaks.

Show Derived Table 
Window

Opens window displaying Derived table, if one 
exists.

Dye/Lane Sorting... Brings up a dialog box which allows you to sort 
the Dye/lane list by file names, lanes, dye color, 
sample information, or sample comments in 
ascending or descending order.

Category Sorting... Brings up a dialog box which allows you to sort 
category names, category starting size or scan 
number, and category dye color in ascending or 
descending order.

Plot Options

Label Options... Brings up a dialog box which allows you to 
modify and use colors and prefixes in labels.

Dye Scaling... Brings up a dialog box which allows you to 
modify signal heights.

Commands in the Views menu: (continued)

Command Description
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Main Window, Upper 
Pane...

Displays the Plot Options dialog box, allowing 
you to change the display options in the upper 
pane of the Main window.

Main Window, Lower 
Pane...

Displays the Plot Options dialog box, allowing 
you to change the display options in the lower 
pane of the Main window.

Plot Window, Upper 
Pane...

When the Plot window is open, displays the Plot 
Options dialog box, allowing you to change the 
display options in the upper pane of the Plot 
window.

Plot Window, Lower 
Pane...

When the Plot window is open, displays the Plot 
Options dialog box, allowing you to change the 
display options in the lower pane of the Plot 
window.

Zoom

Zoom In Zoom in by a factor of two.

Zoom In (Selected 
Range)

Expands the selected portion of an 
electropherogram to fill the full plot area.

Zoom Out Shows a somewhat larger section of the 
electropherogram.

Zoom Out (Full 
Range)

Shows the complete electropherogram.

Zoom To... Brings up a dialog box which allows you to 
specify a zoom range.

Zoom To Category Zooms to a range that includes the ranges of 
currently-selected categories.

Zoom To Next 
Category

Zoom to the range of the next marked category 
following the currently-selected category.

Commands in the Views menu: (continued)

Command Description
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The Macro Menu

Definition The Macro menu contains commands for creating and running macros 
for automating Genotyper procedures and applications.

Menu Options This figure shows the list of commands you can access from the Macro 
menu.

Commands
Commands in the Macro menu: 

Command Description

Record Steps When this menu item is checked, your steps 
(commands) will be added to the Current 
Step Log.

Save Step Log... Creates a macro from the current step log 
and brings up a dialog box which allows you 
to name the macro and choose a keyboard 
command to run it.

Run Macro Runs the selected macro.

Change Macro Name... Brings up a dialog box which allows you to 
change the name of the selected macro and 
change the keyboard command which runs it.

Duplicate Macro... Makes a copy of the selected macro. This is 
useful if you have a macro that you want to 
modify slightly, but you do not want to lose the 
original macro.
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Run Linked Macro/Script... Sends a DoScript Apple event to the linked 
program.

Edit Step... Brings up a dialog box which allows you to 
adjust the values used by the step command. 
This works only for steps created using a 
dialog box.

Run Step Runs the selected step.

Add Comment... Brings up a dialog box which allows you to 
add comments at the end of the Current Step 
log.

Set Import Macro... Automatically runs a selected macro 
immediately after import of GeneScan files.

Clear Step Log... Removes all steps in the Current Step log.

Commands in the Macro menu: (continued)

Command Description
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Importing Data from a 
BioLIMS Database 13
Chapter Overview

New Feature of
Genotyper V. 2.5

Genotyper Software version 2.5 has the ability to read ABI PRISM® 
GeneScan® Analysis data from a BioLIMS® 2.0 database.

� You can now import data from both GeneScan sample files and 
BioLIMS at the same time into a single document.

� Data imported from BioLIMS can be exported to a GenBase 
database after being processed in Genotyper.

Note Genotyper v. 2.5 has read-only access to BioLIMS. Hence, Genotyper 
results cannot be written back to the BioLIMS database. Instead they can be 
stored in individual Genotyper documents, exported as text files, or stored in a 
GenBase™ database.

In This Chapter This chapter describes how to access the BioLIMS® database, how to 
set the preferences, and how to open or process fragment data that is 
located in the BioLIMS database.

For information on troubleshooting the BioLIMS database, see 
Appendix F, “Troubleshooting the BioLIMS Database”, in the GeneScan 
Analysis Software Version 3.1 User’s Manual (P/N 4306157).

Topic See Page

Configuring the Macintosh Computer for BioLIMS Database 
Access

13-2

Setting Up Access to the BioLIMS Database 13-9

Importing GeneScan Data From BioLIMS 13-11

About Server Names 13-15

Using the Collection Browser Window 13-18

13
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Configuring the Macintosh Computer for BioLIMS Database Access

Sybase or Oracle? This section provides instructions on how to configure the client 
Macintosh computer (that runs the Genotyper software) for database 
access.

The BioLIMS database resides on either a Sybase SQL Server or an 
Oracle Server.

Configuring for
Sybase SQL

Server Connection

Follow the steps below to configure a Macintosh computer for 
connection to the Sybase® SQL server.

IMPORTANT The BioLIMS client software for Sybase® must be installed on 
your Macintosh computer.

IMPORTANT Any time the name, port number, IP address, or host and 
domain name of the BioLIMS database server is changed, you will need to 
repeat this procedure.

To configure for the… See…

Sybase SQL Server “Configuring for Sybase SQL Server Connection” 
on page 13-2.

Oracle Server “Configuring for Oracle Server Connection” on 
page 13-5.

To configure for Sybase SQL Server connection: 

Step Action

1 Find the interfaces file in the BioLIMS 2.0:BioLIMS Extras:Sybase 
folder. 

2 Open the file with SimpleText or a similar text editing application.
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3 Find the lines:

SYBASE
query MacTCP mac_ether neuron.apldbio.com 2500

and edit them as follows:

� Replace SYBASE by an alias name for the database server 
(see “About Server Names” on page 13-15).

� Replace neuron.apldbio.com with the IP address or host and 
domain name of the server machine.

� 2500 is the default port number for the Sybase database. If 
necessary, replace 2500 with the port number recommended 
by your BioLIMS database administrator.

� Insert a tab space before the start of the second line if there is 
no tab space already present.

You can find this information in the interfaces file on the Sybase 
Server, or your BioLIMS database administrator can provide the 
information.

4 If you have access to more than one server, duplicate the two lines 
and edit them for the other server(s). 

For example, for two servers, one called SYBASE and one called 
SERVER2, the interfaces file might look like this:

SYBASE
query MacTCP mac_ether neuron.apldbio.com 2500

SERVER2
query MacTCP mac_ether 192.135.191.128 2025

5 Save and close the interfaces file.

To configure for Sybase SQL Server connection: (continued)

Step Action
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6 Open the SybaseConfig control panel. This control panel is found in 
the Control Panels folder in the System folder.

7 The first time the SybaseConfig control panel is opened, a file 
browser opens automatically. 

If a file browser does not open immediately, click the Interfaces Files 
button to open one.

8 Use the file browser to locate and open the interfaces file edited in 
the steps above.

9 Set the Default Language pop-up menu to us_english.

10 Close the SybaseConfig control panel.

To configure for Sybase SQL Server connection: (continued)

Step Action
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Configuring for
Oracle Server

Connection

Use the program Easy Config to configure your Macintosh computer for 
connection to the Oracle Server.

IMPORTANT The BioLIMS client software for Oracle must be installed on your 
Macintosh computer.

IMPORTANT Any time the name, port number, IP address, or host and 
domain name of the BioLIMS database server is changed, you will need to 
repeat this procedure.

Note At installation, Easy Config is placed into the BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications:Networking folder.

To configure your computer for the Oracle Server connection: 

Step Action

1 Find the Easy Config program in the BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications:Networking folder.

2 Open the Easy Config program. 

The Remote Databases window appears.
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3 Click New. 

The Protocol dialog box appears.

4 Select TCP/IP and click OK. 

The TCP/IP dialog box appears.

To configure your computer for the Oracle Server connection: (continued)

Step Action
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5 Enter text in the fields as follows:

� Alias Name: Enter an alias name for the database server. (See 
“About Server Names” on page 13-15.)

� Server Name: Enter the server name. This may be an IP 
address or host (and domain name) of the server machine.

Note This field does not scroll horizontally for display even 
though it accepts characters typed past the end of the field. If the 
server name is longer than 20 characters, you may want to enter 
the end characters first and go back or just use the IP address.

� Oracle SID: Enter the value of the ORACLE_SID environment 
variable.

You can find this information in the tnsnames.ora file on the Oracle 
Server, or your BioLIMS database administrator can provide you 
with the information.

6 Click OK to close the TCP/IP dialog box.

7 From the File menu, choose Save Configuration.

8 From the File menu, choose Quit to exit the Easy Config program.

9 Find the application Set Oracle Home.

The application is contained in your BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications folder.

To configure your computer for the Oracle Server connection: (continued)

Step Action



13-8 Importing Data from a BioLIMS Database

10 Open the application Set Oracle Home.

11 Use the file browser to find the Oracle folder in the BioLIMS Extras 
folder.

Click the Select “Oracle” button. Do not click Open.

To configure your computer for the Oracle Server connection: (continued)

Step Action

Click this button
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Setting Up Access to the BioLIMS Database

Introduction The following procedure describes how to access the BioLIMS 
database by completing the Set Preferences dialog box.

Before you can work with the Genotyper software, you must establish a 
connection to the BioLIMS database. This connection is made through 
the BioLIMS Access button in the Set Preferences dialog box.

Using the
Preferences Box To set up your preferences: 

Step Action

1 Launch Genotyper v 2.5.

2 Choose Set Preferences... under Edit in the main menu.

The Set Preferences dialog box appears. 
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3 Click the BioLIMS button if you wish to open a connection to the 
database and save the preferences you have made in the session 
manager.

The BioLIMS Preferences dialog box opens. 

Enter the requested information and click Open to open a 
connection.

Note User entry fields appear gray and will not accept any input if 
you have already accessed files in BioLIMS through the Choose 
Channel to Open box (see step 3 on page 13-12). In this case click 
on the Close button to close the database connection. Now you can 
re-enter the information into these fields.

4 Click Save to save the information you entered.

5 Click OK in the Set Preferences dialog box.

To set up your preferences: (continued)

Step Action
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Importing GeneScan Data From BioLIMS

Introduction After the client Macintosh has been configured for BioLIMS access, you 
can access files stored in BioLIMS from the File menu of 
Genotyper v. 2.5.

Accessing Files in
BioLIMS To access files stored in BioLIMS: 

Step Action

1 Launch Genotyper v. 2.5.

2 From the File menu, point to Import and click on From BioLIMS 
Database.

The Choose Channel to Open dialog box appears if you have not 
initiated a connection to the BioLIMS database. Otherwise, the 
above step will automatically open the Collection Browser window.
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3 Enter the following information requested by the session manager 
in the Choose Channel to Open box.

� Your user name for the database.

� Your password for your database account.

� The name of the database on the server. (You may have access 
to more than one database on the server.)

Note For Oracle, this entry is the schema owner and not the 
database name.

� The server name. This is an alias to the database server which is 
contained in the interfaces file (Sybase) or in the tnsnames.ora 
file (Oracle).

IMPORTANT All of these text boxes are case sensitive.

4 Click the check box labeled Save Password if you want to:

� Save your password so that you do not have to enter it every 
time you open the connection.

� Run AppleScripts that do not contain password information.

To access files stored in BioLIMS: (continued)

Step Action
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5 If you want the database to open automatically when you launch 
the Genotyper software, click the check box labeled Open on 
Launch.

Note You must also click the check box labeled Save Password 
if you want the database to open automatically.

6 If you intend to use more than one database or user account, enter 
an alias for this BioLIMS session information. You can use an alias 
to connect to the database if no database connection is open.

Once you enter an alias, click Open to connect to the database.

7 If you have more than one alias, click the Make Default check box to 
choose which one appears when you first open the Edit Session 
dialog box.

Note The default alias is the database that opens if you choose 
File:Import:From BioLIMS Database.

Note If both the Make Default and the Save Password boxes are 
checked, no dialog box will appear when a connection to the server 
is requested. Since all the information required of the user has 
been saved, the software will connect to the database 
automatically.

8 Use the pop-up menu to add, change, or remove aliases.

To access files stored in BioLIMS: (continued)

Step Action
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9 Click Open and take one of the following actions:

To access files stored in BioLIMS: (continued)

Step Action

If the login was... Then...

successful the Collection Browser window opens. For 
more information see page 13-19.

unsuccessful an alert dialog box appears.

Check that:

� All the login information was entered 
correctly and in the correct case.

� The interfaces file is correctly 
configured for a Sybase database 
(page 13-2).

� The tnsnames.ora file is correctly 
configured for an Oracle database 
(page 13-5).

� If the connection is still not open, 
consult Appendix F, “Troubleshooting 
the BioLIMS Database”, in the 
GeneScan Analysis Software Version 
3.1 User’s Manual (P/N 4306157).
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About Server Names

Sybase or Oracle? The BioLIMS Session Manager decides whether you are connected to 
Sybase SQL Server or to an Oracle Server database by looking at the 
name in the Server field in the Session Manager dialog box. 

How Names Are
Recognized

The table below summarizes how names are recognized.

Sybase SQL
Server Examples

Example 1

If the interfaces file contains this:

MOZART
query MacTCP mac_ether mozart.apldbio.com 2500

Note Insert a tab space before the start of the second line if none already 
exists.

MOZART is recognized as a Sybase SQL Server because the server 
name is in all uppercase letters. 

The Session Manager would look like this:

If the Session Manager sees a Server 
name … It assumes a … Example

all in uppercase letters Sybase SQL Server database 
connection

MOZART

suffixed by “:s” or “:S” Sybase SQL Server database 
connection

Offenbach:S

containing any lowercase letters Oracle Server database Oramozart

suffixed by “:o” or “:O” Oracle Server database SIBELIUS:O
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Example 2

If the interfaces file contains this:

Offenbach
query MacTCP mac_ether mozart.apldbio.com 2500

the Session Manager would look like this:

For Offenbach to be recognized as a Sybase SQL Server, the name in 
the Server field is suffixed with “:S”.

Oracle Server
Examples

Example 1

If the tnsnames.ora file contains this:

Oramozart=(DESCRIPTION=
            (ADDRESS=
             (PROTOCOL=TCP)(host=mozart)(port=1521))
                  (CONNECT_DATA=(SID=WG733)
                 )
          )

Oramozart is recognized as an Oracle Server because the server name 
begins with “O”. 

The Session Manager would look like this:

Note The database entry field should contain the name of the schema owner 
which may be the same as the username.
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Example 2

If the tnsnames.ora file contains this:

SIBELIUS = (DESCRIPTION=
           (ADDRESS=
           (PROTOCOL=TCP)(host=SIBELIUS)(port=1521))
                  (CONNECT_DATA=(SID=WG733)
                 )
          )

the Session Manager would look like this:

For SIBELIUS to be recognized as a Oracle Server, the name in the 
Server field is suffixed with “:O”.

Note The database entry field should contain the name of the schema owner 
which may be the same as the username.
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Using the Collection Browser Window

Applications That
Use the Collection
Browser Window

The Collection Browser window is common to the following 
BioLIMS-aware applications.

� AutoAssembler™ DNA Sequence Assembly Software.

� GeneScan® Analysis Software.

� Factura™ Feature Identification Software.

� Sample2DB Software.

� Sequencing Analysis Software.

� Genotyper® Software v. 2.5.

Ways to Search the
Database

Using the Collection Browser window from within Genotyper software, 
you can search the BioLIMS database for specific collections and 
fragments.

The following table lists ways you can search:

In This Section This subsection includes the following topics.

Search by... See page

Up to 5 collection-specific criteria 13-21

Up to 14 fragment-specific criteria 13-22

For this topic See page

Displaying the Collection Browser Window 13-19

Collection Browser Window Example 13-19

Parts of the Collection Browser Window 13-20

Collection Search Criteria 13-21

Fragment Search Criteria 13-22

Searching the BioLIMS Database 13-26
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Displaying the
Collection Browser

Window

To display the Collection Browser window:

l

Collection Browser
Window Example

The following is an example of the Collection Browser window.

If you want to... Then... Result

add a fragment to a 
Genotyper document 
to view or analyze

choose Import from the 
File menu and From 
BioLIMS Database 
from the submenu.

The Collection Browser 
window opens if a 
database connection 
has been opened. 
                                     
                                

For more information, 
see “Collection 
Browser Window 
Example” on 
page 13-19.

Status line

Search results

Split bar

Collection search
criteria pop-up menus
and text boxes

Criteria pop-up menu Search button

Fragment
search criteria
pop-up menus
and text boxes
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Parts of the
Collection Browser

Window

The table below describes the parts of the Collection Browser window 
that were labeled in the figure above. 

Description of the Collection Browser window: 

Item Description

Criteria pop-up menu Use this pop-up menu to specify the search 
criteria visible on the Collection Browser window.

Note If you only intend to use a subset of 
criteria, setting only that subset visible helps to 
reduce clutter in the window. The search results 
are the same whether a criterion is invisible or 
blank and visible.

Search button Click this button to query the BioLIMS database.

Note All collections in the database will be 
displayed if you click on Search without first 
specifying any search criteria.

Note You can also press the Return key to 
begin a search.

Collection search 
criteria pop-up menus 
and text boxes

Use these pop-up menus and text boxes to 
define the collection criteria of the search. 

IMPORTANT Only those fragments that 
match each and every criterion you specify are 
returned. That is, search criteria are combined 
using the logical AND operation.

For more information, see “Collection Search 
Criteria” on page 13-21.

Fragment search 
criteria pop-up menu 
and text boxes

Use these pop-up menus and text boxes to 
define the fragment criteria of the search.

IMPORTANT A collection is returned if one 
or more of the fragments contained in it fulfill all 
of the specified fragment criteria.

Note Only fragments meeting search criteria 
will be displayed in the Collection Browser 
window.

For more information, see “Fragment Search 
Criteria” on page 13-22.
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Collection Search
Criteria

The table below shows the collection search criteria. The collections 
returned by the Collection Browser window must match all of the 
collection criteria and contain at least one fragment that matches all of 
the fragment criteria. 

Split bar Drag this bar to alter the relative amount of space 
allocated to the top and bottom portions of the 
Collection Browser window.

Search results After a successful query, found sample files are 
listed in this area as Name, Modification date, 
type, and Creator.

Status line Search results, error messages, and other 
important information is reported here. 

For example, the Status Line lists how many 
collections were returned in a search.

Description of the Collection Browser window: (continued)

Item Description

Allowed Collection Search Criteria: 

Criterion
Pop-up Menu 
Choices Allowed Text Description

Collection 
Creator

� is

� starts with

� ends with

� contains

up to 255 
characters

Name of the 
creator/owner of 
the collection.

Collection 
Name

� is

� starts with

� ends with

� contains

up to 31 
characters

Name of the 
collection.

Collection Type � any

� run

� project

� other

NA Collection type.

Default is any 
menu item.
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Fragment Search
Criteria

The table below shows the fragment search criteria. The collections 
returned by the Collection Browser window must contain at least one 
fragment that matches all of the specified fragment criteria.

Creation Date � any

� is

� before

� after

� between

date — set with 
arrow buttons 
using the format 
mm/dd/yy

Date the 
collection was 
created.

Modification 
Date

� any

� is

� before

� after

� between

date — set with 
arrow buttons 
using the format 
mm/dd/yy

Date the 
collection was 
last modified.

Allowed Collection Search Criteria: (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description

Fragment Search Criteria: 

Criterion
Pop-up Menu 
Choices Allowed Text Description

Sequence-Frag 
Name

� is

� starts with

� ends with

� contains

up to 
31characters 
including letters, 
numbers, and 
punctuation

Cannot use 
colons (:).

Name of the 
fragment.

This is the file 
name entered in 
the Sample 
Sheet.

Sample Creator � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Name of the 
person 
responsible for 
the run.
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Sample Name � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Sample name 
from the Sample 
Sheet.

Instrument 
Name

� is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Set in the 
General Settings 
Preferences of 
the Data 
Collection 
software.

Instrumentation � any

� gel

� capillary

NA Whether the 
sample was run 
on a gel or 
capillary 
instrument.

Start Collect 
Date

� any

� is

� before

� after

� between

date— set with 
arrow buttons 
using format 
mm/dd/yy

Date data 
collection 
began.

End Collect 
Date

� any

� is

� before

� after

� between

date — set with 
arrow buttons 
using format 
mm/dd/yy

Date data 
collection 
ended.

Gel Path � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

The full path 
name to the 
original gel file, 
e.g., 
Hard Disk:Data:
GelRuns:L28t.

Fragment Search Criteria: (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description
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Sample Info � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Sample 
information from 
the Sample 
Sheet.

Sample 
Comment

� is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Comment from 
the Sample 
Sheet.

Size Data � is present

� is not 
present

� does not 
apply

NA Is present 
means that one 
or more dyes 
contain sizing 
information.

Is not present 
means none of 
the dye sample 
contain sizing 
information.

Size Calling � done

� not done

� does not 
apply

NA Done means 
sample file has 
completed size 
calling indicated 
by a size curve.

Not done 
indicated by a 
missing size 
curve.

% Matched 
Peaks

� any

� equal to

� less than

� greater than

� between

0—100 Percentage 
based on size 
standard 
matched peaks 
divided by size 
standard 
defined peaks.

Fragment Search Criteria: (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description
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Offscale Data � present

� does not 
apply

NA Present means 
the analyzed 
range contains 
off-scale dye 
sample peaks.

Fragment Search Criteria: (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description
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Searching the
BioLIMS Database

Follow these steps to use the Collection Browser window to search the 
BioLIMS database for specific collections and fragments.

To search the BioLIMS database: 

Step Action

1 Note From the Select Criteria pop-up menu, select the criteria 
by which you want to search

Note To list all of the items in the BioLIMS database, perform 
the search with no criteria specified. For large databases, this 
process may be slow.

2 To use the pop-up menu:

Note As you choose items from the pop-up menu, a black dot 
appears next to the item on the menu and the item is added to 
either the collection search criteria or the fragment name search 
criteria section of the window.

Choose menu items...
To define the search 
by... See page

above the horizontal line Collection Search 
Criteria

13-21

below the horizontal line Fragment Search 
Criteria

13-22
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The following is an example of the Collection Browser window showing all 
five collection search criteria and all 14 fragment search criteria.

3 Use the pop-up menus and text fields to define your search query. 

Refer to “Collection Search Criteria” on page 13-21, and “Fragment 
Search Criteria” on page 13-22, for details about the search 
criteria. 

When you are satisfied with the search, click Search.

The results of the search appear in the lower portion of the window.

Note Collections returned by the Collection Browser window 
must match all of the collection criteria and contain at least one 
fragment that matches all of the fragment criteria.

To search the BioLIMS database: (continued)

Step Action
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4 To view the fragments contained in the collections, click the small 
triangle to the left of the collection name.

To search the BioLIMS database: (continued)

Step Action

Small
triangle
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5 Select one or more fragments. If you wish to select more than one 
fragment file, refer to the procedure below.

6 Click Select in the Collection Browser window or press Return on 
your keyboard to import the selected files.

To search the BioLIMS database: (continued)

Step Action

If... Then...

The fragment files you wish to select are listed 
in sequence

Hold the shift 
key and click 
on the file 
names.

The fragment files you wish to select are not 
listed in sequence

Hold the 
command key 
(x) and click 
on the file 
names.
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Importing and 
Processing a 5th Dye 14
Chapter Overview

New Feature of
Genotyper V. 2.5

Genotyper Software version 2.5 has the ability to read and process 
GeneScan sample files containing a 5th dye. Further, Genotyper 
processed data with a 5th fluorescent dye can be exported to a 
GenBase database.

Note Reagent kits containing a 5th dye may be available at a future date.

In This Chapter This chapter describes how to import, view, analyze, and export 
GeneScan data containing a 5th fluorescent dye.

Topic See Page

Importing 5th Dye Data 14-2

Viewing Data 14-4

Analyzing and Exporting Data 14-7

14
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Importing 5th Dye Data

Procedure for
Importing 5th Dye

Data

Data containing a 5th dye can be imported, just like data on any of the 
other four dyes, from either GeneScan sample files or a BioLIMS 
database. 

You must first choose the dyes you wish to import from the 
Set Preferences dialog box. You can access this dialog box from the 
Edit pull-down menu.

To import 5th dye data: 

Step Action

1 Select Set Preferences... from the Edit pull-down menu of 
Genotyper Software v. 2.5. 

The Set Preferences dialog box appears.

2 Choose the dyes by clicking their respective boxes under Import 
colors in the Set Preferences dialog box.

Note The 5th dye is designated Orange.

5th dye
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3 Click OK.

The Set Preferences box goes away and you are returned to the 
Main window.

4 From the File menu, point to Import and click on either From 
GeneScan or From BioLIMS Database.

To import 5th dye data: (continued)

Step Action
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Viewing Data

Two Methods to
View Data

There are two ways to view dye data in the Main window.

� Use the Menu bar or

� Use the Dye buttons on the Main window.

Using the Menu
Bar To use the menu bar to view dye data: 

Step Action

1 From the Edit menu, point to Select and click on the dye you wish to 
view.

Data for that dye are graphically displayed as peaks in the main 
window.



Importing and Processing a 5th Dye 14-5

2 To display data for more than one dye in the same window, 

To use the menu bar to view dye data: (continued)

Step Action

Step Action

1 From the Edit menu, point to Select and hold down the 
shift key. 

A + symbol appears to the left of each dye in the menu 
window. This indicates that data from more than one dye 
can be selected for viewing.

2 With the shift key held down, click on a dye.

The data for the first dye selected is graphically displayed 
in the Main Window.

3 Repeat step 2 to add more dyes to the same Main 
window.

Data from the each dye selected is graphically displayed 
in the same window as the first dye.
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Using the Dye
Buttons To use the dye buttons to view data:  

Step Action

1 Click the dye buttons on the Main window to display the data for 
each dye.

Button 
for 5th 
dye
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Analyzing and Exporting Data

Analyzing Data Data containing a 5th dye can be analyzed just like the other four dyes.

Exporting Data The final results from the Genotyper table can be exported either:

� To a GenBase database

� As text files.

2 To display data from more than one dye in the same window, hold 
down the shift key and click on the buttons of the dyes you want to 
view.

Data for the dyes you selected will be displayed in the same 
window.

To use the dye buttons to view data: (continued)

Step Action
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applications
options for automating 4-3

audit trail
maintaining with GenBase 10-2

automating
procedures

approaches to 4-2 to 4-3
automation

planning for 2-6 to 2-8

B
base pairs

definition of 7-7
Bin size

definition of 9-13
determining 9-13 to 9-14
determining starting bin 9-14
guidelines for selecting 9-13
how to define 9-13

Bin sizes
displaying 9-18

bins
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limit 9-13
locating in tables 9-16

BioLIMS
about server names 13-15 to 13-17
accessing the database 13-9 to 13-10
configuring the server 13-2 to 13-8
using the BioLIMS Chooser 13-18 to 13-29

Blue
command

description of 12-5
buttons

definition of 1-15
Locate in Table 9-16

C
Calculate in Table

command
description of 12-11

how to use command 8-21
uses of command 8-19

Calculate Offset
command 6-25

description of 12-9
Calculate Scale Factors

command
description of 12-8

calculating
offset of categories 6-25
results from table data 8-19 to 8-22
scale factors 5-16

calculations
for table data

absolute difference 8-20
average of 8-20
difference 8-20
difference squared 8-20
kinds of 8-20
member for category 8-20
product of 8-20
ratios 8-20
square root 8-20
sum of 8-20

categories
adding 6-5
adding comments to 6-6
adding multiple 6-7
adjusting size ranges of in histograms 9-25

as source of statistics 9-5
choosing range limits for 6-5
coloring name of labels 6-39
comparison with markers 10-15
defining 6-4 to 6-9
defining ranges for in histograms 9-22
definition of 6-4
displaying in color 6-6
editing 6-23, 8-11
editing in histograms 9-22 to 9-25
exporting from GenBase 10-15
generating table rows from 8-3
importing from GenBase 10-15
making

members 6-17 to 6-19
making from labels 6-49 to 6-51
marking 6-26
naming 6-9
offsetting 6-24 to 6-25
overlapping 6-11
searching for 6-20
sorting 6-22
unmarking 6-26
viewing 7-7
zooming 7-13

Categories window
showing 6-4

category groups
collapsing 6-16
creating 6-13 to 6-16
marking 6-15

Category list 4-2, 6-16
description of 3-10
steps for sorting 6-22

Category menu
commands

description of 12-9 to 12-10
description of 12-2
options 12-9

Category Sorting
command

description of 12-14
Category window

example of 3-11
CD-ROM publications

description of 1-7
Change Labels
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command
description of 12-8

Change Macro Name
command

description of 12-16
changing

a macro name 4-14
labels 6-28

Check Inheritance
command

description of 12-12
checkboxes

definition of 1-15
Choose GenBase

command
description of 12-4

Choose GenBase File
command

description of 12-4
Choose GenoPedigree

command
description of 12-4

Choose Linked Document
command

description of 12-4
Choose Linked Program

command
description of 12-4

Clear
command

description of 12-5
Clear All Labels

command
description of 12-8

Clear All Scale Factors
command

description of 12-8
Clear Category list

command
description of 12-8

Clear Common Labels
command

description of 12-8
Clear Dye/lane list

command
description of 12-8

Clear Step Log

command
description of 12-17

Clear Table
command

description of 12-8
Clipboard

using 3-18
Close

command
description of 12-3

Collapse Categories
command

description of 12-13
color

associating categories and labels with 6-39
customizing in labels 6-38

column headings
editing 8-28 to 8-29

columns
adding for Mendelian inheritance 

checks 8-40
arranging order of 8-7
clearing 8-25
contents of

category name 8-5
conditional labeling text 8-5
dye color 8-5
edited cell warning 8-5
edited label warning 8-5
Gel file names 8-5
GeneScan file name 8-5
GeneScan size standard 8-5
GeneScan size-calling method 8-5
inheritance check results 8-5
labeled peak data 8-5
lane number 8-5
low-signal warning 8-5
minimum modulation score 8-5
number of labels 8-5
Sample Comments 8-5
Sample Information 8-5
scale factors 8-5
user comments 8-5
warnings for modulation scores 8-13 to

8-14
determining contents of 8-4
editing headings 8-29
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limits 8-2
results 8-19
searching for 8-34
selecting as source of statistical data 9-7
specifying for label detection 8-9
warnings for edited labels 8-11
warnings for edited tables 8-11 to 8-12

commands
choosing 1-14
displaying 4-8

comments
for categories 6-6

common
labels

removing 6-43
comparing

reference plots 7-24
comparison analysis

performing in tables 8-23
computer performance

guidelines 1-14
configuring the BioLIMS server 13-2 to 13-8
control

peaks
defining 6-45

Copy
command

description of 12-5
Copy command

using 3-18
Copy Table

command
description of 12-8

Copy Window
command

description of 12-6
Copy Window command

using 3-18
copying

Document windows 3-18
steps 4-11

creating
templates 4-16

Current Step Log 4-8
customer support

e-mail address 1-16
help 1-16 to 1-21

internet address 1-20
telephone/fax 1-17 to 1-20

customizing
plot areas 7-14 to 7-21

Cut
command

description of 12-5
Cut command

using 3-18

D
data type

colored labels 6-40
selecting custom colors for 6-41

data types
labeling with 6-36

Derive Table
command

description of 12-8
Derived table command

using 8-36
Derived tables

exporting 8-46
dialog box

definition of 1-15
disease gene mapping

checking Mendelian inheritance for 8-37
Display by Scan

command
description of 12-13

Display by Size
command

description of 12-13
DMD Analysis

using Analyze in Table command for 8-23
document

linked
opening 11-6

Document windows
copying 3-18
editing 3-18
viewing 3-11

documents on demand   1-21
Duplicate Macro

command
description of 12-16

dye colors
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labeling with 6-38
viewing in Dye/lane list 5-5

Dye Scaling
command

description of 12-14
Dye Selection buttons 5-7
Dye/lane lists

categories for 6-4
clearing 5-7
definition of 5-2, 5-4
description of 3-10
editing contents 5-14
generation of 5-2
viewing 5-4 to 5-8
viewing dye color 5-5
viewing GeneScan file 5-5
viewing lane number 5-5
viewing Sample Comments 5-5
viewing Sample Info 5-5
viewing scale factors 5-5

Dye/Lane Sorting
command

description of 12-14
Dye/lane window

example of 3-11
dye/lanes

editing 8-11
generating table rows from 8-3
how to sort 5-9
imported

viewing 7-2 to 7-6
re-importing 8-6
specifying search criteria for 5-10
viewing plots of 7-4 to 7-6
where they come from 5-2 to 5-3

Dye/lanes window
viewing 5-6

dye-labeled fragments 5-2
dyes, 5th 14-1 to 14-7

E
Edit Category

command
description of 12-9

Edit cell
command

description of 12-6

Edit menu
commands

description of 12-5 to 12-6
description of 12-2
options 12-5

Edit Step
command

description of 12-17
editing

categories
in histograms 9-22 to 9-25

category parameters 6-23
column headings 8-28 to 8-29
lists 3-16
Sample Comments 5-14
Sample Information 5-14
steps 4-10
table cells 8-12, 8-28 to 8-29

electropherograms
example of 7-2
viewing 7-4 to 7-6

e-mail, address for technical support 1-16
entry fields

definition of 1-15
exclusive labeling

setting 6-7
Exclusive option

steps for using 6-12
exclusive peak labeling

an example of 6-10 to 6-12
Expand Categories

command
description of 12-13

Export Derived Table
command

description of 12-8
Export Marked Categories to Database

command
description of 12-9

Export to File
command

description of 12-12
Export to GenBase

command
description of 12-12

Export to Link
command



description of 12-12
exporting

results data from GenBase 10-4 to 10-5
tables 8-46

F
File menu

commands
description of 12-3 to 12-4

description of 12-2
options 12-3

file name
viewing in Dye/lane list 5-5

FileMaker Pro
macros in 11-7

Filter Labels
command

description of 12-8
filtering

definition of 6-29
labels 6-29 to 6-32
stutter peaks 6-12

Find
command

description of 12-6
finding table entries 8-33
planning for use of 2-5

Find Next
command

description of 12-6
using in tables 8-34

Flip Table
command

description of 12-8
Flipped Table

command
using 8-45

flipped table
example of 8-45

fluorescent genotyping 1-3
forensic identification 1-3
forensics

checking Mendelian inheritance for 8-37
kind of table 3-2

fragment peaks
ways to label 6-3
why label 6-2

fragment samples
source of 2-2

fragment size
as source of statistics 9-6

G
GenBase

component of Genotyping Software 
System 1-5

definition of 10-2
description of 1-6
exporting categories from 10-15
exporting tables to 10-10 to 10-14
importing categories from 10-15
importing tables from 10-6 to 10-9
linking to 10-2 to 10-3
organization of results data 10-6
planning to link to 2-9
results data you can exchange 10-5
updating tables in 10-14
using for Mendelian inheritance 

checks 8-37
why link to 10-2

GenBase tables
Category Member

description of 10-6
Genotypes

description of 10-6
Individuals

description of 10-6
Markers

description of 10-6
Pedigree Structures

description of 10-6
Pedigrees

description of 10-6
Samples

description of 10-6
specifying formats for export 10-10
specifying formats for import 10-7

GenBase User’s Manual
description of 1-7

gene dosage 1-3
gene expression 1-3
gene expression profiling

example table 8-2
kind of table 3-2
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steps for performing 3-6 to 3-7
gene quantitation

using Analyze in Table command for 8-23
GeneScan

component of Genotyping Software 
System 1-5

description of 1-6
extracting fragment data 5-3
Sample Sheet

description of 2-3
GeneScan files 3-8

display of 3-9
dye/lanes in 5-3
how Genotyper analyzes 1-4
how to import 3-13 to 3-15
importing 1-11
locating 5-13
storing 3-14

GeneScan User’s Manual
description of 1-7

genetic disease research information
accessing from GenBase 10-2

GenoPedigree
component of Genotyping Software 

System 1-5
description of 1-6
exporting data to 10-16
importing data from 10-16
linking to 10-16

GenoPedigree User’s Manual
description of 1-7

Genotype Record
description of 10-4

Genotyper
5th dye 14-1 to 14-7
compatibility with previous versions 1-9
definition of 1-2, 1-6
how it works 1-4
how you can use 1-3
linking to data bases 11-5
linking to spreadsheet programs 11-5
menus

description of 12-2
registering your copy 1-9
research projects 1-3

Genotyper Documents
definition of 3-8

generating statistics for 9-2
how to open 3-8
locking 3-19
printing windows 3-20
saving 3-12
unlocking 3-19
updating 8-35
viewing parts of 3-11

Genotyper Tutorials
description of 1-7

Genotyper User’s Manual
description of 1-7

genotypes
importing 10-2

genotyping applications
how to choose 3-2
kinds of 3-2
kinds of tables you can create 3-2
tables for 8-2

Green
command

description of 12-5

H
help

e-mail address 1-16
internet address 1-20
telephone hours 1-16
telephone/fax 1-17 to 1-20

Histogram window
viewing 9-17

histograms
adjusting size ranges of categories 9-25
setting viewing options 9-20 to 9-21
viewing 9-17
viewing data from tables 9-21

HMA 1-3
table calculation for 8-20

I
Import GeneScan File(s)

command
description of 12-3

Import IDs from GenBase
command

description of 12-12
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importing
5th dye 14-1 to 14-7
GeneScan files

process of 3-13
running macros after 4-6

pedigree data 8-41
project files 3-15
raw data 3-15
results data from GenBase 10-4 to 10-5
select dye colors 3-15

integers
rounding 6-28

internet address
Documents on Demand 1-21

L
Label Options

command
description of 12-14

Label Peaks
command

description of 12-8
labeled peak

example of 6-2
labeled peak data

arranging columns of 8-7
labeled peaks

as source of statistics 9-4
labeled text

as value types 9-11
labeling

all peaks 6-6
approaches to 6-2 to 6-3
automatic 6-26 to 6-28

definition of 6-3
by category definitions 6-26
for quantitative applications 6-45 to 6-48
manual 6-33 to 6-34

definition of 6-3
normalized peaks 6-45 to 6-48
peak areas 6-27, 6-34
peak heights 6-6, 6-27, 6-34
peak size 6-27, 6-34
with data type prefixes 6-36
with dye colors 6-38
with how peak labeled 6-27, 6-34
with modulation score 6-27, 6-34

with scan numbers 6-27, 6-34
with text descriptions 6-27, 6-34

labels 6-13
alleles

renaming 6-28
associating with dye colors 6-38
changing 6-28
coloring by data type 6-40
customizing text in 6-35 to 6-37
customizing the color in 6-38
duplicates

avoiding 6-26
edited

specifying warning columns for 8-11
editing 8-11
identifying data type of 6-36
making categories 6-49 to 6-51
removing 6-42 to 6-44

a range 6-43
all 6-42
common 6-43
correcting errors 6-43
specific 6-42
ways to 6-42

showing manually removed 6-35
lane number

viewing in Dye/lane lists 5-5
limits

columns in tables 8-2
linkage mapping

example table 8-2
kind of table 3-2
steps for performing 3-4 to 3-5

linking
to GenBase 10-2 to 10-3

why 10-2
linking to programs

planning for 11-2
Links

command
description of 12-4

lists
editing 3-16
making active 3-16
selecting items in 3-17

Locate GeneScan File
command
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description of 12-4
Locate in Database

command
description of 12-4

Locate in Table
button 9-16

locating
GeneScan files 5-13

Lock command
using 3-19

locking
Genotyper Documents 3-19

LOH. See loss of heterozygosity
loss of heterozygosity

definition of 8-26
example table 8-2
kind of table 3-3
using Analyze in Table command for 8-23
using table commands for 8-26

Lower Graphical Area
description of 3-10

lower pane
plot area 7-14

M
Macintosh file system

using 1-14
Macintosh procedures 1-14
Macro list

description of 3-10
Macro menu

commands
description of 12-16 to 12-17

description of 12-2
options 12-16

Macro window
showing 4-5

macros
creating from Step list 4-12 to 4-15
definition of 4-2
examples of

in linked programs 11-7
naming 4-14
running 4-4 to 4-6

in linked programs 11-7
running after importing 4-6
supplied with Genotyper 4-4 to 4-6

Main window 3-8
definition of 3-9
parts of 3-10

Main Window, Lower Pane
command

description of 12-15
Main Window, Upper Pane

command
description of 12-15

Make Category Members
command

description of 12-10
Make from Labels

command
description of 12-9

Mark
command

description of 12-6
markers

calculating frequency of 10-2
comparison with categories 10-15

members
categories

making 6-17 to 6-19
memory

how to allocate 1-11
low

warning of 7-6
Mendelian Inheritance

using GenBase to access pedigree 
data 8-37

Mendelian inheritance
checking for 8-37 to 8-44
checking parent inconsistencies 8-43
checking sibling inconsistencies 8-44
why perform checks 8-37

Mendelian inheritance checks
evaluating results of 8-43
how to perform 8-42
performing 10-2

menus
definition of 1-15

microsatellite repeats
adding categories for 6-7

microsatellites
checking Mendelian inheritance for 8-37
size labels for 6-28
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Microsoft Excel
macros in 11-7

modulation
definition of 8-13

modulation score 6-27, 6-34
definition of 8-13
example of 8-13
table column for 8-5

mouse
using 1-14

mutation detection 1-3
mutation screening 1-3

N
naming

categories 6-9
New

command
description of 12-3

Normalize Labels
command

description of 12-8
normalizing

peak areas 5-15
peak heights 5-15
peaks 6-46

nucleic acids
in dye/lanes 5-2
labeling of 5-3

O
Offset Categories

command
description of 12-9

Open
command

description of 12-3
Open GenBase

command
description of 12-4

Open GenoPedigree
command

description of 12-4
Open Linked Document

command
description of 12-4

Open Linked Program
command

description of 12-4
opening

linked programs 11-6
setting preferences for 11-2

Oracle server
configuring the server 13-2 to 13-8
how server names are recognized 13-15 to 

13-17
overlapping

category ranges 6-11

P
Paste

command
description of 12-5

Paste command
using 3-18

pasting
steps 4-11

paternity identification 1-3
paternity testing

checking Mendelian inheritance 8-37
kind of table 3-2

patient information
importing 10-2

peak areas
as measurement of fragment quantities 3-6
as value types 9-10
viewing 7-7

peak data 7-7 to 7-8
arranging columns of 8-7
viewing 7-7 to 7-8

peak height
definition of 7-7

peak heights
adjusting 7-10
as measurement of fragment quantities 3-6
as value types 9-10
comparing 7-9
defining 6-6
making histograms from 9-21
viewing 7-7

peak quantities
comparing 7-9

peak resolution
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techniques for improving 2-2
peak size

changing the scale 7-9
viewing 7-7

peaks
control

defining 6-45
how labeled 6-4
kinds you can filter 6-30
normalized

labeling 6-45 to 6-48
normalizing to control 6-46
small

removing labels from 6-31
spurious

removing labels 6-30
statistics

viewing 9-16
stutter

removing labels from 6-32
pedigree data

importing for inheritance checks 8-41
pedigree structures

using GenBase to access 8-37
penetrance data 10-2
plot area

lower pane 7-14
upper pane 7-14
zooming 7-11

plot areas
customizing 7-14 to 7-21

plot displays
order of 7-6

Plot Options
commands

description of 12-14
Plot window

example of 3-12, 7-3
Lower Pane 7-4
parts of 7-4
Peak Description Area 7-4
Upper Pane 7-4

plot window
lower pane 7-15
upper pane 7-15

Plot Window, Lower Pane
command

description of 12-15
Plot Window, Upper Pane

command
description of 12-15

plots
reference

comparing 7-24
table data 7-22

polymerase enzyme
slippage of 6-32

pop-up menus
definition of 1-15

precedence
concept in table sorting 8-30

preference settings
for dye/lane viewing 5-4

preferences
setting for exporting tables 11-4
setting for linking 11-2

prefixes
for data type labels 6-36

print
how to 3-20

printing
document windows 3-20

procedures
automating 4-2
options for automating 4-3

programs
examples of ones you can link to 11-5
linked

opening 11-6
running macros from 11-7
running Scripts from 11-7

Project files
importing 3-15

Q
quantitative applications

labeling for 6-45 to 6-48
using scale factors for 5-15

quantitative expression 1-3

R
radio buttons

definition of 1-15
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range limits
for categories 6-5

raw data
importing 3-15

Record Steps
command

description of 12-16
recording

steps 4-9
Red

command
description of 12-6

registration card
filling out 1-9

registration information 1-9
Re-Import Dye/lane

command
description of 12-4

re-importing
dye/lanes 8-6

related publications 1-7
Remove Labels

command
description of 12-8

removing
labels

a range 6-43
all 6-42
common 6-43
correcting errors 6-43
specific 6-42
way to 6-42

resetting
scale factors 5-17

results columns
creating 8-19

results data
exporting 10-4
importing 10-4
kinds you can exchange 10-5
organization of 10-6

Results files
importing from GeneScan 3-13

rounding
integers

when to 6-28
rows

appending to tables 8-6
determining contents of 8-3
marking as edited 8-28
sorting 8-30 to 8-32

run conditions
optimizing 2-2

Run Linked Macro/Script
command

description of 12-17
Run Macro

command
description of 12-16

Run Step
command

description of 12-17
running

a step 4-11
macros 4-4 to 4-6

run-to-run variability
eliminating 6-24

S
Sample Comments

editing 5-14
viewing in Dye/lane list 5-5

sample data
techniques for preparing 2-2

Sample files
importing from GeneScan 3-13

sample handling
investigating errors in 8-37

Sample Information
generating rows from 8-3
how to edit 5-14
source of 2-4
viewing in Dye/lane list 5-5

Sample Sheet
completing 2-3 to 2-5
how Genotyper uses 2-4

Sample subfield
example of 2-5

Save
command

description of 12-3
Save As

command
description of 12-3
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Save Step Log
command

description of 12-16
saving

Genotyper Documents 3-12
templates as stationary pads 4-17

scale
horizontal scale

changing 7-9
scale factors

applying to other peaks 5-17
definition of 5-15
dividing peak area by 6-27, 6-34
dividing peak height by 6-27, 6-34
how to calculate 5-16
how to see 5-15
in table columns 8-5
resetting 5-17
viewing in Dye/lane lists 5-5
why use 5-15

scaling factors 7-10
scan number

definition of 7-7
scan numbers

as value types 9-9
viewing 7-7

Scripts
definition of 4-2
running

in linked programs 11-7
steps for creating 4-18
system requirements for 4-18
using to automate 4-18

scrolling
of tables with plots 7-23

searching
for categories 6-20
for dye/lanes 5-10
for table entries 8-33 to 8-34

Select
command

description of 12-5
Select All

command
description of 12-5

selecting
list items 3-17

server names, about 13-15 to 13-17
Set Click Options

command
description of 12-7

Set Histogram Options
command

description of 12-7
Set Import Macro

command
description of 12-17

Set Preferences
command

description of 12-6
Set Statistics Options

command
description of 12-7

Set up Table
command

description of 12-11
setting up

tables 8-2 to 8-6
Show Categories Window

command
description of 12-14

Show Clipboard
command

description of 12-6
Show Clipboard command

using 3-18
Show Derived Table Window

command
description of 12-14

Show Dye/lanes Window
command

description of 12-14
Show Histogram Window

command
description of 12-14

Show Macro Window
command

description of 12-14
Show Main Window

command
description of 12-14

Show Plot Window
command

description of 12-14
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Show Statistics Window
command

description of 12-14
Show Step Window

command
description of 12-14

Show Table Window
command

description of 12-14
showing

manually removed labels 6-35
Step window 4-8
table data in plots 7-22

signal
low

cause of 8-15
example of 8-15
specifying warnings for 8-15 to 8-16

saturated
cause of 8-17
example of 8-17
specifying warnings for 8-17 to 8-18

Sort Table
command

description of 12-11
sorting

categories 6-22
dye/lanes 5-9
rows in a table 8-30 to 8-32

sources
choosing for statistics 9-4 to 9-8
of table data 8-2

spectral overlap
peaks resulting from 6-31

spreadsheets
copy tables to 11-8
exporting tables to 11-8
functionality in 8-23

SSCP 1-3
kind of table 3-2

starting
Genotyper 1-13

stationary pad
saving templates as 4-17

statistical data
generating 9-2 to 9-3

statistics

Bin
description of 9-2

Count
description of 9-2

displaying bins 9-18
Frequency

description of 9-2
kinds you can generate 9-2
Maximum

description of 9-2
Mean

description of 9-2
Median

description of 9-2
Minimum

description of 9-2
Number of Data Points

description of 9-2
Source

description of 9-2
Standard Deviation

description of 9-2
Value Type

description of 9-2
viewing 9-15 to 9-16

statistics options
setting 9-3

Statistics window
viewing 9-16

Step list
clearing 4-12
editing 4-10 to 4-11
recording steps in 4-7 to 4-9

Step log
current 4-8
description of 3-10

Step window
location of 4-7
showing 4-8

Steps
running 4-11

steps
copying and pasting 4-11
how to record 4-9
how to stop recording 4-9

storing
GeneScan files 3-14
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stutter peaks
definition of 6-32
filtering 6-12

Sybase SQL server
configuring the BioLIMS server 13-2 to 13-8
how server names are recognized 13-15 to 

13-17

T
Table area

description of 3-10
table cell text

as value types 9-12
table cells

as source of statistics 9-7
editing 8-28 to 8-29
numerical values

as value types 9-11
table data

kinds you can edit 8-28
sources of 8-2

Table menu
commands

description of 12-11 to 12-12
description of 12-2
options 12-11

Table window
example of 3-12

tables
analyzing data in 8-23 to 8-25
appending rows 8-6
calculating results from data 8-19 to 8-22
calculations

kinds of 8-20
column number limit 8-2
copying contents of 8-36
copying to spreadsheets 11-8
deriving a second 8-36
determining column contents 8-4
determining row contents 8-3
edited 8-12

specifying warning columns for 8-11 to
8-12

exporting 8-46
exporting to text files 11-8
flipping 8-45
for gene expression profiling 8-2

for genotyping applications 3-2, 8-2
for linkage mapping 8-2
for loss of heterozygosity 8-2
formatting for export 8-45
locating bins in 9-16
searching for entries 8-33 to 8-34
setting up 8-2 to 8-6
sorting rows 8-30 to 8-32
updating 8-35
viewing data in plots 7-22
viewing histogram data from 9-21

technical support 1-16 to 1-21
e-mail address 1-16
internet address 1-20
telephone/fax 1-17 to 1-20

templates
definition of 4-2, 4-16
saving as stationary pads 4-17
steps for creating 4-17
supplied 4-16
using and creating 4-16 to 4-17

text box
example of 8-23
reading for Calculate in Table 8-19

third-party programs
examples of 11-5

Trisomy 1-3
using Analyze in Table command for 8-23

U
Undo

command
description of 12-5

Unlock command
using 3-19

unlocking
Genotyper Documents 3-19

Unmark
command

description of 12-6
Update Table

command
description of 12-11

Update to GenBase
command

description of 12-12
updating



Index-16

tables 8-35
tables in GenBase 10-14

upgrades
purchasing 1-9

Upper Graphical Area
description of 3-10

upper pane
plot area 7-14

V
Value Type

choosing 9-9 to 9-12
labeled text 9-11
peak heights 9-10
Scan number 9-9
size in base pairs 9-9
table cell text 9-12
table cell values 9-11

Value Types
peak areas 9-10

vertical bar
meaning of in lists 3-16

viewing
Document windows 3-11
Histogram window 9-17
histograms 9-17
peak statistics 9-16
Statistics window 9-16
table data in plots 7-22

Views menu
commands

description of 12-13 to 12-15
description of 12-2
options 12-13

W
Web Site

how to access 1-8
where 8-20
Window selection buttons

description of 3-10
windows

definition of 1-15
printing 3-20
working with 1-14

www address

Applied Biosystems 1-20
Documents on Demand 1-21

Y
Yellow

command
description of 12-5

Z
Zoom

commands
description of 12-15

Zoom In
command

description of 12-15
Zoom In (Selected Range)

command
description of 12-15

Zoom Out
command

description of 12-15
Zoom Out (Full Range)

command
description of 12-15

Zoom To
command

description of 12-15
Zoom To Category

command
description of 12-15

Zoom To Next Category
command

description of 12-15
zooming 7-11 to 7-13

histograms 9-20
on a selected range 7-11
on the plot area 7-11
out on a plot area 7-12
out to a full range 7-12
to a range of categories 7-13
to a specific range 7-13
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